Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

Best Practice of Portal Development

By Wang Hua Hong (wanghuah@cn.ibm.com)
Shanghai Globalization Lab (http://ut.cn.ibm.com/sgl)
User Technology (http://ut.cn.ibm.com/)

IBM China Software Development Lab

©Shanghai Globalization Lab, User Page 1
Technology, CSDL, IBM China 2006

¢
I


mailto:Wang%20Hua%20Hong%20(wanghuah@cn.ibm.com)
http://ut.cn.ibm.com/sgl
http://ut.cn.ibm.com/
http://w3.cdl.cn.ibm.com/cdl.nsf/ContentDocsByTitle/CSDL%20Home

1.

Best Practice of Portal Development

written by Luke Wang (wanghuah@cn.ibm.com)

11
1.2
13
1.4

2.1
2.2
2.3
2.4
2.5
2.6

3.1
3.2

4.1
4.2
4.3
4.4

5.1
5.2
5.3
5.4
5.5
5.6
5.7
5.8
5.9

Table of Contents

Preface

Main contents
Audience

About the author
Change history

Portal introduction

What is a portal?
MVC design pattern
Portal concepts
Portlet lifecycle
Portal project types
Portal administration

The framework of portal project

Framework overview
Concepts in this framework

Portal development process

Portal development overview
Design

Development

Maintenance

Best practice of portal development

Login

Exception handling in portlet application
Log handling in portal project

Code System

Customize skin of portal

Customize theme of portal

Portlet Caching

Enable session for anonymous user
Enable Automatic JSP Reloading

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006

Page 2

o oo Q1

»

©O© ©O© 00 N OO O

11

11
11

42

42
42
43
54

56

56
57
58
61
62
64
72
73
73



Best Practice of Portal Development

written by Luke Wang (wanghuah@cn.ibm.com)

5.10
5.11
5.12
5.13

6.1
6.2
6.3
6.4
6.5
6.6
6.7

7.1
7.2
7.3
7.4
7.5
7.6
7.7
7.8
7.9

8.1
8.2
8.3
8.4

9.1
9.2
9.3
9.4
9.5

10.

9

How to write a WPS taglib
Session in portlet

JavaScript in portlet

Classpath issues in portal project

Portal administration

Login portal

Deploy portal applications
Manage pages

Manage Portlets

Manage Users and Groups
Manage themes and skins
Set resource permissions

Bring globalization into portal

Globalization overview in portal project
How to get userid and locale in portlet
Localization Pack Handling

Select language

Globalization Preference in portal projects
Enable GBO in portal project

Bidi in portal

Encoding of portlet

Encoding of portal database

Artwork in Portal

Ul design

Images

Apply stylesheet

Coordination between artwork team and portal team

Comparison of several types of portlets

IBM API Portlet

JSR168 Portlet

Faces Portlet

XDIME Portlet

Comparison between IBM Portlet and JSR168 Portlet

Portal Resource Center

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006

74
80
82
90

92

92
92
93
96
96
98
98

102

102
103
105
111
115
119
136
140
140

142

142
143
144
144

145

145
147
149
152
154

155

Page 3



Best Practice of Portal Development

written by Luke Wang (wanghuah@cn.ibm.com)

10.1
10.2
10.3
10.4
10.5
10.6
10.7
10.8
10.9
10.10
10.11
10.12
10.13

WebSphere Portal for Multiplatforms
WebSphere Portal Express
WP510 Info Center
RAD V6 Portlet Application Development and Portal Tools
IBM WebSphere Portal for Multiplatforms V5 Handbook
IBM WebSphere Portal V5 A Guide for Portlet Application Development
WebSphere Portal library:
WebSphere Portal zone in DeveloperWorks
WebSphere Portal Forum

IBM user groups

JSR 168 Specification:

Comparing JSR 168 to the IBM portlet API

Tags used by the portal JSPs

11. Appendix 1: Abbreviations and acronyms

12.  Appendix 2: Acknowledge

ot

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006

Page 4

155
155
155
155
155
155
155
155
155
155
155
155
155

156

157



Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

1. Preface

1.1 Main contents

This paper is based on information from our previous portal projects and various IBM®
publications. The purpose is to give you series best practices of portal development.

In this paper, you will know what’s the portal firstly. Then the author will show you the

framework and process of portal development. A lot of best practices will make your portal
development easily. Also I’ll show you how to support globalization in portal.

1.2 Audience

Portal developer, designer, administrator

1.3 About the author

Luke (Wang Hua Hong) is a Software Engineer at the IBM Shanghai Globalization Lab (SGL:
http://ut.cn.ibm.com/sgl/) in Shanghai. Luke joined IBM in 2001 and worked on IBM
globalization solutions for e-business systems in these years. He has rich experience in both portal
and globalization. You can reach Luke at wanghuah@cn.ibm.com.

1.4 Change history

Date Version Description Author

2005-12-13 1.0 Final Luke Wang
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2. Portal introduction

2.1 What is a portal?

Portals are the next-generation desktop, delivering e-business applications over the Web to all
kinds of client devices. Portals provide site users with a single point of access to multiple types of
information and applications.

IBM WebSphere Portal provides a single, secure, interactive point of access to dynamic
applications, information, people and processes to help build successful Business-to-Business
(B2B), Business to Employee (B2E) and Business to Consumer (B2C) portals.

2.2 MVC design pattern

Model: Encapsulating all the business logic
View: A JSP or even simple HTML.
Controller: Aservlet, portlet, or a simple Java class
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Portlet MVC architecture

The MVC architecture can be applied as a design pattern to any system needing to achieve
separation of responsibilities. In fact, you will see as you continue through this paper that the
Portal Server itself is architected this way. Furthermore, several of the benefits of the portlet
architecture are available to you only if you employ a good MVC design.

Model

The Model in a portlet application is not necessarily different from the Model in any other Java
server side application. The Model represents business logic and should not be concerned with the
Controller or the View. The Controller could be a servlet, portlet, or a simple Java class. The View
could be a JSP or even simple HTML. In theory, then, provided that existing applications employ
solid MVC practices, porting the functionality WebSphere Portal should not require any changes
to the logic. However, in practice, there are always applications that lack this foresight. The rich
API covered later in this chapter will arm you with the tools to tackle this situation. Implementing
a rigid commitment to the MVC architecture now will conserve an enormous amount of effort in
later migrations or maintenance duties.

9
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View

Like the servlet MVC implementation, the View is traditionally implemented using JSPs or simple
HTML. However, because the HTML the View returns will be aggregated, it must not contain
page-level tags and must be very mindful of the environment in which it is executing. Furthermore,
the Portlet API provides tag libraries which aid in creating dynamic view resources for the portlet
environment.

Control

The Controller is responsible for determining the requested mode, executing an appropriate Model
and selecting the correct View. The portlet class itself acts as the Controller. Instead of
determining the request method as in servlets, portlets need to determine the mode the user has
requested. In a normal presentation, where a page is built with several portlets on it, the mode is
View. The user, with appropriate permissions, may click the Edit button in order to perform some
edit functionality. In this case, the mode is Edit.

2.3 Portal concepts
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This the "<DIME Stock Sample® portlet for WebSphere Everyplace Mobile Portal. To use this
have the webSphere Everyplace mMobile Portal server extensions installed, or be using the u
for WebSphere Everyplace Mobile Portal.

Portal concepts

The following are some definitions and descriptions of Portal concepts.
Portlet

A portlet is an application that displays page content.

Portlet application

Portlet applications are collections of related portlets and resources that are packaged together. All
portlets packaged together share the same context that contains all resources such as images,
properties files and classes.

9
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Page

A portal page displays content. A page can contain one or more portlets. For example, a World
Market page might contain two portlets that displays stock tickers for popular stock exchanges and
a third portlet that displays the current exchange rates for world currencies. To view a page in the
portal, you select its page.

Layout

The page layout defines the number of content areas within the page and the portlets displayed
within each content area. In many cases, the portal administrator defines the page layout. The
administrator can permit specified users or user groups to change the page layout to reflect
individual preferences.

If you have authority to change a page, use the configure icon (wrench icon) to alter the page
layout.

Roles

Each portal page is subdivided into one or more content areas. Each content area can contain one
or more portlets. The portal administrator or a user who has authority to manage a page can
control whether others who have authority to edit the page can move, edit or delete the content
areas and the portlets on the page.

Portal V5.1 permission is role based. A role is a set of permissions. Roles can be assigned (or
mapped) to individual principals granting those principals the corresponding permissions. If you
have authority to make changes to a portal page, use the Resource Permissions page in Access
under Administration to set the permissions for the page. By default, there are seven roles and they
are as follows:

Themes

Themes represent the overall look and feel of the portal, including colors, images and fonts. There
are several default themes provided with the standard installation of WebSphere Portal. Each page
in the portal may have a different theme associated with it, thereby creating the appearance of
virtual portals. Use the Themes and Skins under Portal User Interface to manage themes.

Skins

The term skin refers to the visual appearance of the area surrounding an individual portlet. Each
portlet can have its own skin. The skins that are available for use with a portlet are defined by the
portal theme that is associated with the page. The portal administrator or the designer determines
the theme for pages and the available skins for the theme. The administrator can permit specified
users to change the skins to reflect individual preferences. If you have authority to make changes
to a portal page, use the Themes and Skins under Portal User Interface to manage themes.

2.4 Portlet lifecycle
The basic portlet lifecycle is to:

9
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Initialize, using the init class to initialize the portlet and put it into service.
Handle requests, processing different kinds of actions and rendering content.
Complete, using the destroy class to take the portlet out of
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2.5 Portal project types

There are several types of portal project, which including IBM API portlet, JSR168 portlet, JSF
portlet, XDIME portlet and etc.

For details, please refer to the section Comparison of several types of portlet projects

2.6 Portal administration

After you installed WPS environment, you can access portal by http://hostname/wps/portal.
You can login using the default user for WPS.

Username: wpsadmin

Password: wpsadmin

You will see the following page by clicking the link “Administration” in the top-right of portal
page.

©Shanghai Globalization Lab, User Page 9
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For details about how to do the administration, please refer to the section Portal Administration

©Shanghai Globalization Lab, User Page 10
Technology, CSDL, IBM China 2006




Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

3. The framework of portal project

3.1 Framework overview

Here is the framework of portal project. It implements the MV C design pattern.

Model: Encapsulating all the business logic. It can be Action Bean, Business Bean, DAO, and etc.
View: A JSP or even simple HTML.

Controller: Aservlet, portlet, or a simple Java class.

The main flow is User -> JSP —> Portlet —> Action Bean —> Business Bean —> DAO (DataBean)
—> Database

dartifacts @GBI] @Log{] @CodeSyste- @Exception @]]ataBean
;:.';I-ages and Stylesheet

i

.t T

I5E (3 Fortlet (9 ActionBean (5 BusineszFean (5 DA0

% -7 = Database

w
ser Access other sub system, such

as webh services

LF Tag (3 Constants (& Utility Class aSubsystems
-[E}Subsystel, such as Teb Service

G LP Utility

NP The Framework of Portal Project
TTTLE S sck Luke 2005-11-9

3.2 Concepts in this framework

3.2.1 User

The user who are browsing the portal website.

3.2.2 JSP

The JSP page will be shown to the user. It’s the View in MVC design pattern. Each JSP has a
corresponding portlet or actionbean (in JSF portlet).

Note: In JSF portlet, the name of JSP is consistent to ActionBean, that is, for Search.jsp, the
ActionBean should be Search.java.

JSR168 Portlet — JSP

<%@ page language="java" contentType="text/html; charset=UTF-8" pageEncoding="UTF-8"
session="true"%>

<%@ taglib uri="http://java.sun.com/portlet” prefix="portlet" %>

<%@ page import="java.util.* ,javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.*" %>

9
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<%@ page import="com.ibm.sgl.oged.constant. TrackConstansts"%>
<%@ page import="com.ibm.sgl.oged.db.databean.ShipmentBean"%>
<%@ page import="com.ibm.sgl.oged.db.databean.UserBean"%>

<%@ page import="com.ibm.sgl.oged.db.manager.UserBeanManager"%>
<%@ taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip" %>

<%@ taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip_alt" %>

<lp_alt:load file="image.properties"/>

<Ip:load file="tracking.properties"/>

<% @include file="Bidi.jsp"%>

<%

String locale= com.ibm.sgl.oged.util. LPUtil.getFullLocale(request.getLocale().toString());

%>

<link href="/wps/oged/images/<%-=Ilocale%>/Styles.css" rel="stylesheet" type="text/css">
<portlet:defineObjects />

<FORM name="hawbform" method="POST" action="<portlet:actionURL/>">
<table  width="100%" border="0" cellspacing="0" cellpadding="0">

<tr>
<td width="100%" height="170" align="center" valign="top"><br>
<br>
<table width="90%" border="0" cellpadding="0" cellspacing="0">
<tr>
<td colspan="3" class="td5<%=dir%>" ><Ip:value
key="PORTLET_TRACKSHIPMENTSTATUS" /></td>
</tr>
</table>
<%
String

errormsg=(String)renderRequest.getPortletSession().getAttribute(TrackConstansts. ERROR_MSG)

if (null==errormsg || errormsg.length()==0)

}/end for if

>
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else {
%>

<table width="90%" border="0" cellpadding="0" cellspacing="0" >
<tr>
<td height="20" class="td4<%=dir%>" width="20"><img
src="/wps/oged/images/error-message.gif" alt="<Ip_alt:value key="ERRORMSG"/>"></td>
<td height="20" class="td4<%=dir%>" width="90%">
<lIp:value key="<%=errormsg%>"/>
</td>
</tr>
</table>

<%

renderRequest.getPortletSession().setAttribute(TrackConstansts. ERROR_MSG,errormsg);
}

String
myhawb=(String)renderRequest.getPortletSession().getAttribute(TrackConstansts. TRACK _BY H
AWB_FIELD);
if (null==myhawb)

renderRequest.getPortletSession().removeAttribute(TrackConstansts. TRACK _BY HAWB_FIEL
D);

%>
<table width="90%" border="0" cellpadding="0" cellspacing="0" >
<tr>
<td width="50%" align="center" class="td3<%=dir%>"><font
color="#000000">HAWB:</font></td>
<td width="50%" class="td6<%=dir%>"><font color="#000000">
<input name="<%=TrackConstansts. TRACK_BY_HAWB_FIELD %>"
class=wpsFieldText size=10 maxlength="8" value="<%=myhawb %>" >
</font></td>
</tr>
<tr>
<td colspan="3" class="td3<%=dir%>"><div align="center">

©Shanghai Globalization Lab, User Page 13
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<input
name="<%=TrackConstansts. TRACK_BY_HAWB_SUBMIT_BUTTON%>" type="submit"
class="button" id="track2" value="<Ip:value key="BUTTON_TRACK" />" >

</div></td>
</tr>
</table>
<br>
</td>
</tr>

</table>
</FORM>

3.2.3 Portlet

A portlet is an application that displays page content. It’s the Controller in MV C design pattern. It can
decide to invoke which jsp according to the result from business process.

There are several types of portal project, which including IBM API portlet, JSR168 portlet, JSF portlet,
XDIME portlet and etc.

JSR168 Portlet — Portlet
/*
* Author Peter
* Class: <TrackByHAWBBrieflyPortlet>
* Description: <This class is to handle the contron of the logic of UC TrackByHAWBBriefly .>
* Version: <1.0>
* Author: <Peter>
* Creation date: <2005-8-9>
* Department: Shanghai Globalization Laboratory
* Copyright (c) 2005, International Business Machines Corporation, All rights reserved.
*/
package com.ibm.sgl.oged.wemp.portlet;

import java.io.IOException;

import javax.portlet.ActionRequest;

import javax.portlet.ActionResponse;

import javax.portlet.GenericPortlet;

import javax.portlet.PortletException;

import javax.portlet.PortletRequestDispatcher;

>
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import javax.portlet.RenderRequest;

import javax.portlet.RenderResponse;

import com.ibm.sgl.oged.constant. TrackConstansts;

import org.apache.log4j.*;

import com.ibm.sgl.oged.wemp.actionbean. TrackByHAWBActionBean;
/**

*

* @author panxf

*@version 1.0

* TODO To change the template for this generated type comment go to

* Window - Preferences - Java - Code Style - Code Templates

*/
public class TrackByHAWBBrieflyPortlet extends GenericPortlet {
/**

* action bean

*/

private TrackByHAWBActionBean trackByHAWBActBean

TrackByHAWBActionBean();

/**
* |sp name
*/
private String JSP_NAME = null;
/**
* logger
*/

private static Logger logger = Logger.getLogger(TrackByHAWBPortlet.class);

/**

* Serve up the <code>view</code> mode.
* @param request

* @param response

* @throws PortletException

* @throws IOException

* @see javax.portlet.GenericPortlet#doView(javax.portlet.RenderRequest,

* javax.portlet.RenderResponse)
*/
public void doView(RenderRequest request, RenderResponse response)
throws PortletException, IOException {
/I Set the MIME type for the render response
logger.debug("#pan# Track doView begin"); //SNON-NLS-1$

/I Set the MIME type for the render response

©Shanghai Globalization Lab, User
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response.setContentType(request.getResponseContentType());

if (null == JSP_NAME) {
JSP_NAME = TrackConstansts. TRACK_BY_HAWB_BRIEF;

request.getPortletSession().removeAttribute(TrackConstansts. TRACK_BY_HAWB_FIELD);

/I Invoke the JSP to render
}
PortletRequestDispatcher rd = getPortletContext().getRequestDispatcher(
getJspFilePath(request, JSP_NAME));
rd.include(request, response);
JSP_NAME = null;
logger.debug("#pan# *Track doView over"); //SNON-NLS-1$

/**

* Returns JSP file path.

* @param request

* Render request

* @param jspFile

* JSP file name

* @return JSP file path

*/

private static String getJspFilePath(RenderRequest request, String jspFile) {
logger.debug("#pan# Track getJspFilePath begin™); //SNON-NLS-1$
/ISNON-NLS-1$
String markup = request.getProperty(TrackConstansts.WPS_MARKUP);
if ( null == markup) {
markup = getMarkup(request.getResponseContentType());
}
return "/" + markup + "/" + jspFile + "." + getJspExtension(markup); //SNON-NLS-1$
/ISNON-NLS-2$ /I$NON-NLS-3%

/**

* Convert MIME type to markup name.

*

* @param contentType

>
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* MIME type
* @return
*/
private static String getMarkup(String contentType) {
logger.debug("#pan# Track getMarkup begin™); /SNON-NLS-1$

if (TrackConstansts.XDIME_CONTENT _TYPE.equals(contentType)) {
return TrackConstansts.XDIME;

}
return TrackConstansts.HTML;

}

/**

*

* @param requet

* @param response

* @throws PortletException

* @throws IOException

* @see javax.portlet.GenericPortlet#doView(javax.portlet.RenderRequest,

* javax.portlet.RenderResponse)

*/

public void processAction(ActionRequest request, ActionResponse response)
throws PortletException, java.io.IOException {

/IPortletPreferences prenf = request.getPreferences();
logger.debug("#pan# Track in process action."); //SNON-NLS-1$

if (null 1=

request.getParameter(TrackConstansts. TRACK_BY_HAWB_SUBMIT _BUTTON) ) {

logger.debug("#pan# click TrackbyHAWB button™); //$SNON-NLS-1$

logger.debug("#pan# do the trackbyhawb work™); //SNON-NLS-1$

/lget the hawb value

String hawb = request

.getParameter(TrackConstansts. TRACK_BY_HAWB_FIELD);
/I Set the session of action bean

trackByHAWBACctBean.setSession(request.getPortletSession());

request.getPortletSession().setAttribute(TrackConstansts. TRACK_BY_HAWB_FIELD,hawb);

>
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if (trackByHAWBACctBean.doSubmit(hawb)){ //enter the jsp
logger.debug("#pan# portlet doSubmit is ok™); /SNON-NLS-1$
JSP_NAME = TrackConstansts. TRACK_BY_HAWB_BRIEF_RESULT:;

}else {
logger.debug("#pan# portlet doSubmit is not ok™); /SNON-NLS-1$

JSP_NAME = TrackConstansts. TRACK_BY_HAWB_BRIEF;

if (null 1=
request.getParameter(TrackConstansts. TRACK_BY_ HAWB BACK BUTTON)) {
JSP_NAME = TrackConstansts. TRACK_BY_HAWB_BRIEF;

/**

* Returns the file extension for the JSP file

*

* @param markupName

* Markup name
* @return JSP extension
*/

private static String getJspExtension(String markupName) {
logger.debug("#pan# Track getJspExtension™); //SNON-NLS-1$

return TrackConstansts.JSP;

}
/**
* @return
*/
public String toString(){
return TrackByHAWBBFrieflyPortlet.class.toString();
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3.2.4 ActionBean

The purpose of ActionBean is to handle the inputs in the jsp by user and invoke the methods in
BusinessBean. For example, do the validation for user input. If the input is invalid or exception
from BusinessBean is throwed, it will return false and set the error message to session.

JSR168 Portlet — ActionBean

package com.ibm.sgl.oged.wemp.actionbean;

import com.ibm.sgl.oged.wemp.businessbean. TrackByHAWBBrieflyBusinessBean;

import com.ibm.sgl.oged.db.databean.ShipmentBean;
import com.ibm.sgl.oged.exception. TrackException;

import javax.portlet.PortletSession;
import com.ibm.sgl.oged.constant. TrackConstansts;
import org.apache.log4j.*;

public class TrackByHAWBActionBean {
/**
* session passed from portlet
*/
private PortletSession mysession = null;
/**
* logger
*/
private static Logger logger = Logger
.getLogger(TrackByHAWBActionBean.class);

/**
* @return Returns the session.
*/
final public PortletSession getSession() {
return mysession;

/**

* @param session
* The session to set.
*/
final public void setSession(PortletSession mysession) {
this.mysession = mysession;

public boolean doSubmit(String hawb) {
é gi ©Shanghai Globalization Lab, User Page 19
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boolean mark = true;
logger.debug("#pan# *doSubmit");//SNON-NLS-1$

logger.debug("#pan# *doSubmit to check :::" );//SNON-NLS-1$
logger.debug(hawb);

if (inputValidate(hawb)) {
logger.debug("#pan#*doSubmit is true™); //SNON-NLS-1$

ShipmentBean sb = null;
TrackByHAWBBrieflyBusinessBean trackBizbean = new
TrackByHAWBBrieflyBusinessBean();

try {
sb = trackBizbean.getShipmentDetailByHAWB (hawb);

mysession.setAttribute(TrackConstansts.SHIPMENT _INFO, sb);
} catch (TrackException e) {

String errString = e.getErrorCode();
mysession.setAttribute(TrackConstansts. ERROR_MSG, errString);
mark = false;

}else {
logger.debug("#pan# doSubmit is false™); //SNON-NLS-1$

mark = false;

}

return mark;

public boolean inputValidate(String hawb) {

if (null == hawb || 0 == hawb.length()|| 0 == hawb.trim().length()) {
getSession().setAttribute(TrackConstansts. ERROR_MSG,
TrackConstansts.EM_HAWBEMPTY);
logger.debug("hawb is null™); //SNON-NLS-1$
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return false;

try {
Integer.parselnt(hawb);

} catch (NumberFormatException e) {

getSession().setAttribute(TrackConstansts. ERROR_MSG,
TrackConstansts.EM_HAWBINVALID);
logger.debug("hawb is not numberic"); //SNON-NLS-1$

return false;

¥
if (8 I= hawb.length()) {

getSession().setAttribute(TrackConstansts. ERROR_MSG,
TrackConstansts.EM_HAWBLEN);
logger.debug("hawb.length = 8"); //SNON-NLS-1$

return false;

return true;

3.2.5 BusinessBean

The purpose of BusinessBean is to handle the business operations. For example, access database
through DAO, or invoke other subsystem through web services. BusinessBean is called by
ActionBean and return the result to ActionBean. If error occurs, it will throw exceptions to
ActionBean. Each portlet only has one BusinessBean, and all the ActionBeans for this portlet
share this BusinessBean.
JSR168 Portlet — BusinessBean
/*

* Author: Peter Class: <TrackByHAWBBrieflyBusinessBean>

*  Description: This class is to handle the business logic of UC TrackByHAWB and
TrackByHAWBBriefly

* Version: <1.0>

* Creation date: <2005-8-9>

* Department: Shanghai Globalization

>
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* Laboratory Copyright (c)2005, International Business Machines Corporation,
* All rights reserved.
*/

package com.ibm.sgl.oged.wemp.businessbean;

import com.ibm.sgl.oged.constant. TrackConstansts;

import com.ibm.sgl.oged.db.manager.ShipmentBeanManager;
import com.ibm.sgl.oged.db.databean.ShipmentBean;

import com.ibm.sgl.oged.exception.TrackException;

import com.ibm.sgl.oged.util. DBException;

import org.apache.log4j.*;

/**

* @value 1.0
* @author panxf
*
* TODO To change the template for this generated type comment go to
* Window - Preferences - Java - Code Style - Code Templates
*/
public class TrackByHAWBBrieflyBusinessBean {

/**

* Comment for <code>shipmentbeanmanager</code>
*
* @generated "UML to Java
* (com.ibm.xtools.transform.uml2.java.internal. UML2JavaTransform)"
*/
private ShipmentBeanManager shipmentbeanmanager = new ShipmentBeanManager();

/**
* logger
*/
private static Logger logger = Logger
.getLogger(TrackByHAWBBrieflyBusinessBean.class);

/**

* @param hawb
* @return
* @throws TrackException
* @generated "UML to Java
* (com.ibm.xtools.transform.uml2.java.internal. UML2JavaTransform)"
*/
public ShipmentBean getShipmentDetailByHAWB(String hawb) throws TrackException {

>
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ShipmentBean sb = new ShipmentBean();
logger.debug("#Peter# start  to get the shipment info"); /SNON-NLS-1$
try {
sb = shipmentbeanmanager.getShipmentByHAWB (hawb);
} catch (DBEXxception €) {

String errMsg = e.getErrorCode();
if (TrackConstansts.EM_GENERAL.equals(errMsg)) {
throw new TrackException(errMsg);

}else {
logger.debug(e);
}
}
if (null ==sb) {
logger.debug("#Peter# buz bean is null "); //SNON-NLS-1$
}
logger.debug("#Peter# buz bean pan get the shipment info"); //SNON-NLS-1$
return sb;
}
/**

* The string representation is CLASS NAME
* Where NAME is the company name and PRODUCT is the product name.
* @return
*/
public String toString() {
return TrackByHAWBBrieflyBusinessBean.class.toString();

¥
326 DAO

The purpose of DAO is to handle the database related operations. For example, insert, query,
update, delete and etc.

Code sample
/*
* Class: < G11NpreferenceBeanManager >
* Description:< This class handles all GLINPREFERENCE related operation.>
* Version: <1.0>
* Author: < Lori >
* Creation date: <2005-8-9>
* Department: Shanghai Globalization Laboratory
* Copyright (c) 2005, International Business Machines Corporation,

>
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* All rights reserved.
*/
package com.ibm.sgl.oged.db.manager;

import java.sgl.Connection;

import java.sgl.PreparedStatement;
import java.sgl.ResultSet;

import java.sql.SQLEXxception;

import org.apache.log4j.Logger;

import com.ibm.sgl.oged.db.connector.JDBCConnectionProvider;
import com.ibm.sgl.oged.db.databean.G11NPreferenceBean;
import com.ibm.sgl.oged.db.databean.ShipmentBean;

import com.ibm.sgl.oged.util.CodeSystem;

import com.ibm.sgl.oged.util. DBException;

public class G11NPreferenceBeanManager {

private G11NPreferenceBean glinPreferenceBean = null;
private Logger logger = Logger.getLogger(G11NPreferenceBean.class.getName());
private JDBCConnectionProvider _jdbcConnectionProvider = null;

public G11NPreferenceBeanManager() {
_jdbcConnectionProvider = new JDBCConnectionProvider();
_jdbcConnectionProvider.setDBName(DBConstants. OGEDDBName);
_jdbcConnectionProvider.start();

/**

* insert one gllnpreferencebean to table "insert into GIINPREFERENCE
* values(?,?,2,2,2,2,2,2,2,2)"

*

* @param gllnPreferenceBean

* glinPreferenceBean to be inserted into table

* @return true success, false fail

* @throws DBEXxception

*/

public boolean insertG11NPreference(G11NPreferenceBean gllnPreferencebean)
throws DBEXxception {
if (null == gl11lnPreferencebean) {

logger.debug(“'null bean");//$NON-NLS-1$ }
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boolean returnflag = false;

Connection conn = null;

PreparedStatement ps = null;

StringBuffer strSql = null;

strSql = new StringBuffer(DBConstants.InitSize);

strSql = strSqgl.append(DBConstants.insertG11NPreference);

conn = _jdbcConnectionProvider.getConnection();

try {
ps = conn.prepareStatement(strSqgl.toString());
ps.setString(1, gllnPreferencebean.getUserid());
ps.setString(2, gl1lnPreferencebean.getLanguage());
ps.setString(3, gllnPreferencebean.getCurrency());
ps.setString(4, gllnPreferencebean.getDatetime());
ps.setString(5, gllnPreferencebean.getCalendar());
ps.setString(6, gllnPreferencebean.get\Weight());
ps.setString(7, gllnPreferencebean.getLength());
ps.setString(8, gllnPreferencebean.getField1());
ps.setString(9, gllnPreferencebean.getField2());
ps.setString(10, gl1lnPreferencebean.getField3());
/I see if executeUpdate success
if (0 != ps.executeUpdate()) {

returnflag = true;

Y/end of try
catch (SQLException €) {
logger.debug("Exception in db access, input may not be valid");//$NON-NLS-1$
/I e.printStackTrace();
DBException dbe = new DBException();
dbe.setErrorCode(DBEXxception.KEYEXSIT);
throw dbe;
}/end of catch
finally {
try {
ps.close();
}/end of try ps.close
catch (SQLException €) {
logger.debug(“close preparedstatement failed");//SNON-NLS-1$
I e.printStackTrace();

}/end of catch
try {
conn.close();
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}/end of try conn.close

catch (SQLException €) {
logger.debug(“close connection failed");//SNON-NLS-1$
Il e.printStackTrace();

} /lend of catch

}/end of finally
return returnflag;

/**

* get G11NPreference from table by userid "select * from G11INPREFERENCE
* where userid=?"
*
* @param userid
* @return
* @throws DBEXxception
*/
public G11NPreferenceBean getG11NPreference(String userid)
throws DBEXxception {
if (null == userid) {
return null;
}
glinPreferenceBean = null;
Connection conn = null;
PreparedStatement ps = null;
StringBuffer strSqgl = null;
ResultSet rs = null;
strSql = new StringBuffer(DBConstants.InitSize);
strSql = strSqgl.append(DBConstants.getG11NPreference);
conn = _jdbcConnectionProvider.getConnection();
try {
ps = conn.prepareStatement(strSqgl.toString());
ps.setString(1, userid);

rs = ps.executeQuery();
if (rs.next()) {
logger.debug(“get one record");//SNON-NLS-1$
glinPreferenceBean = new G11NPreferenceBean(rs.getString(1), rs
.getString(2), rs.getString(3), rs.getString(4), rs
.getString(5), rs.getString(6), rs.getString(7), rs
.getString(8), rs.getString(9), rs.getString(10));
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}/end of if(rs.next)
else {
logger.debug("no result match hawb™");//SNON-NLS-1$
glinPreferenceBean = null;
}/end of else
Y/end of try
catch (SQLException €) {
logger.debug("Exception in db access");//SNON-NLS-1$
/I e.printStackTrace();
DBEXxception dbe = new DBException();
dbe.setErrorCode(DBException.UNKOWNPROBLEM);
throw dbe;

}/end of catch
finally {
try {
rs.close();
ps.close();
}/end of try ps.close
catch (SQLException €) {
logger.debug(“close prearedstement failed");//SNON-NLS-1$
I e.printStackTrace();

}/end of catch
try {
conn.close();
}/end of try conn.close
catch (SQLException €) {
logger.debug("Close connection failed");//$NON-NLS-1$
Il e.printStackTrace();
} /lend of catch
}/end of finally
return gl1lnPreferenceBean;

/**
* updateG11NPreference by G11NPreferenceBean "update G1IINPREFERENCE set
* language="?,currency="2,datetime=?,calendar=?,weight=?,length=?
* field1="? field2=?,field3=? where userid=?"
*
* @param gllnPreferenceBean
* G11NPreferenceBean to be updated

>
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* @return true success,false fail
* @throws DBEXxception

*/

public boolean updateG11NPreference(G11NPreferenceBean gllnPreferencebean)

throws DBEXxception {
if (null == gllnPreferenceBean) {
return false;

boolean returnflag = false;
Connection conn = null;
PreparedStatement ps = null;
StringBuffer strSqgl = null;

strSql = new StringBuffer(DBConstants.InitSize);
strSql = strSqgl.append(DBConstants.updateG11NPreference);
conn = _jdbcConnectionProvider.getConnection();

try {
ps = conn.prepareStatement(strSqgl.toString());

ps.setString(1, gllnPreferencebean.getLanguage());
ps.setString(2, gllnPreferencebean.getCurrency());
ps.setString(3, gllnPreferencebean.getDatetime());
ps.setString(4, gllnPreferencebean.getCalendar());
ps.setString(5, gllnPreferencebean.getWeight());
ps.setString(6, gllnPreferencebean.getLength());
ps.setString(7, gllnPreferencebean.getField1());
ps.setString(8, gllnPreferencebean.getField2());
ps.setString(9, gllnPreferencebean.getField3());
ps.setString(10, gl1lnPreferencebean.getUserid());

if (0 != ps.executeUpdate()) {
returnflag = true;
}else {
DBException dbe = new DBEXxception();
dbe.setErrorCode(DBException.NOROWUPDATED);
throw dbe;
}
Y/end of try
catch (SQLException €) {
logger.debug("Exception in db access");//SNON-NLS-1$
/I e.printStackTrace();
DBEXxception dbe = new DBEXxception();

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006

Page 28



Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

dbe.setErrorCode(DBEXxception.KEYEXSIT);
throw dbe;
}/end of catch
finally {
try {
ps.close();
}/end of try ps.close
catch (SQLException €) {

logger.debug(“close preparedstatement failed");//SNON-NLS-1$

}/end of catch
try {
conn.close();
}/end of try conn.close
catch (SQLException €) {

logger.debug(“close preparedstatement failed");//SNON-NLS-1$

} /lend of catch
}/end of finally
return returnflag;

3.2.7 DataBean

Commonly DataBean is related to a table in database, you can also define a DataBean as data
transferring between classes. DataBean is a set of data, which will be used everywhere in the

portal project. Such as portlet, ActionBean, BusinessBean, JSP and etc.

DataBean sample
/*
* Class: <DriverBean>
* Description:<This bean is to handle Driver related info .>
* Version: <1.0>
* Author: <Lori>
* Creation date: <2005-9-9>
* Department: Shanghai Globalization Laboratory
* Copyright (c) 2005, International Business Machines Corporation,
* All rights reserved.
*/
package com.ibm.sgl.oged.db.databean;

public class DriverBean {

>
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/**
* userid of table driver
*/
private String userid = null;
/**
* password field of table driver
*/
private String password = null;
/**
* role field of table driver
*/
private String role = null;

/**

* getPassword
* @return Returns the password.
*/
public final String getPassword() {
return password;

/**

* setPassword
* @param password
* The password to set.
*/
public final void setPassword(String password) {
this.password = password;

/**

* getRole
* @return Returns the role.
*/
public final String getRole() {
return role;

/**

* setRole

* @param role

&3 The role to set.
*/

>
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public final void setRole(String role) {
this.role = role;

/**

* getUserid
* @return Returns the userid.
*/
public final String getUserid() {
return userid;

/**
* @param userid
* The userid to set.
*/
public final void setUserid(String userid) {
this.userid = userid;

/**
* @return return string
* The string representation is "name=NAME, product=PRODUCT"

* Where NAME is the company name and PRODUCT is the product name.
*/

public final String toString() {
/I TODO Auto-generated method stub
return super.toString();

3.2.8 Database

Database is the repository, which will store the data used in portal applications.
You can design the database in RSA. All fields should de defined here.Here is a sample.
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1 1HFREFERENCE
o zi?USERID © USER

LAHGIAGE
CUERERCY
DATETIME
CATEFDAR
WELGHT
LEWGTH
FIELDI
FIELDZ
FIELDS

[N OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0

Then you can generate the script in RSA.

-- Please run the command: db2 -tvf OGED.sql
CREATE DATABASE OGEDWEMP;
CONNECT TO OGEDWEMP;

CREATE SCHEMA DB2INST1;

CREATE TABLE DB2INST1.G11NPREFERENCE
(USERID VARCHAR(32) NOT NULL,

LANGUAGE VARCHAR(32) NOT NULL,
CURRENCY VARCHAR(10) NOT NULL,
DATETIME VARCHAR(10) NOT NULL,
CALENDAR VARCHAR(10) NOT NULL,
WEIGHT VARCHAR(10) NOT NULL,
LENGTH VARCHAR(10) NOT NULL,
FIELD1 VARCHAR(32),
FIELD2 VARCHAR(32),
FIELD3 VARCHAR(32));

ALTER TABLE DB2INST1.G11NPREFERENCE
ADD CONSTRAINT C2239253 PRIMARY KEY (USERID);

COMMENT ON TABLE DB2INST1.G11NPREFERENCE IS 'For G11N Preference';
ALTER TABLE DB2INST1.G11NPREFERENCE
ADD CONSTRAINT USERID FOREIGN KEY (USERID)

REFERENCES DB2INST1.USER(USERID);

CONNECT RESET;
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3.2.9 Exception

Each portlet or subsystem might have a corresponding exception class if required. Each exception
class must have a getMessage() method to return the detailed error information.

Exception sample
package com.ibm.sgl.oged.exception;

public class TrackException extends Exception {
/**
* Indicate the error message
*/

private String _errorCode = "";

/**

* Default constructor

*/
public TrackException () {
}

/**
* The constructor with error code as parameter.
* @param errorCode
*/
public TrackException (String errorCode) {
this._errorCode = errorCode;

/**
* Get the error code which is set in the business bean.
* @return errorCode indicate the Error Message.
*/
final public String getErrorCode () {
return _errorCode;

/**
* set the error code
*/
final public void setErrorCode (String errorCode) {
this._errorCode = errorCode;
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3.2.10 Constant

To void using string constants in claas, we need to collect them and put into one constant class.
Each portlet or subsystem might have a corresponding constant class if required. Any direct use of
constants in other classes should be avoided.

Constant sample
package com.ibm.sgl.oged.constant;
public class TrackConstansts {
/**
* Constants for JSP file name
*/
public static final String TRACK_ADVANCED_JSP = "/html/TrackByAdvanced.jsp";
public static final String TRACK_ADVANCED RESULT JSP
"/html/TrackByAdvancedResult.jsp™;

/**

* Constants for button name

*/
public static final String TRACK_DETAIL_BACK = "detail_back";
public static final String TRACK_DETAIL_SUBMIT = "detail_submit";

/**

* Constants for title name

*/
public static final String TRACK BY _HAWB SUBMIT _BUTTON =
"TrackByHAWBSubmit";

¥

3.2.11 Utility Class

We need to define the common and reusable utilities into utility class. Then all portlets can invoke
the methods in utility class. Such as, string handling, locale handling, measurement, localization
pack handling and etc.

Utility Class sample
package com.ibm.sgl.oged.util;

public class MeasurementScaleConverter {
/**
* Unit convertion step.
*/
public static final int SCALE_METER = 100;

/**

>
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* Unit convertion step.
*/
public static final int SCALE_FOOT = 12;

private MeasurementScaleConverter() {

super();
/[ TODO Auto-generated constructor stub

/**

* This method will convert the value in one unit to another unit according
* the scale of the value.

*

* @param unit

* The input unit of this attribute. The values are from the code
* system.

* @param length

* The input value of this attribute.

* @return an object array which contains two objects. The first object is

* the converted float value. The second object is the converted

&3 unit.If the value needs not to be converted, the returned value

* will be the same as the parameters.

*/

public final static Object[] convert(Double length, String unit) {
/I TODO Auto-generated method stub
double lengthValue = length.doubleValue();
String convertedUnit = unit;
if (CodeSystem.LENGTH_METER.equals(unit)) {
if (1.0 > lengthValue) {
lengthValue *= SCALE_METER;
convertedUnit = CodeSystem.LENGTH_CENTIMETRE;
}
} else if (CodeSystem.LENGTH_CENTIMETRE.equals(unit)) {
if (100.0 < lengthValue) {
lengthValue /= SCALE_METER,;
convertedUnit = CodeSystem.LENGTH_METER;
}
} else if (CodeSystem.LENGTH_FEET.equals(unit)) {
if (1.0 > lengthValue) {
lengthValue *= SCALE_FOOT;
convertedUnit = CodeSystem.LENGTH_INCH;

}
} else if (CodeSystem.LENGTH_INCH.equals(unit)) {
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if (12.0 < lengthValue) {
lengthValue /= SCALE_FOOT;
convertedUnit = CodeSystem.LENGTH_FEET;

Obiject[] ret = new Object[2];
ret[0] = new Double(lengthValue);
ret[1] = convertedUnit;

return ret;

3.2.12 Code System

Code System is used to store the data, which will be used for data exchanging between portlets
and subsystems. The constant in Code System is a key in the applications. It will be replaced
with translated strings using WPS tag in JSP page.

Code System sample
package com.ibm.sgl.oged.util;

import java.util. ArrayList;

public class CodeSystem {
/Ipublic static final String Key = "Value" //Description

/IReport Type

public static final String REPORT_TYPE_FULL ="RT1001"; //Full

public static final String REPORT_TYPE_MEDIUM = "RT1002"; //Medium
public static final String REPORT_TYPE_BRIEF = "RT1003"; //Brief

public static final ArrayList getReportTypeVector() {
ArrayList result = new ArrayL.ist();
result.add(0,CodeSystem.REPORT_TYPE_FULL);
result.add(1,CodeSystem.REPORT_TYPE_MEDIUM);
result.add(2,CodeSystem.REPORT_TYPE_BRIEF);
return result;
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3.2.13 Subsystem

Subsystem is other application beside portlet, which will be invoked by portal applications. For
example, BusinessBean can invoke the subsystem through web services.

Here is a sample. In the class RequestReportBusinessBean, which invokes the email Web
Service of other subsystem.

Subsystem sammple
EmailWebServiceProxy proxy = new EmailWebServiceProxy();
HtmlEmail htmlEmail = new HtmIEmail();
htmlEmail.setCustomerlD(reportRequest.getUserid());
htmlEmail.setReport_format(reportRequest.getFormat());
String mailContent = htmlEmail.mail4Report(ReportConstansts.LOCALE_US);
String mailSubject = LPUtil.getLPValue(locale, ReportConstansts.FILE_MYTASK,
ReportConstansts.EMAIL_SUBJECT);

try {
final boolean ifgroup = proxy.sendMailToGroup(group, mailSubject,

mailContent);
} catch (RemoteException el) {
logger.error(el.getMessage());

3.2.14 GBO

Global Business Object (GBO) is a Java based technology, which offers a solution for constructing
culturally aware graphical controls in global J2EE applications. Through encapsulating the
functions into a reusable globalization tag library, GBO allows programmers to create global GUI
functions in their Java Server Pages (JSP) files very conveniently.

Note: Please contact GBO team for the latest GBO version.

GBO sample
<tr>
<td class="td3<%=dir%>"><Ip:value key="TABLE_BEGINDATE" /> </td>
<td class="td6">

<input type="text" id="datel_Show" name="begindateshow"
readonly="readonly" value=<%=begindate%>>
<input type="hidden" id="date1" name="begindate"

<%if(0'=begindatehidden.length())%> value=<%=begindatehidden%>>

<input type="hidden" id="datel Unformat" >

<img src="/wps/oged/images/calendar.gif" alt="<Ip_alt:value
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key="CALENDAR"/>"
onclick="window.open('<%=renderRequest.getContextPath()%>/html/popupcalendar/PopupCalen
dar.jsp?locale=<%=poplocale%>','datel’,'height=200,width=210,scrollbars=no,resizable=yes,statu
s=no,menu=no,toolbar=no")">
</td>
<tr>

For details about GBO, please refer to the section Enable GBO in portal project

3.2.15 Logdj

We can use Log4j to write the log in log files in portal project.

3.2.15.1 Add the jar file into project

Please add the log4j-1.2.9.jar into your portal project first. For example:
PortalProject\WebContent\WEB-INF\lib

3.2.15.2 Add the log4j.properties into project
Add the logd4j.properties file into PortalProject\JavaSource\

3.2.15.3 Modify the log4j.properties

You may need to customize the log4j.properties, such as log level, log file directory and log
format.

Here is a sample.

# An example log4j configuration file that outputs to System.out. The output information
consists of relative time, log level, thread name, logger name, nested diagnostic context and the
message in that order.

# For the general syntax of property based configuration files see the documenation of
org.apache.log4j.PropertyConfigurator.

log4j.rootLogger=DEBUG, FILE

# Al is set to be a ConsoleAppender which outputs to System.out.
#log4j.appender.Al=org.apache.log4j.ConsoleAppender

# Al uses PatternLayout.
#log4j.appender.Al.layout=org.apache.log4j.PatternLayout

# The conversion pattern uses format specifiers. You might want to
# change the pattern an watch the output format change.
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#log4j.appender.Al.layout.ConversionPattern=%-4r %-5p [%t] %37¢ %3x - %m%n

# In this example, we are not really interested in INNER loop or SWAP
# messages. See the effects of uncommenting and changing the levels of
# the following loggers.

# log4j.logger.org.apache.log4j.examples.SortAlgo.INNER=WARN

# log4j.logger.org.apache.log4j.examples.SortAlgo.SWAP=WARN

log4j.appender.FILE=org.apache.log4j.FileAppender
log4j.appender.FILE.File=/opt/WebSphere/PortalServer/log/oged.log
log4j.appender.FILE.Append=true

log4j.appender.FILE.layout=org.apache.log4j.PatternLayout
#log4j.appender.FILE.layout.ConversionPattern=%-4r %-5p [%t] %37¢ %3x - %m%n
log4j.appender.FILE.layout.ConversionPattern=[%-d{yyyy-MM-dd HH:mm:ss}] [%37c] %3x -
%m%n

3.2.15.4 Invoke the log4j in class

There are three levels of log, info, debug and error. You can use like the following.
logger.inf(*“Info here.”);

logger.debug(“Just debug here”);

logger.error(“Error occurs!”)’

Here is a sample.
package com.ibm.sgl.oged.wemp.businesshean;

import com.ibm.sgl.oged.constant. TrackConstansts;

import com.ibm.sgl.oged.db.manager.ShipmentBeanManager;
import com.ibm.sgl.oged.db.databean.ShipmentBean;

import com.ibm.sgl.oged.exception. TrackException;

import com.ibm.sgl.oged.util. DBException;

import org.apache.log4j.*;
public class TrackByHAWBBrieflyBusinessBean {

private ShipmentBeanManager shipmentbeanmanager = new ShipmentBeanManager();

/**

* logger
*/

>
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private static Logger logger =
Logger.getLogger(TrackByHAWBBTrieflyBusinessBean.class);

public ShipmentBean getShipmentDetailByHAWB(String hawb) throws TrackException {
ShipmentBean sb = new ShipmentBean();
logger.debug(**#Peter# start to get the shipment info'"); //SNON-NLS-1$
try {
sb = shipmentbeanmanager.getShipmentByHAWB (hawb);
} catch (DBEXxception €) {

String errMsg = e.getErrorCode();
if (TrackConstansts.EM_GENERAL.equals(errMsg)) {
throw new TrackException(errMsg);

}else {
logger.debug(e);
}
}
if (null ==sb) {
logger.debug("#Peter# buz bean is null "); //SNON-NLS-1$
}
logger.debug("#Peter# buz bean pan get the shipment info"); /SNON-NLS-1$
return sb;
}

3.2.155 Logs in log file
Here is the log in log file oged.log.

[2005-11-10 16:40:00] [com.ibm.sgl.oged.wemp.portlet.SelectLanguagePortlet] - Enter
doView method!
[2005-11-10 16:40:00] [com.ibm.sgl.oged.wemp.portlet.SelectLanguagePortlet] - The jsp is
SelectLanguage
[2005-11-10 16:40:00] [com.ibm.sgl.oged.wemp.portlet.SelectLanguagePortlet] - Exit

doView method!

For details, please refer to the section_Log Handling in Portal Project

3.2.16 Images and Stylesheet
To make the portal website more beautiful, we need to add some images and apply the stylesheet
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for JSP page.

3.2.16.1 Add images

We can add the images into project: PortalProject\WebContent\images

Or we can separate them from project and place the images into wps.war directory like the
following.

opt\WebSphere\AppServeninstalled Apps\ogedwemp\wps.ear\wps.war\oged\images

Note: If you want to use different image for each locale,please use the subdirectory for the locale
as following.

images\en_US

images\zh_CN

images\fr_FR

images\ar_EG

3.2.16.2 Apply stylesheet

The stylesheet can be the same directory with images. Please pay attention to the tag .tdlrtl ,
which is used to support bidi language.
Here is the sample of stylesheet.
td1{
border-left: 5px solid #clclcl;
font-weight: bold,;
color: #727272;
padding: 5px 10px 5px 10pX;
border-bottom: 1px solid #clclcl;
border-right: solid 1px #clclcl;
background: #eeeeee;
}
tdlrtl{
border-right: 5px solid #clclcl,;
font-weight: bold,;
color: #727272;
padding: 5px 10px 5px 10pX;
border-bottom: 1px solid #clclcl;
border-left: solid 1px #clclcl;
background: #eeeeee;

For details, please refer to the section Artwork in portal
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4. Portal development process

Here are the detail steps for portal development.

4.1 Portal development overview

Here is the portal development overview. There are several roles and scenes.

1. Design

The designer will do the design in RSA or RSM according to the use case in RequestPro. In the
design phase, the designer will deliver a lot of design documents, including Ul pages, portlets,
interface, modeling and etc.

2. Development

The portlet developer will do the development in RAD or RSA according to the design documents.
Then deploy the war file and debug the application in portal debugging server.

3. Administration

The portal administrator will do the administration in portal admin console; for example, create
users and group, create pages, set the access permissions for page or portlet.

4. Test

The testers will access the portal website in portal testing server, and then submit defects in
ClearQuest or TCT.

Portal Development Overview _
By Luke 2005-11-15

Designer

-Portlets
-Utility class

-Code System
-Subsystem

-Pages
-Users and groups
-Authority

Administrator

4.2 Design

The designer will do the design in RSA or RSM according to the use case in RequestPro. In the
design phase, the designer will deliver a lot of design documents.
® For the developer: Ul pages, portlets, utility classes, code system, subsystems.

9
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® For portal administrator: pages, users and groups, authority and etc.

4.3 Development

Here is the portlet project development process.

4.3.1 Setup Environment

Before you can develop a portal project, you need to setup the portal server environment and
development environment. Here is the environment description.

Portal Server

There are two portal servers, one is for test and deployment, and another is for debugging. The
following needs to be installed.

® VVMWare (It will help you to easily backup the portal server.)

Redhat Linux AS3.0 update3

WPS for Multiplatform V5.1 (WAS, WPS, DB2, LDAP)

WEMP V5.1 (Optional. It’s used to develop XDIME portlets to support mobile device.)
Samba (It can help you easily access the file directory in portal server.)

SSH (Start the ssh service in portal server. It can help you control the portal server remotely.)

Development environment

® RAD V6.0 or RSAV6.0

® \WebSphere Portal V5.1 Test Environment (Optional. You can debug the porllet in portal
server directly. )

® Portal Toolkit (It’s packaged with RAD now. If you want to develop XDIME portlet, please
install Mobile Portal Toolkit in RAD V6.0)

® UltraEdit

® SSH (It can help you control the portal server remotely.)

For details about how to setup environment, please refer to the InfoCenter of WPS and the
Redbook sg246681.pdf (Rational Application Developer V6 Portlet Application Development and
Portal Tools).

4.3.2 Transformation from Model to Java

The designer has designed many classes in RSA. The developer needs to run the Transformation
from Model to Java in RSA. The generated java file can be imported into portlet project.
In RSA, right click the packages, select Transform -> Run Transformation -> UML to Java
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Select a project that you want to put the generated java files and click Run.
Then you can view the generated java files in the target project like the following image.
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- Jj'l'l'EMPPr-:nject [wanghh_wiew_shnion]
Web Diagram
+ " Deployment Descriptor: WEMEFroject
+ Fortlet Deployment Descriptor
—|- [ Tava Resources
- @ JawaSource

+

gad. constant
com. 1bm. . exception
com. 1bm. .wemp. actionbean
com. 1bm. .wemp. buzineszhean
com. 1bm. .wemp. portlet
LocalizationFack ar EG
LocalizatioenFack en US
LocalizationPack fr_FR
LocalizationFPack zh CH

wempproject. nl

+
:
:
:
T
T
i
i
i

configz—all. properties
configzfile

logdj. properties
logdj—1.2.9. jar
ibmjndi. jar
ogedutil. jar
EmailWSClient WASS. jar

Note: For the referenced object in model project is platform-independent, you may need to do
some modifications for the generate java file after transportation. For example, change the object
to Date/Time, Calendar, ArrayList and etc.

4.3.3 Create a portlet project

Now you can create a portlet project in RAD. Please do as the following steps.

1. Create a portlet project in RAD

In RAD, select menu File -> New -> Project...

@‘J Nodeling — Calculate Yolumetric Weight::Calculate Yolumetric Weig

File dit Havigate Search Project Diagram Medeling ClearCaze PBun Windew Help

I T I
Cloze Ctrl+F4 % Folder
Cloze 11 Ctrl+5hift+F4
| File
1= B~ Pluglet .
= "
E:] Save As. .. QE? ML Model
|_="j" Example :
% Other Ctrl+h
[] Other...

2. In the left image, you can select Portlet Project (It’s IBM API portlet) or Portlet Project

S
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(JSR 168). For the difference between IBM API portlet and JSR168 portlet, please refer to the
section Comparison of several types of portlet projects
3. Input the project name and select the target server, then click Next.

-@:I-He' Project @
Select a wizard
Create a new portlet project (TSR 1881 [—
Wizards:
5 Dymamic ¥eb Project ~

%1 ETB Froject
(3% Tava Project
B Portal Project

5
+ (= EJE
+)- (% T2EE
+- (2% Tava
(= MCE
4 (2 Modeling
+ (= Fluglets
(2 Portal
(2 Server v

7 Show ALl Wizards.

& Hew Portlet Project (ISR 168}

Portlet Project (JSR 163)

Specify = name and location for the mew portlst project (TSR 153) E —H
Fame: TestPrj

Project location: |E:‘\RADB‘workspaceiTestPrj Browse. ..

[¥ Create a portlet

Hide Adwamced <<

Servlet wersion: [2.3 -]

Target server:

[V Add module to an EAR project

EAR project: [TestPrjEAR v Hew ..

Context Reot:  [TestPrj

[7 Add support for annotated Java classes

< Back Bext > | Finish | Cancel
S —

4. Select portlet type

You can select the type of new portlet from list.
Empty portlet (JSR168)

Basic portlet (JSR168)

Faces portlet (JSR168)

HTML/XDIME portlet (JSR168)

Structs XDIME portlet (JSR168)

For the difference between IBM API portlet, please refer to the section Comparison of several
types of portlet projects

5. Features

Just click Next to the next step.

S
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-:@:I-lle' Portlet Project (JSE 16B8)

Portlet Type

Select the pertlet type of the new portlet that will be created in the
project.

L

Select the typs of new portlst

" Empty portlet (TSE 183)

¢ Bazic portlet (TSE 183)

" Faces portlet (TSR 188)
" HIML/XDIME Portlet
¢ Struts XDIME Portlet

Description:

Create a portlet that extends the GenericPortlet class defined in the Jawa

Portlet Specification Yersion 1.0 (TSR 168). You will be asked to select
several options for gensrating sample code

Tou may eustomize the code to integrate the portlet into your portal.

<Back || B> || Einish | Concel |

@ Wew Portlet Project (ISR 168)

Features

Select a Web Froject feature. A feature can provide additional

functionality for the portlet project. i‘ !

Web Project features

[CJSAF Data hccess Enables Web modules to aceess data
Clsicbel data access in SAF systems, through the SO
%00 Relational databaze runtime archithoture.

[E%eb Disgran
=[] TSP Tag Libraries
[]J5P Standard Tag Library
OQutility Tag Libraries

Description:

<Back || Hewt > | | Finish | Cancel
1

6. Portlet Settings

Please change the package prefix here, for example, com.ibm.sgl.oged.wemp.
7. Single Sign-On

Just click Next to the next step.
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@ New Portlet Project (JSR 168} X

Portlet Settings

Define the general settings of the portlet E :lq

General

Fortlet name: [TestPrj

Display mame: [TestPrj portlet

Description: |This iz a test portlet project

Internationalization

Locale: Jen | [Enelish

Dizplay name: [TestPrj partlet

Description: |This iz a test portlet

Code generstion options

v Ch;}ge code generation optiens

Fackage prefix" [com ibm. =21 oged wemp. portlet

Class prefin:  |TestPrjPortlet

< Back l Next > ‘ Finish Eomedil |
! I

@& New Portlet Project (ISR 168)

Single Sign-On

Define the single sign-on options of the portlet. E :H

[~ hdd credentisl wault handling
o

-
-
-

-

<Baek |TTHa 3 Finish | el
———— 7

8. Action and Preferences

Just click Next to the next step.

9. Miscellaneous

You can select the markup and mode, then click Finish to create a new portlet project.
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New Portlet Project (TSE 168) X

Action and Preferences

Define the action handling and the preferences handling of the portlet E _H

Portlet action handling
[V Add sctien request handler
[V Add form sample

Portlet preferences
[~ Add preferences handling
r

Finish | Caneal |
® New Portlet Project (TSR L68)

Miscellaneous

Select miscellaneous options of the portlet E —H

Addi tional markups

I~ Add chtnl markup suppert
[~ Add wnl markup support
[ Add edit mode

[ 4dd help mode

I~ Add configure mode

a7 [[[ Einish []  cemea |

10. After the portlet is created successfully, you can view the project in the workspace.

package com. ibm.=sgl.oged. vemp.porclet;

P import java.io.®:[]

", Wb Diagran

#l-'Z5) Deplopment Descriptor: TestPrj
U] Portlet Deployment Descriptor
= (% Tava Rezources

= B JavaSource

E con. ibm. sgl oged wemp. por tlet

- c TestFrijFortlet

P
k3

+ A sample portlet based on GensricFortlet
*

Vlyuhlin class TestPrjPorflet extends GenericPortlet {

w0 [I) TestPribortletTessionbasm, java public static final String JSP_FOLDER = r/com_ibm_sgl_oged_wen
&£ com. ibm. sgl. aged. wemp. portlet. nl
# =i TRE System Library [WebSphers Portal public static final String VIEW_JSP = "TestPriFortletVisw":
+-E, WebSphere Portal v5.1 Runtime
I = RebContent
2 > com_ibm_sgl_oged wanp_portlet public static final String SESSICN_BEAN = "TestPrjPortlscSession
= B i=p
public static final String FORM_SUBMIT = "TestPrjPortletFormsSuk
E TestFriFortletVien. jsp public static final String FORM TEXT = "TestPrjPortletFormTex
(2 META-. L
=I-(= WEB-INF - sun
(5 classes * Serve up the <code>wiew</code> mode.
= 1ib

+

@ ibm-web-bnd. xmi ) 3
% @see javex.portlet.GenericPortlecgdoView(javax.porcler. Renderk
ibm—web-ext. xmi

porllal snl =/
web anl - public veid doView(RenderRequest request, RenderResponse response
~

11. When the portlet project is created successfully, please create the java packages according to
the design in model project like the following.
For Portlet
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com.ibm.sgl.oged.portlet
com.ibm.sgl.oged.actionbean
com.ibm.sgl.oged.businessbean

For Common packages
com.ibm.sgl.oged.util
com.ibm.sgl.oged.exception
com.ibm.sgl.oged.constant

For DB packages
com.ibm.sgl.oged.db.connector
com.ibm.sgl.oged.db.manager
com.ibm.sgl.oged.db.databean

12. Import all the java files generated from modeling project.

13. Add the required jars and libs into the classpath of the portlet project.
There are some common jars, such as log4j.jar, gbo.jar, icu4j.jar and etc.

14. Create all the portlets defined in the design document before portlet development.
Just click File - > New -> Portlet, and follow the steps.

15. Add all the JSP files according to the Ul pages.
Change the extension from html to JSP and import into
<PortletProject>\<WebContent>\<Markup>\

16. Modify the JSP file

For the JSP page of a portlet is surrounded by the theme in portal website, we can just need the
main contents and remove the <html>, <head> and <body> in JSP file. Also we need to add the
head for each JSP file.

Here is the sample JSP file.

<%@ page language="java" contentType="text/html; charset=UTF-8" pageEncoding="UTF-8"
session="true"%>

<%@ taglib uri="http://java.sun.com/portlet" prefix="portlet" %>

<%@ page import="com.ibm.sgl.oged.util.LPUtil" %>

<portlet:defineObjects />

<%Q@ taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip" %>
<Ip:load file="welcome.properties"/>

<%@ taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip_alt" %>
<lp_alt:load file="image.properties"/>

<%@include file="Bidi.jsp"%>

>
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<link href="/wps/oged/images/<%-=Ilocale%>/Styles.css" rel="stylesheet" type="text/css">

<%
String locale= LPULtil.getFullLocale(request.getLocale().toString());
%>
<table width="100%" border="0" cellspacing="0" cellpadding="0">
<tr>

<td width="250" height="170" valign="top"  class="Backgroundleftbar"><img
src="/wps/oged/images/<%=Ilocale%>/pic_leftbar.gif" width="250" height="295"
alt="<Ip_alt:value key="PIC_LEFTBAR" />" ></td>

<td width="75%" height="170"><br>

<table width="100%" border="0" align="center" cellpadding="0" cellspacing="0">
<tr>
<td height="30" colspan="2" class="td5<%=dir%>"><Ip:value

key="TITLE_ABOUTSGL" /></td>

</tr>
<tr>
<td width="40%" class="td3<%=dir%>"> <p><img
src="/wps/oged/images/<%=Ilocale%>/SGL.gif" width="320" height="220" alt="<Ip_alt:value
key="SGL" />" ></p></td>
<td width="60%" class="td3<%=dir%>">
<Ip:value key="NOTE_ABOUTSGL" />
<br><Ip:value key="NOTE_ABOUTSLOGAN" />
</td>
</tr>
</table>
<br>
</td>
</tr>
</table>

17. Modify the configuration file

You may need to modify the configuration file of portlet project, such as web.xml, portlet.xml.
Note: For faces portlet, please try to define all the managed beans and navigation rules in
faces-config.xml

18. Add the portlet project into ClearCase for team development.
Right click the project, and select Team - >Share Project.

©Shanghai Globalization Lab, User Page 51
Technology, CSDL, IBM China 2006

>



Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

4.3.4 Portlet Development

Now the developer can import the project from ClearCase and do the portlet development now.
The developer needs to write the portlet application according to the design in the modeling
project.

In the development, please pay attention to the following issues.

®  Session

Portlet jumping

Portlet corporation

Portal DB encoding

Taglib

Login

Language changing

User information

Locale info

Theme customizing

Localization Pack handling

Exception handling

Log handling

Code system

DAO

Bidi support

GBO

Note: Please check in your code in ClearCase regularly. Please do NOT check in the code that
cannot be compiled.

For details about how to develop portlet application, please refer to the InfoCenter of WPS and the
Redbook sg246681.pdf (Rational Application Developer V6 Portlet Application Development and
Portal Tools).

4.3.5 Deployment

Before you want to deploy the portlet project, you’d better reboot the portal server before
deployment; otherwise it will fail due to the lack of memory.

To deploy the portlet project in portal server, please right click the project name in RAD, then
select Export... -> WAR file

©Shanghai Globalization Lab, User Page 52
Technology, CSDL, IBM China 2006

ot



http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/

Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

=3 Dymamic Web Frojects

i
+ OGEDU+i]l [wanghh_wiew_shuion] -
L B
i ; * b sample portl
+ ETestPrJ Hew .

31ic class Test

- &=

+-'23 Deploym .
% Fazt

+ Fortlet L Za=te
+-[B Tava Re 9% Delete public static
+ ctp ]
+ ctp.mked  Befactor ALt+5hiftT * | ppblic static
= WebCont Import. .. ,

htm]
[ 3 T - =
imas B WAR file

ME2=T A9 Refresh
MET# = N

[~ F-F

7 Export. . .

Maca Praiant -

Input the destination path and click Finish. Then the war file for this project will be generated.

WAR Export
Export Web project to the local file system. { @
1 -
Web project: [WEMEFroject ~|
Testination: |CZ"I.I|DCL1.IT|E1‘|+.S and Settings‘wanshh\ S EWEMFProject. war] ﬂ Browse. ..

[v Export source files

v Owerwrite existinz file

Finizh | Cancel

Then you can login portal using wpsadmin/wpsadmin, select Administration -> Portlet
Management -> Web Modules - >Install, input the war file directory, click Next to finish the
installation.

NeSa S | E——
Manage Web Modules
?"’"ﬁ. Portal User Interface Installing a wWeb module, Step 1: Select WAR file.
@:, Portlet Managemen4 Qclick 1
-~ the Cancel b
| WEI:_' M':_'dUIES | F“lin:-r‘fnr'.:f'
Applications and Settingsiwanghhy £\ WEMPProject war| [ BIR. .. | |
Portlets
| Mext || Cancel |

Weh Services

YWeb Clipping

After the installation is finished, the portal administrator needs to manage pages and portlets so
that user can visit the portlet applications.

4.3.6 Administration

The portal administrator needs to do the following in adminconsole so that user can visit the
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portlet applications.

® Create pages

® Set the page tile (Add multilingual title for each page)
® Create users and groups

® Assign the permissions for each page

® Assign the permissions for each portlet

For details about how to manage users, pages and portlets, please refer to the section Portal
Administration

4.3.7 Debug and Test

After the portal administrator finished the administration, the developer or tester can access the

portal website and view the portlet applications.

Here are the detail steps of debugging and test.

1. Access http://hostname: 9080/wps/portal, verify the portlet application.

2. Check the error log

Log is very useful for debugging. Here are the important log files.

° /opt/WebSphere/PortalServer/log/SystemOut.log

° /opt/WebSphere/PortalServer/log/SystemErr.log

o lopt/WebSphere/PortalServer/log/wps_2005.07.21-06.52.19.log

° /opt/WebSphere/PortalServer/log/oged.log  (Your own log file which uses the

log4j.jar.)

Modify the source file in IDE, and rebuild the project.

You can redeploy the project again. Or just copy the JSP, class or policy file to the

corresponding directory of portal server as following.

® JSP:
<WPS>\installedApps\HelloWorld_PA_1_0_LT.ear\HelloWorld.war\helloworld\jsp\xdime

® Class:
<WPS>\installedApps\HelloWorld_PA_1 0_LT.ear\HelloWorld.war\WEB-INF\classes\hello
world
Policy: <WPS>\installedApps\HelloWorld_PA_1 0_LT.ear\HelloWorld.war\mcs-policies

5. Verify the portlet application again

> w

4.4 Maintenance

We need to do the maintenance through the portlet project. Most important is backup! Please do
the backup in each milestone, for example, every day or every week.

Here are the main actions for maintenance.
® \Write a maintenance document, which contains the server information: IP address, hostname,
username, password, VMWare image location, start service and etc.
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Backup the important configuration file

Backup the important log files

Backup the source code of the portal project

Backup the VMWare images of portal server when you have deployed the war file
successfully or have finished the management and authorization for page and portlets.

Each time when you have recovered the portal server from a VMWare image, please verify the
portlet applications.
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5. Best practice of portal development

5.1 Login

The login application is packaged with WPS. We can customize the application to meet our
requirement.

5.1.1 Find the login war directory in the PoralServer as the following.

\\10.1.1.180\opt\WebSphere\PortalServer\installed Apps\Login
Port_pplication_PA_1_0_3T.ear\login.war\WEB-INF\jsp

5.1.2 Modify the following jsp file to meet your requirement
1. LoginView.jsp:

2. Bidilnclude.jsp

3. StatusMessagelnclude.jsp

4. LoggedInView.jsp

5.1.3 Add the style sheet for LoginView.jsp to support vary style sheet for each supported language.

<%

String userLocale = getFullLocale(request.getLocale().toString()); //To get the full locale
like en_US

if (userLocale.equals(*zh_CN™))
{
%>

<LINK href="/wps/oged/images/zh_CN/Styles.css" rel="stylesheet"
type="text/css">

<% }else if(userLocale.equals(*fr_FR"))

{

%>

<LINK href="/wps/oged/images/fr_FR/Styles.css" rel="stylesheet"
type="text/css">

<% }else if(userLocale.equals("ar_EG"))

{

%>

<LINK href="/wps/oged/images/ar_EG/Styles.css" rel="stylesheet"
type="text/css">

<% }else{ %>

<LINK href="/wps/oged/images/en_US/Styles.css" rel="stylesheet"

>
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type="text/css">
<% } %>

5.1.4 You can also add your new LP strings into login properties like the following.

Add the following:
NOTE_INPUT=\u8bf7\u8f93\u5165\u60a8\u7684\u7528\u6237\u540d\u548c\usbc6\u7801
In the file

\\10.1.1.180\opt\WebSphere\PortalServer\installed Apps\L ogin

Port_pplication PA 1 0 3T.ear\login.wan\WEB-INF\nls\loginportlet_zh.properties

5.1.5 Invoke the Ip strings using taglib
<fmt:message key="NOTE_INPUT"/>

5.2 Exception handling in portlet application

Please add the exception handling in your portlet application like the following.

5.2.1 Create the exception class for your portlet.

If you can not find your exception in the package com.ibm.sgl.gpim.exceptions, please add your
own exception class like ProductBusinessException

5.2.2 . Set the error code and throw exception in the methods of business beans

public ProductDetailContainerDataBean getProductByEPCCode (String locale,String EPCCode,
String catalogName) throws ProductBusinessException {

try{
//Write your code here

} catch (RemoteException remoteException) {
throw new ProductBusinessException(*error_code");

5.2.3 Catch the exception in the actionbeans and set the error code in the session.

Note: The error code should be included in the Ip properties file.

I

try{
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/[Call the method in the business bean here
}catch (ProductBusinessException productBusinessException ) {
productBusinessException.printStackTrace();

String error_code = productBusinessException.getErrorCode();
if (null '=error_code) {
this.getRequestScope().put(“error_code", error_code);

}

5.2.4 Get the error code from session and print the error in the jsp

Get the error message from Ip file according to the error code.
Print the error message in the top of the page.

<table width="100%" border="0" cellspacing="0" cellpadding="0">

<%

String error_code = (String)renderRequest.getAttribute(*error_code™);

if (error_code !'=null) {
%>

<tr>
<td>
<p><font color="#FF6600"><Ip:value key="<%= error_code %>"/></font></p>

</td>
</tr>

<%

%>
</table>

5.3 Log handling in portal project

We can do as the following steps.
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5.3.1 Add the log4j-1.2.9.jar into the class path of the portal project.

Please add the log4j-1.2.9.jar into your portal project first. For example:
PortalProject\WebContent\WEB-INF\lib

5.3.2 Add the log4j.properties in the directory <PortalProject>\JavaSource\

Here is the sample code of the log4j.properties

# An example log4j configuration file that outputs to System.out. The
# output information consists of relative time, log level, thread

# name, logger name, nested diagnostic context and the message in that
# order.

# For the general syntax of property based configuration files see the
# documenation of org.apache.log4j.PropertyConfigurator.

log4j.rootLogger=DEBUG, FILE
#log4j.rootLogger=DEBUG, Al, FILE

# Al is set to be a ConsoleAppender which outputs to System.out.
#log4j.appender.Al=org.apache.log4j.ConsoleAppender

# Al uses PatternLayout.
#log4j.appender.Al.layout=org.apache.log4j.PatternLayout

# The conversion pattern uses format specifiers. You might want to
# change the pattern an watch the output format change.
#log4j.appender.Al.layout.ConversionPattern=%-4r %-5p [%t] %37¢ %3x - %m%n

# In this example, we are not really interested in INNER loop or SWAP
# messages. See the effects of uncommenting and changing the levels of
# the following loggers.

# log4j.logger.org.apache.log4j.examples.SortAlgo.INNER=WARN

# log4j.logger.org.apache.log4j.examples.SortAlgo.SWAP=WARN

log4j.appender.FILE=org.apache.log4j.FileAppender
log4j.appender.FILE.File=/opt/WebSphere/PortalServer/log/oged.log
log4j.appender.FILE.Append=true

log4j.appender.FILE.layout=org.apache.log4j.PatternLayout
#log4j.appender.FILE.layout.ConversionPattern=%-4r %-5p [%t] %37¢ %3x - %m%n
log4j.appender.FILE.layout.ConversionPattern=[%-d{yyyy-MM-dd HH:mm:ss}] [%37c] %3x -
%m%n

9
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5.3.3 Import the class in your java class.

import org.apache.log4j.Logger;

5.3.4 Define a class varible like the following.

static Logger logger = Logger.getLogger(RegisterUserActionBean.class);

5.3.5 Write the log in the method like the following.

logger.info("It’s just a information.");
logger.debug("It’s a debug information.");
logger.error(“There is an error here!™);

Here is the sample code.
public boolean doSubmit(ActionRequest request) {
logger.info("*****Enter the doSubmit method!*****");
logger.debug("The email address is :" + request.getParameter(“email™));
boolean retval = false;
if (validate(request)) {
logger.debug("Luke--Validate user input successfully.");

/[The default role is customer
userBean.setRole(CodeSystem.ROLE_CUSTOMER);
userBean.setPassword(**123456");

UserBean userBean = (UserBean) request.getPortletSession()
.getAttribute(UserConstansts. USER_BEAN);
try {
retval = registerUserBusinessBean.addUser(userBean);
} catch (UserManageException e) {
logger.error(*The error code is " + e.getErrorCode());
request.getPortletSession().setAttribute(UserConstansts. ERRMSG_RESULT,

e.getErrorCode());

}
logger.debug("Luke--insert result is:" + retval);
retval = true;

}else {
logger.debug("Luke--Validate Failed™);
retval = false;

}
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logger.info("*****Exit the doSubmit method!*****retval is " + retval);
return retval;

5.3.6 Find the log which you set in the file log4j.properties
For example,view the log in /opt/WebSphere/PortalServer/log/oged.log

[2005-10-19 07:33:23] [com.ibm.sgl.oged.wemp.portlet.RegisterUserPortlet] - The jsp name
is RegisterUser

[2005-10-19 07:33:31] [com.ibm.sgl.oged.wemp.portlet.RegisterUserPortlet] - FEEEREXIL
doView method!*****

[2005-10-19 07:33:56] [com.ibm.sgl.oged.wemp.portlet.RegisterUserPortlet] - **F**EThere

is an error here!****

5.3.7 You can also set the log level in the properties file log4j.properties, and then restart the
application or the server.

log4j.rootLogger=INFO, FILE
or log4j.rootLogger=DEBUG, FILE
or log4j.rootLogger=ERROR, FILE

5.4 Code System

We often want to exchange the data between jsp, portlet, database or other system.
Commonly we need to map each other to know the exactly meaning of the value. So we can use
the code system across the functions and systems. Then it will be easy to understand each other.

5.4.1 Define the code system in the CodeSystem.java.
/[City list
public static final String CITY_ALL ="CITY1000"; //All
public static final String CITY_NEW_YORK ="CITY1001"; //New York
public static final String CITY_SHANGHAI ="CITY1002"; //Shanghai
public static final String CITY_PARIS = "CITY1003"; //Paris
public static final String CITY_CAIRO ="CITY1004"; //Cairo

5.4.2 We can also define a method to get the code list defined in CodeSystem.java.

This method will return an ArrayList,we can use it in our portlet or jsps.

public static final ArrayList getCityVector() {

>
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ArrayList result = new ArrayList();
result.add(0,CodeSystem.CITY_ALL);
result.add(1,CodeSystem.CITY_NEW_YORK);
result.add(2,CodeSystem.CITY_SHANGHALI);
result.add(3,CodeSystem.CITY_PARIS);
result.add(4,CodeSystem.CITY_CAIRO);

return result;

5.4.3 Using the code system in portlet or jsps.
LP handling:
<Ip:value key=<%=CodeSystem.CITY_SHANGHAI%> />

Comparison:
If(theCity.equals(CodeSystem.CITY_SHANGHAI)){
/ITODO here

¥

5.4.4 Or you can get the list
ArrayList cityList= CodeSystem.getCityVector();

5.5 Customize skin of portal

We will introduce how to customize the skin of portal.

The term skin refers to the visual appearance of the area surrounding an individual portlet. Each
portlet can have its own skin. The skins that are available for use with a portlet are defined by the
portal theme that is associated with the page. The portal administrator or the designer determines
the theme for pages and the available skins for the theme. The administrator can permit specified
users to change the skins to reflect individual preferences. If you have authority to make changes
to a portal page, use the Themes and Skins under Portal User Interface to manage themes.

5.5.1 Skin in portal

The term skin refers to the visual appearance of the area surrounding an individual portlet.
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*E My Portal administration [ Ed
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Parsonalization | My Finances | My Work | My Tasks EEMER=GEN LukeTest
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b i Mew Page Edit Page Assign Permi & 3 Searchi |

l Mobile Applications LukeTesk Page

HiZEWurld portlet  Partlet Skins
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}‘I:jimﬂ ~ sample hello portlet. ¥ou should take a look at this with 2 mobile device to see th

For t!e L
Etnc:x\ﬁample Application

Hello!

This the "SDIME Stock Sample® portlet for WebSphere Everyplace Mobile Portal, To use this
have the WebSphere Everyplace Mobile Portal server extensions installed, or be using the u
for WebSphere Everyplace Mobie Portal.

5.5.2 Set the default skin in admin console
We can create a new skin or just modify the existing skins. Here we will use an existing skin. To

set the default skin, please login portal and select Administration, then select Portal User
Interface -> Themes and Skins. Here we select Fade in the skin list, and set it as default portal

| Websphere LRI ST )Ty Portal |Administration Edit my profile 7 Log eut
Themes and Skins T -0
?.? Portal User Interface Thermes:
et add new therne
fManage Pages Adimin with left navigation Edit th
Themes and Skins Corporate 4 ' ==
Engineering Delete therne
@q.., Bortet b + Finance
n..é/ orte RS Science Set as default portal therme
o~ WMekhZSphere — portal defsult |
i/ mccass Home
Lightweight el
\%J Portal Settings Skins:
- outline w || [F] Aadd new skin
.--.. . Hint
Portal Analysis i
" 7 ¥ HoSkin Delete skin
ST, HoBorder Set as default portal skin
- :/ Portal Content Clear
b Fade - portal default
/’ Dramonds
wirtual Portals R .
Pinstripe
= Wawve et
—~ s

5.5.3 Modify the Control.jsp

The skin contains some jsps, images and stylesheet. In most conditions, we just need to modify the
Control.jsp.

/opt/WebSphere/AppServer/installed Apps/ogedwemp/wps.ear/wps.war/skins/html/Fade/Control.js

p
We can change the skin to meet our requirements. For example, we can remove the maximum link,

minimum link, and configuration link from skin.
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=] wps. ear | | Hame |
(] META-THF =T

= mﬂontrol.jsp
[ e2a @fade.jpg
[ dee preview. gif
[ DocEditor @preview_rtl. zif
D dtd show_tools_delete. gif
D ]..'Ltml @ show_tools_down. zif
(] images ﬁzhow_tonls_left. zif
[ menu (5 show_tools_right. gif
[ META-TIHF .
|:| oged chow_twools_nup. gif

[ peopleawarene=s
|:| plnButtonTemplate

B title back gif
EEgtitle back rtl gif

D preload L title_cnnfigure. gif
3 screens B title_edit gif
—[ 3 =kins | B title_help gif
|:| chiml title_maximize. zif
title_minimize. zif
£ $1bum @title_restore. gif
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D CarnerHighFerformance
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[

5.5.4 Verify the result

You can see that there is no tool link in skin now.

About SGL

T

details about

For

how to customize skKin,

Fo tool link now.

Founded in September 2000, SGL, Shanghai Globhalization Labaratory,
aims at pramoting warld-ready applications that meet the international
language and locale needs of users all over the world. The main tasks
of SGL members is to werify whether IBM flagship products conform to

the Globalization Architecture, and to ensure that these products

behave praperly together fram a globalization perspective, as
custarmers will experience them.
Ifyou can make it here, you can make it evenawhere.

please refer to WP510 Info Center:

http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/

5.6 Customize theme of portal

We will introduce how to customize the theme of portal.

Themes represent the overall look and feel of the portal, including colors, images and fonts. There
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are several default themes provided with the standard installation of WebSphere Portal. Each page
in the portal may have a different theme associated with it, thereby creating the appearance of
virtual portals. Use the Themes and Skins under Portal User Interface to manage themes.

5.6.1 Theme in portal

Themes represent the overall look and feel of the portal.
e o R ST My Portal | Administration o Ed

"3 e 3 = Bolex
Themes Mew Page Edit Page Assign Permi ¢ Search |

Parsonalization | My Finances | My Work | My Tasks [RElddiEE=las LikeTest
| Mobile Applications LukeTest Page

Hiigw::-rltl portiet parilet Skins

ielcome!

Joir ie ~ cample hello portlat. You should take 2 look at thic with a mobile device to see th
Aagant

For l!el i
Stnc:\\Sample Application

Hello!

This the "<DIME Stock Sample* portlet for WebSphere Everyplace Mobile Portal. To use this
have the webSphere Everyplace Mobile Portal server extensions installed, or be using the 1
for WabSphere Everyplace Mobile Portal.

5.6.2 Set the default skin in admin console

We can create a new theme or just modify the existing themes. Here we will use an existing theme.
To set the default theme, please login portal and select Administration, then select Portal User
Interface -> Themes and Skins. Here we select WebSphere in the theme list, and set it as default
portal theme.

WebSphera [N T Tty portal Administration | Edit my profile 7 Log aut
Themes and Skins ?T -0
2@ Portal User Interface Theres:
Admin ~ Add new therme
Manage Pages Admin with left nawvigation Edit th
Themes and Skins Corporate 4 ! arme
Engineering Celete theme
@1.., Finance
= (e M e cience Set as default portal therne
— WMebSphere — portal default —
- A
{g Access Home
Lightweight b
EJ Portal Settings Skins:
' cutline || [*] add new skin
. ~ . Hint
Portal Analysis i
" y NoSkin Delete skin
=T WoBorder Set as default portal skin
w\/’- Portal Content Clear
h Fade - portal default a—
- - Dri
}[? Virtual Portals . .
. Pinstripe
Al Wave =

5.6.3 Introduction of the theme

The theme contains some jsps, images and stylesheets. If we want to get a totally different view than
the default, we need to create images, and customize jsps and stylesheet. In most conditions, the portal
developer just needs to modify the following jsps: Default.jsp, PlaceBarInclude.jsp and
PageBarlnclude.jsp. And the artwork team can help about images and stylesheet.

S
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ST wp=. ear] #| | Hame |
= MET 5~ IHF  |[E] styles. c==

= LNP_Stxles. c==
Largelcons. css
HelpStxles. css

ﬂ TaolBarInclude. j=p

E SearchBarIncluds. j=p

ﬁ Flain. j=p

ﬂ FlaceBarTnelude. jsp

ﬂ FPageBarInclude. j=sp

ﬂ HawvigationTreeInclude. j=sp
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..... D preload ﬂclose'ﬁ'indow.jsp
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=[-Z3 themes EZ|Shadow_Border TopRight. ..
----- backup —-10. 21 @Shadow_Border_T apleft. jps
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5.6.4 File dependency in theme

Here is the file dependency in portal.

ext. fheadinclude jsp | DWP_Styles css HelpStyles css

|:| SearchBarinclude jsp

Layeredontainer jsp - cojumnContainer jsp UnlayeredContainer- jsp

FowContainer jsp UnlayeredContainer-H jsp

Controljsp  Bidilnclude jsp ShowTools jsp

Here you see the basic file structure of a normal theme. At the top level you have the default.jsp.
Included in it are the tablibinclude, the Head, the pagebegininclude, and so JSP-files. The
Home.jsp is located in the screens subdirectory. The LayeredContainer and Control.jsp can be
found in the skins subdirectory.

New with version 5.1 is that there is now a SearchBarInclude, which contains all of the necessary
components for the integration of the portal search engine. Also the navigation except if you use

9
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PlaceBar and PageBar is now included in the NavigationTreelnclude.jsp. With version 5.0 it was
misplaced in the Skin.

Because of the usage of included jsp when you change a file for example the ToolBarlnclude.jsp
you need to touch the surrounding Default.jsp for the application server to recompile the whole
theme. When you use the Portal Tooling normally when you change an included file and save it
then also the surrounding file is automatically saved for you.

Here is the overview in portal website.

e I

g Wartical Heux

\

PlaceBarinclude.jsp

PageBarinclude.jsp

ToolBarIﬁclude.isp

AdminLinkBarInclude.jsp

N

~

Default.jsp

Default.jsp is the parent jsp for
the theme. Each of the other JSPs
are called from it.

5.6.5 Default.jsp

Default.jsp is an important part of your collections of jsps. Think of it as a central location that
binds all the other files together. Notice what a simplified Default.jsp file contains.

Here is the short version of Default.jsp

<%@ page session="false" buffer="none" %>

<%@ page language="java" contentType="text/html; charset=UTF-8" pageEncoding="UTF-8"
%>

<%@ taglib uri="/WEB-INF/tld/portal.tld" prefix="wps" %>

<%@ taglib uri="/WEB-INF/tld/portal-internal.tld" prefix="wps-internal™ %>

<%@ include file="./extension/TagLibInclude.jsp" %>

<wps-internal:adminNavHelper/>

<wps:constants/>

<html|>

<%@ include file="./Head.jsp" %>

<%@ include file="./extension/PageBegininclude.jsp" %>
<table border="0" cellspacing="0" cellpadding="0">

9
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<tr>
<td>
<wps:if portletSolo="no">
<%@ include file="ToolBarInclude.jsp" %>
<%@ include file="PlaceBarInclude.jsp" %>
<%@ include file="PageBarlInclude.jsp" %>
</wps:if>
ftd>
</tr>
<tr>
<td>
<a name="wpsMainContent"></a>
<%-- Call the WPS engine command to render the portlets for this page --%>
<wps:screenRender/>
</td>
</tr>
</table>
<%@ include file="./extension/PageEndInclude.jsp" %>
</html>

5.6.6 Taglibs in theme

The portalserver supplies several Custom Taglibs, which make a creation of a theme much easier.
4 are used in themes and skins. portal.tld, portal-internal.tld, menu.tld and people.tld. You can of
course add others in case you need them. The point to add them would be the taglibinclude.jsp.

Here are the taglibs used in Themes and Skins

portal.tld

Includes basic tags for use in theme. For example urlFindInTheme to generate an url to point
towards an resource/image inside the theme. Another important tag is the if tag. With it you can
add conditional parts of html code to a page when for example you are in the login screen. The
details, which conditions are supported, can be found in the description of the available tags ( see
References )

portal-internal.tld

Is used for internal tags. For example adminlinkinfo initializes 2 variables, which contain the
current values of the current ContentNode and the ComponentNode. The ContentNode represents
the object id of the currently displayed page. The component node contains the object id of the
portlet currently selected.

portlet.tid
Contains the different styles used in portlets / skins.

>
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menu.tld / people.tld ( same as personTag.tld )
Integrated through ext../TagLibInclude.jsp

JSTL definition files
Added to enable disconnected support of Java Server Pages Standard Tag Library

c.tld ( core ) / x.tld (xml ) / fmt.tld ( output formatting )

Others available in <wp_root>/shared/app/WEB-INF/tld

5.6.7 Navigation in portal

There are 3 components are used to display navigation.

PlaceBarlnclude.jsp

Can be used to display first level of navigation

PageBarInclude.jsp

Can be used to display second level of navigation

NavigationTreelnclude.jsp

Can be used to display all remaining levels.Navigation is moved to this file. Not in skin anymore

5.6.8 Stylesheet in theme

In each of the themes 3 Style sheets are used. The most important is the Styles.css. In it you will
find most of the styles needed for theme and skin development. The other 2 Styles sheets are only
used in 2 or 3 portlets.

Here are 3 styles used in Portal.

Styles.css

See appendix for further information what styles are available.

With RAD a new preview modus is available to use a packaged html-file to preview changes.
HelpStyles.css

Used in Common Pim Portlet / Search Center

LWP_Styles.css

Used in Common PIM Portlet / People Picker / Portal Doc Mgr

5.6.9 Before you can customize theme

Since Default.jsp is the central file for all other JSPs, You must touch the Default.jsp in order for
changes to be picked by the Server. You can touch the file by changing the saved date. Easiest way
is to open Default.jsp and insert space, delete it and SAVE file. If it still does not take effect after
modifying the Default.jsp, please ensure you enable JSP reloading referring to the section Enable

9

©Shanghai Globalization Lab, User Page 69
Technology, CSDL, IBM China 2006




Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

Automatic JSP Reloadin.

5.6.10 Customize theme

I will not tell you how to do the coding in the jsps here. One of my experiences is that we should
pay more attention to the user locale, stylesheet and bidi.

Note: Please remain the administration link for the user wpsadmin.

Here are the code fragments in the Default.jsp.

<%
com.ibm.wps.engine.RunData rdata =com.ibm.wps.engine.RunData.from(request);
com.ibm.wps.puma.User user = rdata.getUser();
String userLocale = getFullLocale(rdata.getLocale().toString());
String userid = null;
if (null '=user) {
userid = user.getUserID();
user.setPreferredLanguage(userLocale);
}
%>
<table width="1000" border="0" cellspacing="0" cellpadding="0">
<tr>

<td width="209"><img src="/wps/oged/images/<%=userLocale%>/logo.gif" alt="Our Global
Express Demo' width="209" height="101"></td>
<td valign="top">

<table width="791" align="<%=bidiAlignRight%>" border="0" cellspacing="0"
cellpadding="0">
<tr>
<td height="22" align="<%=bidiAlignRight%>" class="BackgroundTitle">
<table height="22" border="0" cellpadding="0" cellspacing="0"

class="Backgroundicontitle">

<tr>
<wps:if loggedIn="yes" portletSolo="no">
<td width="30">
<%-- Administration button --%>
<wps:urlGeneration contentNode="wps.Administration™ portletwWindowState="Normal">
<td class="wpsToolBar" valign="middle" nowrap>

<a href="<% wpsURL.write(out); %>" class="wpsToolBarLink"><wps:text
key="link.administration™ bundle="nls.engine"/></a>&nbsp;&nbsp;
</td>
/wps:urlGeneration>
</td>
</wps:if>

<wps:if loggedIn="yes">

>
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<td >
<wps:urlGeneration contentNode="6_0_222">

<a class="wpsToolBarLink" href="<% wpsURL.write(out); %>"
onMouseOver="MM _swaplmage(‘'Image5',", /wps/oged/images/icon_EditProfile_1.gif',1)"
onMouseOut="MM_swaplmgRestore()"><img
src="/wps/oged/images/<%=userLocale%>/icon_EditProfile.gif" alt="<wps:text
key="PORTLET_EDITPROFILE" bundle="nls.engine"/>' title='<wps:text
key="PORTLET_EDITPROFILE"  bundle="nls.engine"/>'  name="Image5"  width="15"
height="15"  border="0" id="Image5"> <font color="#FFFFFF" >&nbsp;<wps:text
key="PORTLET_EDITPROFILE" bundle="nls.engine"/>&nbsp;&nbsp;</font></a>

</td>
</wps:if>

</tr></table>
<ftd></tr>
</table>

5.6.11 Verify the result

You can see the portal website is totally different from the default portal.

Welcome E-Shipping Track Shipment Status  User Management  Onl

Genenal Information About OGED About SGL

| General Information

welcome to Global Express Derno [OGED), the globalization solution for the express industryl OGED leverages IBM -
Wnrkmace webhSphere Everyplace Mobile Portal, RFID and other products to address the needs of express companies and
ssssssssss partners. The core products and technologies that OGED uses are described as follows I Please select a language

- 1B Workplace: IBM Workplace Collaboration Serices is a single product that provides = full range of integrated ready-to-

use carmmunication and callaboration taals that shable peapls to do thair joks mare efestively - anvtime, anvwhers Witk
the flexibility to deploy any mix of capabilities, it provides a ready-rmade foundation to build customized role-based

warkplace enviranments that provide the toals and infarmation Beople need to do their work more efficiently.

- WEMP Wik Snhere Frarmlace Mokile Prral S0FMPY s 8 kev cnrmbnnent afwiehanhere Fyanmlace Senice Delivens 1t

5.6.12 Insert a new theme

To add a theme to the configuration of the Portal you have to copy the theme directory to the
<was_root>/installedApps/<node>/wps.ear/wps.war/themes/html directory. Then add the theme in
the administrative portlets as following.
1. Click on Administration -> Portal User Interface -> Themes and Skins
2. Click on Add new theme
3. Insert a name and the name of the theme-directory for example ‘MyTheme’ if it is located in
<was_root>/installedApps/<node>/wps.ear/wps.war/themes/html/MyTheme
Once you do that, follow the same direction as you would with existing Themes.
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[FWobsphore LT e N i . e | My Portal [ Administration |Edit my profile ¥ Log out
. Themes an. d Skins T - O

=3 Portal User Interface Thermes:

Corporate -~ Add new therne

Engineering

| Edit th

Finance ! =me

Science Celete theme

TehSphere — portal defsult

Hore Set as default portal theme

Lightweight
;q# Access Mokile Fortal

‘\?,.J Portal Settings

[#] 2dd new skin
O,\ Portal Analysis gi}zﬂne Delate skin
Hint
Portal Content NoSkin
MNoEBorder
Clear

)
SR

Set as default portal skin

=

f@;f &

wirtual Portals Fade — portal default

= Dismonds s

For details about how to customize theme, please refer to WP510 Info Center:
http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/

5.7 Portlet Caching

5.7.1 Portlet Caching

Caching improves performance by reducing the load on the server. Caching is per user per portlet,
a portlet cached for one user will not be used for another user. A JSR 168 portlet must use the
portlet.xml to enable caching.The expiration cache is defined in seconds. In the following smaple,
the contents of the portlet should be cached for 10 minutes. A value of zero indicates that the
portlet caching is disabled. A -1 value will cause the portlet cache to never expire. Any value
above 0 will be interpreted as the number of seconds the content should be cached for.
Here is the piece in portlet.xml.
<portlet>
<portlet-name>AboutSGL </portlet-name>
<display-name>AboutSGL portlet</display-name>
<display-name xml:lang="zh">AboutSGL portlet</display-name>
<portlet-class>
com.ibm.sgl.oged.wemp.portlet. AboutSGLPortlet
</portlet-class>
<init-param>
<name>wps.markup</name>
<value>html,xdime</value>
</init-param>
<expiration-cache>600</expiration-cache>
<supports>
<mime-type>text/html</mime-type>
<portlet-mode>view</portlet-mode>
</supports>
<supports>

©Shanghai Globalization Lab, User Page 72
Technology, CSDL, IBM China 2006

©
i


http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/

Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

<mime-type>x-application/vnd.xdime+xml</mime-type>
<portlet-mode>view</portlet-mode>
</supports>
<supported-locale>zh</supported-locale>
<resource-bundle>wempproject.nl.AboutSGL</resource-bundle>
<portlet-info>
<title>AboutSGL portlet</title>
</portlet-info>
</portlet>

5.7.2 Change the expiration time-out value in portlet

If the expiration-cache is defined in the portlet.xml, the portlet may programmatically change the
expiration time. The request property expiration-cache should be used to modify the caching
values.

RenderResponse.setProperty(PortletResponse. EXPIRATION_CACHE,(new
Integer(600)).toString() );

While the portlet content is cached and the portlet is not a target of a request, the cached content
will be used during the render phase. If there is a request for the portlet, the cached content will be
disregarded and the render method of the portlet will be invoked.

5.8 Enable session for anonymous user

We want to maintain the session for anonymous user.

5.8.1 Find the configuration file

\opt\WebSphere\PortalServer\shared\app\config\services\NavigatorService.properties

5.8.2 Change public.session to true like the following.

public.session = true

5.9 Enable Automatic JSP Reloading

To view changes to your theme and skins JSPs without restarting the portal server, you can force
the application server to automatically check for new versions of JSPs. While this is ideal for
development and testing purposes, automatic JSP reloading should be disabled in a production
environment because of performance issues.

If we can enable JSP automatic reloading, then we don’t need to restart the application every time
after modifying the jsps.

>
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Follow these steps to enable automatic JSP reloading:

5.9.1 Open the file

/opt/WebSphere/AppServer/config/cells/ogedwemp/applications/wps.ear/deployments/wps/wps.w
ar/WEB-INF/ibm-web-ext.xmi

5.9.2 Find the following entry in this file:

<webappext:WebAppExtension xmi:version="2.0" xmlns:xmi="http://www.omg.org/XMI"
xmlns:webappext="webappext.xmi" xmlns:webapplication="webapplication.xmi"
xmlns:commonext="commonext.xmi" xmlIns:common="common.xmi"
xmi:id="IBM_WPS_Ext" reloadInterval="3" reloadingEnabled="false"
fileServingEnabled="true" directoryBrowsingEnabled="false"

5.9.3 Change the value for reloadingEnabled to true.

5.9.4 Save the file and restart the portal server.

After completing these steps, JSPs are automatically reloaded when they are changed. However, to
view changes to a JSP that is included by another (parent) JSP, you must also change the parent
JSP to indicate that the server must reload it.

5.10 How to write a WPS taglib

Our portal pages need to support several languages, such as English, Simplified Chinese, French and Egypt. We
want to use taglib to access the localization pack. Here I’d like to tell you how to write a taglib for portal project.

5.10.1 Write the class for taglib first

We need to write one class for LoadTag, another for ValueTag.

Here is our sample code .

LPLoadTag.java
[*
* Class: <LPLoadTag>
* Description:<LPLoadTag>
* \ersion: <1.0>
* Author: <Luke>
* Creation date: <2005-8-9>
* Department: Shanghai Globalization Laboratory
* Copyright (c) 2005, International Business Machines Corporation,
* All rights reserved.
*/
package com.ibm.sgl.oged.util;

>

©Shanghai Globalization Lab, User Page 74
Technology, CSDL, IBM China 2006



©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006




LPValueTag.java

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006




Best Practice of Portal Develo

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006




Best Practice of Portal Develo

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006




Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

5.10.2 Write the taglib configuration file Ip.tld

We will reference to class for Ip handling in the Ip.tld.
Then place the Ip.tld in the portal directory <PortalProject>\WebContent\WEB-INF\tld
Note that we can define the tag name in this file, such as load and value.
Ip.tid
<taglib>
<tlibversion>5.1</tlibversion>
<jspversion>1.2</jspversion>
<shortname>LP Taglib</shortname>

<tag>
<name>load</name>
<tagclass>com.ibm.sgl.oged.util.LPLoadTag</tagclass>
<attribute>
<name>file</name>
<required>true</required>
<rtexprvalue>true</rtexprvalue>
</attribute>
</tag>
<tag>
<name>value</name>
<tagclass>com.ibm.sgl.oged.util.LPValueTag</tagclass>
<attribute>
<name>key</name>
<required>true</required>
<rtexprvalue>true</rtexprvalue>
</attribute>
</tag>
</taglib>

5.10.3 Use the taglib in portal jsp file

Write the following code in portal jsp page. We should use the tag name defined in the Ip.tld file, such as Ip:load

and Ip:value.

<!I--Import the taglib -->
<% @taglib uri="/WEB-INF/tld/Ip.tld" prefix="1p"%>

<!--Load the propertiy file -->
<Ip:load file="user.properties” />

9
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<!I--Get the translated string from Ip -->
<Ip:value key="ERROR_PASSWORD " />

Here is the piece in the localization file.
ERROR_PASSWORD =The password is invalid!

5.11 Session in portlet

We need to use session to exchange the data between the jsp pages and portlet.

We can use get the session object from request. Please note that JSSR168 portlet is different from
IBM API portlet. You can see the difference in the code fragments.

5.11.1 For IBM API portlet

JSP sample

<% @ taglib uri=""/WEB-INF/tld/portlet.tld" prefix=""portletAPI** %>

<%@ page import="java.util.*, com.ibm.gcl.gcm.databeans.*, com.ibm.gcl.gcm.portlets.*,
com.ibm.gcl.gcm.util.*, java.net.*, com.ibm.gcl.gcm.constants.FederalSearchParameters'%>

<portletAPI:init />

<%

CaseDetails casedetails =
(CaseDetails)portletRequest.getPortletSession().getAttribute(FederalSearchParameters. CASEDET
AILS);

%>

Portlet sample
public class CriminalSearchPortlet
extends PortletAdapter
implements ActionListener {

public void doView (PortletRequest request, PortletResponse response)
throws PortletException, IOException {
PortletSession session = request.getPortletSession();
String JSPFile = (String)
session.getAttribute(DocumentParameters.JSPPAGENAME);
String pagelD = (String) session.getAttribute(DocumentParameters.PAGEID);

if (null == JSPFile) {
/I First time enters into the portlet
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JSPFile = DocumentParameters.PAGE_CRIMINAL_SEARCH,;

pagelD = DocumentParameters.FIRSTPAGE;

session.setAttribute(DocumentParameters.PAGEID, pagelD);

session.setAttribute(DocumentParameters. ERRMESSAGE, null);

session.setAttribute(DocumentParameters. OLDCRITERIA, new
SearchCriteriaHistory());

}

request.setAttribute(DocumentParameters.PAGEID, pagelD);
request.setAttribute(DocumentParameters.JSSPPAGENAME, JSPFile);

setActionURIs(request, response);

getPortletConfig().getContext().include(JSPFile, request, response);

public void actionPerformed (ActionEvent event) throws PortletException {

String actionString = event.getActionString();
PortletRequest request = event.getRequest();

PortletSession session = request.getPortletSession();
CriminalSearchActionBean actionBean = new CriminalSearchActionBean();
actionBean.setSession(session);

actionBean.setRequest(request);
actionBean.setContext(getPortletConfig().getContext());

try {
Class actionClass = actionBean.getClass();

Method method =
actionClass.getMethod(
DocumentParameters. ACIONT_PREFIX + actionString,
null);
method.invoke(actionBean, null);
} catch (Exception e) {
e.printStackTrace();
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5.11.2 For JSR168 portlet

JSP sample
<%@ taglib uri=""http://java.sun.com/portlet™ prefix=""portlet™ %>
<portlet:defineObjects />
<%
String locale = com.ibm.sgl.oged.util.LPUtil.getFullLocale(request.getLocale().toString());
renderRequest.getPortletSession().setAttribute(“userLocale”,locale);
String name = “7;
if(renderRequest.getPortletSession().getAttribute(*name™)!=null)
name = (String)renderRequest.getPortletSession().getAttribute(*name");
%>

Portlet sample
public void processAction(ActionRequest request, ActionResponse response)
throws PortletException, java.io.IOException {

if (null '=request.getParameter(’BUTTON_BACK?”)) {
request.getPortletSession().setAttribute(*JSPNAME”,”InitialShipment.jsp”);

public void doView(RenderRequest request, RenderResponse response)
throws PortletException, IOException {

String JSP_NAME = (String) request.getPortletSession().getAttribute(

InitiateShipmentConstansts.JSPNAME_SESSION);
request.getPortletSession().removeAttribute(
InitiateShipmentConstansts.JSPNAME_SESSION);
if (null == JSP_NAME) {
InitiateShipmentActionBean.clearSession(request.getPortletSession());
JSP_NAME = InitiateShipmentConstansts.INIATE_SHIPMENT;

}

/I Invoke the JSP to render

PortletRequestDispatcher rd = getPortletContext().getRequestDispatcher(
getJspFilePath(request, JSP_NAME));

rd.include(request, response);

5.12 JavaScript in portlet

In the portlet jsps, we need to use JavaScript to implement the following functions.
1. The event onchange and onclick, for example, refresh the page upon the user selection

9
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without submitting.

2. Change the hidden field value and submit the form upon the user interactions. For example,
select an itemin a list.

3. Popup calendar

4. Pull down calendar

Here are some samples for your references.

5.12.1 The event onchange and onclick

JavaScript fragments
<script language="JavaScript">
function changeLangUrl(){
var language = document.selLangForm.Language.value;
var submitURL;

if(language=="en_US")
{
submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale"
value="en_US"/></wps:url>";  }
else if(language=="zh_CN")
{
submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale"
value="zh_CN"/></wps:url>";
}
else if(language=="ar_EG")
{
submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale"
value="ar_EG"/></wps:url>";
}
else if(language=="fr_FR")
{

submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale
value="fr_FR"/></wps:url>";

}

<wps:if loggedIn="yes">
submitURL=submitURL.replace("portal”,"myportal™);
</wps:if>

window.location.href = submitURL;

¥

</script>

>
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Code fragments

<%@ page import="java.util.* javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.*,
com.ibm.sgl.oged.db.databean.G11NPreferenceBean, com.ibm.sgl.oged.constant.UserConstansts,
com.ibm.sgl.oged.util.CodeSystem, com.ibm.sgl.gbo.core.operation.FeatureManager,
com.ibm.sgl.gbo.localelist.IGLocaleList,

com.ibm.sgl.gbo.core.preference.base.* ' %>

<form name="selLangForm">

<select onchange="changeLangUrl();" name="Language" >

<%
String localeList[] ={"en_US", "zh_CN", "fr_FR", "ar EG"};
String languageList[] = {"en", "zh", "fr", "ar"};
String countryList[] = {"US", "CN", "FR", "EG"};

BasePreferenceFactory bpf = BasePreferenceFactory.getFactory();
BasePreference bp = bpf.getBasePreference("languageL.ist");

FeatureManager fm = FeatureManager.getInstance();
for(int i = 0; i<4; i++) {
Locale locale = new Locale(languageList[i], countryList[i]);
/[System.out.printin(locale);
bp.setLanguage(locale);
/ISystem.out.printIn(localeList[i] + locale);

IGLocaleList gll = (IGLocaleL.ist) fm.getFeature(IGLocaleL.ist.class, "languageL.ist");

String langL.ist3 = gll.getLocaleName(locale);

/[System.out.printIn(langList3);

String optionValue = "";

if(CodeSystem.LOCALE_EN.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_EN;

}

if(CodeSystem.LOCALE_CN.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_CN;

}

if(CodeSystem.LOCALE_FR.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_FR;

}

if(CodeSystem.LOCALE_AR.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_AR;
dir ="rtl";
langList3 =
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replaceString(replaceString(langList3,")","&#8207;)" ),"("," &#8207;(");
}
%>

<option dir="<%=dir%>" value=<%=optionValue %>
<%if(optionValue.equals(userLocale)) {out.print("selected");} %>>

<div align="center" dir=<%=dir%> >
<%-=replaceString(replaceString(langList3,")" bidiForceString+")" ),"(",bidiForceString+ "("")%>
</div ></option>
<%
} %>
[select>

5.12.2 Change the hidden field value and submit the form upon the user interactions.

JavaScript fragments

<script language="JavaScript">

function PrevPage(){
this.document.prevpage.submit();

}
function NextPage(){

this.document.nextpage.submit();

¥

</script>

Code fragments
<tr>
<td colspan="4" class="td6<%=dir%>">
<%
if (pagelD.equals(TrackConstansts.FIRST_PAGE)) {
%>

<lIp:value key="TABLE_PREVIOUS"/>
<%}else{%>

<a href="#" onclick="PrevPage()"> <Ip:value

key="TABLE_PREVIOUS"/></a>
<%}%>

[<%=pagelD%>/<%=TrackByAdvancedPortlet. maxPageNum%>]
<%

if (pagelD.equals((new Integer(TrackByAdvancedPortlet. maxPageNum)).toString())){

>
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%>
<Ip:value key="TABLE_NEXT"/>
<%}else{%>
<a href="#" onclick="NextPage()"> <Ip:value key="TABLE_NEXT"/></a>
<%} %>
</td>
</tr>

<form name="nextpage" action=<portlet:actionURL/> method="POST">

<input name="<%=TrackConstansts.NEXT%>" type="hidden" value="<Ip:value
key="BUTTON_RETURN" />"> </form>

<form name="prevpage" action=<portlet:actionURL/> method="POST">

<input  name="<%=TrackConstansts.PRE  %>"  type="hidden" value="<Ip:value
key="BUTTON_RETURN" />">

</form>

5.12.3 Popup Calendar

JavaScript fragments
For details, please refer to GBO team: PopupCalendar.jsp and PopupCalendar.js

Code fragments
<tr>
<td class="td3<%=dir%>"><Ip:value key="TABLE_BEGINDATE" /> </td>
<td class="td6">

<input type="text" id="datel_Show" name="begindateshow"
readonly="readonly" value=<%-=begindate%>>
<input type="hidden" id="date1" name="begindate"

<%if(0!=begindatehidden.length())%> value=<%=begindatehidden%>>

<input type="hidden" id="datel Unformat" >

<img src="/wps/oged/images/calendar.qgif" alt="<Ip_alt:value
key="CALENDAR"/>"
onclick="window.open('<%=renderRequest.getContextPath()%>/html/popupcalendar/PopupCalen
dar.jsp?locale=<%=poplocale%>",'datel’,'height=200,width=210,scrollbars=no,resizable=yes,statu
s=no,menu=no,toolbar=no")">

</td>
<tr>
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5.12.4 Pull down calendar

JavaScript fragments

<SCRIPT language="JavaScript">

/1f there are more than one PulldownGBO in one page.

/IYou should repacle the name of year, month, date with new one.
var monthdays = new Array(12);

monthdays[0] = 31;
monthdays[1] = 28;
monthdays[2] = 31;
monthdays[3] = 30;
monthdays[4] = 31;
monthdays[5] = 30;
monthdays[6] = 31;
monthdays[7] = 31;
monthdays[8] = 30;
monthdays[9] = 31;
monthdays[10] = 30;
monthdays[11] = 31;

var back = new Array(4);

function update_days(f)

/[ alert(f.months.parent());
compute_days(f);
var lengthDeleted = 31 - monthdays[f.month1.selectedIndex];

if(back[0] == null){
for(x=0;x<back.length ;x++) {
back[x] = f.date1[30 - x];

if(null !'= back[0]){
for(x=0;x<back.length ;x++) {
f.date1[30 - x] = back[x];

-

©
i

©Shanghai Globalization Lab, User
Technology, CSDL, IBM China 2006

Page 87



Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

for(x=0;x<lengthDeleted ;x++) {
f.date1[30 - x] = null;

function compute_days(f){
if('isNaN(f.yearl.value) && f.yearl.value.length > 0){
var year=parselnt(f.yearl.value);
var ret_val = 0;
if (year % 4 == 0 && year % 100 !=0)
ret_val=1;

if (year%4 == 0 && year % 400 == 0)
ret_val=1;

if(ret_val == 1){
monthdays[1] = 29;
Yelse{
monthdays[1] = 28;

¥
</SCRIPT>

Code fragments

<%@ page
import="java.util.* java.text.* java.sql. Timestamp,javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.
*,com.ibm.gcl.gbo.calendar.*,com.ibm.gcl.gbo.template.*" %>

<%
CalendarGBO calendar = CalendarGBO.getInstance(locale);
String dateorder = calendar.getDateOrder();
for(int j = 0; j < dateorder.length(); j ++){
if(dateorder.charAt(j)=="m"){
%><td class="td2<%=dir%>">
<select name="month1" size="1" onchange="update_days(this.form)">
<%
String[] monthvalue = {"1","2","3" 4" "5","6","7","8","9","10","11","12"};
String[] monthcaption = calendar.getFullMonthList();
for(inti = 0; i < monthvalue.length; i ++) {
if(monthvalue[i].equals(month)){
%>

>

©Shanghai Globalization Lab, User Page 88
Technology, CSDL, IBM China 2006



Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

<option value="<%=monthvalue[i]%>"
selected><%=monthcaption[i]%></option>
<% Yelse{ %>
<option value="<%=monthvalue[i]%>"><%=monthcaption[i]%></option>
<% }
}
%>
</select>
</td>
<%
}

else if(dateorder.charAt(j)=="d"){
%><td class="td2<%=dir%>">
<select name="datel1" size="1">
<%
String[] dayvalue =
£r1m,2 3 4 e e, e, e, Lo LA 12 M3 14 B e ML 7, 18, 19" 20" 121,
22", "23" "24" 25" "26" 27" "28","29","30" ,"31"};
String[] daycaption = calendar.getFullDayL.ist();
for(int i = 0; i < dayvalue.length; i ++)
{
if(dayvalue[i].equals(date)){
%>
<option value="<%=dayvalue[i]%>" selected><%=daycaption[i]%></option>
<% Yelse{ %>
<option value="<%=dayvalue[i]%>"><%=daycaption[i]%></option>
<% }

%>
</select>
</td>
<%

}

else if(dateorder.charAt(j)=="y'){
%><td class="td2<%=dir%>">
<select name="yearl" size="1" onchange="update_days(this.form)">
<%
String yearlist[] =
{"'2000","2001","2002","2003","2004","2005","2006","2007","2008","2009","2010"};
for(int i = 0; i < yearlist.length; i ++){
if(yearlist[i].equals(year)){

>
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%>

<option value="<%-=yearlist[i]%>" selected><%=yearlist[i]%></option>
<% Yelse{ %>

<option value="<%=yearlist[i]%>"><%=yearlist[i]%></option>
<% }

%>
</select>
</td>
<%

}

Yo>

<td class="td2<%=dir%>">

<select name="time" size="1">

<%

String[] times =
{"00:00","01:00","02:00","03:00","04:00","05:00","06:00","07:00","08:00","09:00","10:00","11:0
0","12:00","13:00","14:00","15:00","16:00","17:00","18:00","19:00","20:00","21:00","22:00","'23
:00"};

for(inti = 0; i < times.length; i ++){
if(timesJi].equals(time)) {
%>
<option value="<%-=times[i]%>" selected><%=times[i]%></option>
<% }
else{
%> <option value="<%=times[i]%>" ><%=times[i]%></option>

<% }
}
%>
</select>
</td>

5.13 Classpath issues in portal project

Classpath is very important to the success of a project. If it’s mixed up, it will be very difficult for
us to find the problem.

We need to make classpath very clear in the portal project. For example, what’s the use of this jar

>
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file? What’s the version of the GBO.jar?

To ensure the portal applications behavior correct, we must follow some rules.

5.13.1 Classpath in portal project

Assign a person to be responsible for updating the classpath file in portal project and portal
environment. Anyone else cannot check out and modify the classpath file.

5.13.2 Jar file in portal project

1. Please don NOT copy the unused jar files to portal project.
2. Make sure each jar file is required and on the right version.

5.13.3 Jar file in portal server

1. Please do NOT copy the unused jar files to portal project.

2. Make sure each jar file is required and on the right version.

3. Please don NOT copy the same jar file to several locations, such as portal project, portal
server, and application server. It will cause unexpected problems.
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6. Portal administration

Here I will give you step-by-step instructions about how to do the administration for portal.

6.1 Login portal

Login using the default user of portal.
User ID: wpsadmin
Password: wpsadmin

ILo in
g Login uszsing the default user

of portal:
s Ozer ID:wpsadmin
| password:wpzadmin
Please input your user ID and password
"l.l'r
Lizer|D: |wp5admin |
Passward: [sossesse |

Resume last session

| Log in | Cancel

After logging in, you can click the Administration link to the portal admin console.

WebSphere [R S T vy Portal
Manage Pages

-
72? Portal User Interface Q

Themas and Skins Saarch b\,r:| Title starts with ¥| search:
a:’ Portlet Management
& g webSphere Portal
(@ AcCcess Pages in WebSphere Portal add, Edit, Delete, and Reorder pages

|-*- VET page| |-*- Mew |abel

E;J Portal Settings Page 1 of 2 |

'.h'PurtaI Analysis

~ iy Portal wps.My Portal Active
&2 - o . :
Zg\'/j Portal Content S p dministration wps. Administration Active

) S S B

6.2 Deploy portal applications

In the admin console, click Portlet Management -> Web Modules in the left navigation tree.
Then you can click Install to install a portal application.
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Wobphors [0 S RS- vy Portal [Administration | Edit my profile ? Log out

‘2@ Portal User Interface

%’|Pnﬂlet Management|

Web Modules

Applications
Partlets

Webh Services
Web Clipping

{%? Access

EJ Portal Settings
(- T

Manage Web Modules + &2 =0

Search by:lFiIe name starts with Vl Search: Search

Web modules Click Install to install a Web module, Select a Web module to view its
portlet applications and portlets, Click Delete to remove the Web module from your

portal o k_fssign Access to allow others to work with the Web module,
| Install | | Consume

Page 1 of 10 [#] [»] Jump to page:[1 |

Name Status

lwppeoplefinder. war
xDIMEStockSample, war
Imparts ML war
LotusWebConferencing. war
appearance.war

Browser or input the full path of the war file to be installed. Click Next.

?-f' Portal User Interface

Q:f}’ Portlet Management

wWeb Modules

Applications
Portlets

Wweb Services
Web Clipping

{y? Access

WebSphere [T N s 1y Portal Edit my profile 7 Log ou:

Manage Web Modules /2 -0

Installing a Web module, Step 1: Select WAR file.

Qclick the Browse button to specify the location of the WaR file to install.
Click the Mext button to continue or the Cancel button to go back to the Web
module page.

Brectory:
| bs\wanghh'\,ﬁ[ﬂj\Dortal support'\NLSTest.warl[M'ﬂ... ]|
|

Cancel

In this step, you can view the war file contents and click Finish.
WebSphers ] ST ) vy Portal Administration Edit my profile 7 Log ow

?;ﬁ. Portal User Interface

@3/’ Portlet Management

Web Modules
Applications
Portlets

Web Services
weh Clipping

{%? AcCcess

:EJ Portal Settings

6.3 Manage pages

Manage Web Modules £ 72 - 0O

Installing a Web module, Step 2: View WAaR file contents.

QThe selected WaR file contents are displayed below, Select the Finish
button to install the WaR file or the Cancel button to go back to the Wehb
module page,

Portlet applications Portlets
| MLSETest application MLSTest portlet

To manage the pages, click Portal User Interface -> Manage Pages.
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In this page, you can navigate the page tree by clicking the page title. You can click the tool icon
to manage the pages. For example, set the page order; edit page layout and set page permission.

WebSphers [T FETTE T Wy Portal [Administration |Edit my profile 7 Log out
Manage Pages 4 & F -0
?'ﬁ Portal User Interfacg Q use the contrals below to work with your pages. Browse or search for pages to work with, Click
Mew to create new pages, labels and urls. Activate and deactivate pages, re-order, edit properties
Manage Pages and layout, move pages, assign permissions and delete, For more information, click Help.
Themes and Skins Search by:| Title starts with v| Search: Search
Sh
sgpdicitietiianacement webSphere Portal » My Portal ) [ [&] (2] [f] gzi.‘;:gz‘m
&/ Access Pages in My Portal Add, Edit, Delsts, and Reorder pages Edit page Nark Reaove

E t
HK— MEw page| |1K— e Iahel| HK— MEw url| Layout Y

%J . Edit page

= Portal Settings

r q property Page 1 of
i i Xove

.w.?PDrtal Analysis Title Unique name doen atus
CloceD-pos 6_0_1UH Active

&3 .
%\% Portal Content Olwelcome wps. My Portal.Welcome ove ‘?UM [x] =]
% ~Shippi 6.0_210 Active (]
%J” Virtual Portals DE—Sh'M (2] [ B) [#] @) & (2] [@
o Ollrrack shinment Status 6_0_=1R sctive (4] [¥] @

6.3.1 Create a new page

To create a new page, just click New Page.

In the following page, you can set the page title, layout, supported markups and click OK to create
a new page.

WebSphara [~

Page Properties
MNew page:Welcome

P Use the controls below to work with wour pages to specify wo
layout, or page cache options.

S5et the title,
Tie: o impenpresken

|LukeTestI | |

[ I want to make this page my ppvate p

B Page Properties
This page can be added to a user's My favoaorites list,

[0 other pages can share the cofitents of this page.

E Type of Page

& A content pade with thesg properties:

o oM oMo oM o

This page supports {7( least one must be selected):
I HTML O =DIME

E Page Cache Options

< Set the cache options for the page, the lesser value of cache
determine the actual cache expiry seconds.

You can see that the new page has been created successfully.
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Page Properties + &2
oK

6.3.2 Edit page layout

If you want to edit the page layout, please click the icon Edit page layout.

You can set the portlet in your wanted place as following.

=dit Layout
<P Edit Layout and Content allows you to add and arrange portlets, columns and rows. You can also remove portlets, columns and rows.

Modifications occur as you make them

Page title: welcome

T 1
O M o0 B B9 B9 |—— Tou can =e1

HomePage portlet =
You can add
can set the portlet
e.

+ add portlets — portlets here. Tou
in the right palc

ect the

[&] =] [@] | select Language (=] (=] [«] (@]

General Information

(2] (=] &)

TrackByHaWBBriefly portlet

+ add portlets
+ Add portlsts

6.3.3 Edit page title and description
If you want to edit the page title and description, please click the icon Edit page property. Then
click “l want to set titles and description”. You can set the portlet in your wanted place as

following.

Title:
welcorme

Themea:

= Page Properties
Fropertie=s:
This page can be added to a user's MMy favorites list.

[0 other pages can share the contents of this page.

=H Tyvpe of Page
This page supports (at least one must be selectaedl:

HTrRL L ernTrar ] wwrrar =ODIMME [ =ul

= Page Cache Options

<

Cache Scope
& Mon-shared cache for a single user
2 Shared cache across users
Cache Expiration
G CTache alwaws expires
O Cache newver expires
2 CTache expires after this many seconds[o
Cachese Access Contral
[ 1gnore access cantral in caches

H aAadwvanced options
[0 This page has a list of allowed portlets.
| I want to set titles and desl:rir:lticlns.!

Click here to set multilimgual

ol emmeay g2igx meme rozer i
Click the edit icon to edit the title and description.
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[ Websphere (2] e~~~ i = SRR 7 | 0g out
Page Properties + 87

Set titles and descriptions for other languages: Welcome

Titles and descriptions for other languages Click the Edit icon to change the title or description for a language.

4] [«] Page 2 of 3 [»] [ Jump to page:[z

Czech Welcome Witejte Ed
Portuguese wWelcome Bem-vindo #
Hebrew welcome OEAN 0217 rs
Arabic Lis 3 [ Click here to Ed
French Bienvenue Bienvenus €dit the = &
= = title and
Simplified Chinese R Bt description rs
Morwegian Welcome Yelkommen &
Finnish wWelcome Tervetuloa -
Romanian welcome Bine ati wenit Ed
Swedish welcome Walkommen rd

[i<] [«] Page 2 of 3 [»] [ Jump to page:[z |

Input the title and description here and click OK.

‘WebSphere L=

Page Properties

Set title and description: Simplified Chinese

Title: REW

ZH

Description: #LiH
E

| DK || Cancel

6.4 Manage Portlets

To manage portlets, you can click Portlet Management -> Portlets.

In this page, you can manage portlets, for example, configure portlet, assign access to a portlet and etc.
Also, you can click Search to search a portlet.

[ Wobsphers [0 ST S 1y Portal Edit my profile T Log out

Manage Portlets +|#2 2 -0

?ﬁ“ Portal User Interface Search b\-f1| Title starts with "| Search:

%r Portlet Management |

weh Modules Portlets Click Copy to create a duplicate of the portlet. Click Configure to set titles, descriptions
and parameters. Click Delete to remove the portlet from your portal. Click Assign Access;;silllg;‘ﬁf

S others to work with the portlet. Delete access to
Portlets Configurerportlet s portlet
o

Web Services Cony portlet T ==
web Clipping portlet = oo ———
|TrackByHAWBBrieﬂy portlet Provide portlet il

Page 1 of 1

w

@/ Access

6.5 Manage Users and Groups
To manage the user and groups, please click Access -> Users and Groups
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WebSphera [N ) ==t 1y portal | Administratiun‘ Edit n

MManage Users and Groups

?—ﬁ. Portal User Interface Search:

Qg}’ Portlet Management Search by:| Al available v| | search
{% Access Users and Groups
| Users and Groups | Mew grDup| x| Mew user
Resource Permissions

User and Group
Permissions

. D
Credential Yault !

All Portal User Groups

uE Portal Settings Al Authenticated Portal Users

To add a new user, please click New user. Input the user information and click OK.
Q Change the information below and click 0K to change your profile.,

* zer I0:
luketestiiie

* Password:

* Confirm Password:

* First Mame:
huke |
* | ast Mame:

|wang |

Ernail:

|wanghuah@anand

Preferred language:
|5imp|iﬁed Chinese V|
* Required Field

| 0K || Cancel |

To add new group, please click New group. Input the group ID and click OK.
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rorrsrw o B ST vy Portal |Administration|

Manage Users and Groups

?@ Portal User Interface Mew group
@3}’ Portlet Management ID:
|Luketest| |

@/ Access | [Tox ][ cancet |

Users and Groups

Fesource Permissions

ser and Group
Permissions

Credential Wault

6.6 Manage themes and skins

To manage themes and skins, please click Portal User Interface -> Themes and Skins

You can select the theme or skin from the list, and set it as default in portal. You can also create a new
theme or skin, and then add new theme or skin in this page.

For details, please refer to the section Customize theme of portal and_Customize skin of portal

WebSphare [2C] b}\\“ EE’ - . My Portal Administration Edit my profile ¥ Log out
Themes and Skins ? - 0O
@. Portal User Interface Tharmes:

Ldmin r Add new theme

Manage Pages Adimin with left navigstion T

Engineering . Delete theme
- Finance
QO/ Portlet Management cience Set as default portal therme
. lebSphere - portal default
-~ Ay
e " Access Home

Lightweight bt
%J Portal Settings Skins:
- outline ~ Add new zkin

. = q Hint

Portal Analysis -
~¥ Y HoSkin . Delete skin

€% MoBordsr Set as default portal zkin
Qg‘/ Portal Content clear

- Fade - portal default

< Tri=mmomt

: Virtual Portals ) i

' Pinstripe

Al Wave v

6.7 Set resource permissions

To set access permissions for page , we have two ways.

1. Click Portal User Interface -> Manage Pages, then navigate to the page, click icon Set page
permission

2. Click Access ->Resource Permission, select Pages as resource type, then navigate to the
page, click icon Assign Access
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To set access permission for portlet, we also have two ways.

1. Click Portlet Management -> Portlets, then navigate to the portlet, click icon Assign access
to portlet

2. Click Access ->Resource Permission, select Portlets as resource type, then navigate to the
page, click icon Assign Access

Here | take the page and the second way as sample. It’s similar for portlets.

[ websphere [20] N ] E ST 1y Portal [Administration| Edit my profile 7 Log out
Resource Permissions + 7 7 -0
-
w Portal User Interface Search hy:| Title starts with | Search:

“‘l,
@J Portlet Management ‘ select Resource Type » Pages » WebSphere Portal » My Portal

f’g/ Page 1 of 1

Users and Groups

Resource OGED-FDA
Permissions Welcome
User and Group

Perrmissions
Credential Yault

| wps, My Portal.Welcome

E-Shipping
Track Shipment Status

User Management
Online Tools

‘FJ Portal Settings -
Maobile Portal

(o | e (e (e (e | o) [

mwp. MobilePortal

After you click the icon Assign Access, you will see the Resource Permissions page.

You can set the permission according to the role, such as Administrator, Manager, Editor, User and
etc. Commonly, we set the permission for the role User.

Click the icon Edit Role in the User line.

| WebSphers [SI°T N ] | = ST 2 | og out 4
Resource Permissions #7072
Welcome
Page 1 of 1
Adrministrator 4 v
Security Administrator v 4
Delegatar
Manager
Editor
Privileged User
User |
Page 1 of 1
Display/Madify Owner
Al
Click the button +Add to add the user or group.
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[ websphers [ S T 7 Log out

Permissions e

+| Add Click here to
T add the role

Welcome » User

Page 1 of 1
KMembers in the Role Delete Member from Role Inherited

Anonymous Portal User ‘

Page 1 of 1

You can search user or group in this page. Commonly, we can select Users, then search by
prefferredLanguage.

WebSphers BOIH S T 7 Log out
Resource Permissions ol
Search for Users ar User Groups. !_l_J;S_E'_fE o
Search by:| preferredLanguage V| fearch: [en | i Search

/
Welcome ¢ User » Add Role Members

1.Tou can search
users or groups here.

2.0r you can just Page 1 of 1
% zelect all from list. e
Select Users and User &Groups

| Al Authenticated Portal Users
O all Partal User Groups

Page 1 of 1
Ok || Cancel |

Input en as preferred language, we can search the user named luke in LDAP of portal.
Select the user luke and click OK to add the user. Then the user luke will act as the User role for
the current resource.
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[ WebSphers [0 RS .- 7 Log out

Resource Permissions

Search for Users or User Groups,

“NHEE

Search by preferredLanguage V|Search: [en | | Search

Welcome » User » Add Role Members

Page 1 of 1
aloct Heopes ol Ll o sy o
e e
| Anonymous Partal User
O luke
Page 1 of 1
ok Cancel
Click the navigation bar to exit the setting page.
[ WebSphere LU R ST 7 L og out

Resource Permissions

“NHEE

EJPAC40031: Members successfully added to the role,

add

Welcome | User Click here
T ——————to retun

Page 1 of 1
Members in the Role Delete Member from Role Inherited
Anonymous Portal User
luke ‘
| I Page 1 of 1
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7. Bring globalization into portal
In this section, you will know how to support globalization in portal.

7.1 Globalization overview in portal project

To support Globalization in portal project, please pay attention to the following aspects.

7.1.1 Localization Pack

To support multi languages, we need to collect all the strings which will be shown in Ul interface,
such as portal web page, email and etc. We can package the Ip files and send to TSC for
translation. After translation, we need to convert the original UTF-8 strings into \U format ASCII
strings. Then we will use WPS taglib or resource bundle to get the strings in LP file.

Note: We will use \U format ASCII file in portal project. But in other projects, such as PvC
projects or Web Services projects, we will use UTF-8 format LP file.

For details, please refer to the section Localization Pack Handling

7.1.2 Select Language

To support multi languages, we need to support language changing in portal website. Then user
can select the preferred language to view the portal website.

For details, please refer to the section Select Language

7.1.3 Globalization Features

Globalization is not just a matter of translation. Cultural information should also be considered, as
people from different cultural background would expect different behaviors of a same application.

For details, please refer to the section Enable GBO in portal project and Globalization Preference
in portal project

7.1.4 Globalization Preference

User can set his (or her) globalization preference after logging in portal website. For example, the
user can browser the portal website in English, but the measurement format or calendar format can
be set to Simplified-Chinese format.
We can provide the following g11N preferences for users.

Popup Calendar

Pull down Calendar

Currency Format

Length Format

Weight Format

Date/Time Format
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® Honorific
® Name format
® Address format

For details, please refer to the section Globalization Preference in portal project

7.1.5 Bidi support

Commonly we choose several languages in our portal project; there should be one bid language,
such as Hebrew or Egyptian. Bidi support is very unique and special for us for it’s display from
right to left in website. Portal developers should pay more attentions to bidi.

For details, please refer to the section Bidi in portal

7.1.6 Artwork in portal

In a globalization portal project, we may need to modify the stylesheet to meet the requirement in
each locale.

For details, please refer to the section Artwork in portal

7.1.7 Locale handling

In portal project, locale is everywhere. Developer needs to know how to get the locale and use it in
jsp, portlet and business beans.

For details, please refer to the section How to get userid and locale in portlet and Locale fallback
in portal

7.1.8 Encoding

If the encoding is not right, the words may be error code, and the portal page will not be right to
users. So we need to set UTF-8 encoding in jsp page, localization pack files, java string handling.

For details, please refer to the section Encoding of portlet

7.2 How to get userid and locale in portlet

Please get the locale and userid as the following.

7.2.1 User Locale

1. Theme
com.ibm.wps.engine.RunData rdata = com.ibm.wps.engine.RunData.from(request);

String userLocale = rdata.getLocale().toString();
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out.printIin("userLocale is: " + userLocale);

2. Portlet (In the following methods: processAction, doView,actionPerformed)

//Get the locale from request

String userLocale =
com.ibm.sgl.oged.util.LPUtil.getUserLocale((javax.servlet.ServletRequest)request);

//Set the user locale to session

request.getPortletSession().setAttribute("userLocale",userLocale);

/lor set it in application scope
request.getPortletSession().setAttribute("userLocale",userLocale,PortletSession. APPLICATION _
SCOPE);

3. Portlet jsp files

//Get the locale from request

String userLocale = com.ibm.sgl.oged.util. LPUtil.getFullLocale(request.getLocale().toString();
/lor get it from application scope
renderRequest.getPortletSession().getAttribute(“userLocale”,PortletSession. APPLICATION_S
COPE);

4. Java Classes

3.1 If you have get the request firstly.

//Get the locale from request object

String userLocale =
com.ibm.sgl.oged.util.LPUtil.getUserLocale((javax.servlet.ServletRequest)request);

3.2 Or you can get from session if you have set locale in session.
//Get the locale from session
String userLocale = request.getPortletSession().getAttribute("userLocale™);

7.2.2 User ID

1. Theme jsp file
//Get user id from request
com.ibm.wps.engine.RunData rdata = com.ibm.wps.engine.RunData.from(request);
com.ibm.wps.puma.User user = rdata.getUser();
String userid = null;
if (null '=user) {
userid = user.getUserID();
user.setPreferredLanguage(userLocale);

¥

out.printin(“userid is: " + userid);

>
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or you can write as the following
String userid = request.getRemoteUser()

2. Portlet class (In the following methods: processAction, doView,actionPerformed)
//Get the locale from request

String userid = request.getRemoteUser();

//Set the user locale to session

request.getPortletSession().setAttribute(*"userid”,userid);

3. Portlet jsp files
//Get the user id from request
String userid = request.getRemoteUser());

3. Java Classes

3.1 You should get the request firstly.
//Get the locale from request

String userid = request.getRemoteUser();

3.2 Or you can get from session if you have set it.
//Get the locale from session
String userid= request.getPortletSession().getAttribute(“userid")

7.3 Localization Pack Handling

To support multi languages, we need to collect all the strings which will be shown in Ul interface,
such as portal web page, email and etc. We can package the Ip files and send to TSC for
translation. After translation, we need to convert the original UTF-8 strings into \U format ASCII
strings. Then we will use WPS taglib or resource bundle to get the strings in LP file.

Here | will show you the life cycle of the Localization Pack.

7.3.1 Collect the LP strings and organize the Localization Packs

Please collect all the English strings into the LP properties file like the following. Please pay
attention to those strings which may not be displayed in Ul pages, such as portlet tiles, page titles,
status , code system.

Note: If the string is too long, please separate it into several strings in LP file.

Note: The line “# NLS_MESSAGEFORMAT_NONE” is required in LP file
#welcome.properties

#This file is for OGED WEMP welcome function

# By Luke 2005-8-3

>
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#NLS_MESSAGEFORMAT_NONE

#Portlet titles
PORTLET WELCOME=Welcome

#Title informations
TITLE_GENERALINFORMATION=General Information

#Table column name
TABLE_TRACKSHIPMENT=Track shipment status

#Button label
BUTTON_TRACK=Track

#Notification information
NOTE_ABOUTSLOGAN=If you can make it here, you can make it everywhere.

#Error messages
EM_GENERAL=The system is temporarily unavailable, please contact the system administrator.

#Other string

Organize the LP files by locale like the following.

= [5) Shipmentl ﬂ image. properties

= [ ar_FG ﬂlwpuser. properties

5 UTF-3 ﬂm}'task. properties
7 en US ﬂnew. properties

= [5) £r_FR ﬂ ordlinetool. properties
=) UTF-3 ﬂnther.prnperties

= 5 zh CH ﬂrepnrt. properties
=) UTF-& ﬂshipping. properties

WL P o

Note: Please use notepad instead of UltraEdit to view and update LP files. For the Unicode
support in UltraEdit is not very good.

7.3.2 Translation of LP

After the LP files are packaged, we need to contact translation service provider for transltation

Sometime we can just send UTF-8 format file, sometimes we need to send XLIFF files. So we need to
use the tool XLIFF to convert the property file to XLIFF file. When the LP files are returned, we need
to convert from XLIFF to property file.

Note: Please ensure the returned files are using UTF-8 encoding.

For details of XLIFF, please refer to the readme.txt in xliff

java -jar Prop2XLF.jar [-version] [-without-locale-suffix] [-reverse] [-mode aggregate|mirror|given]

>
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[-target-languages ab-CD,ef-GH,ij-KL,xx-XX] [Source] [Result]

Note: Please use notepad instead of UltraEdit to view and update LP files. For the Unicode
support in UltraEdit is not very good.

Note: It’s very important to maintain the LP file version! Please ensure all the keys in each
locale the same.

7.3.3 Write WPS tag or use resource bundle

We have two methods to get the LP strings in LP file. Write a WPS tag or use resource bundle
directly.

1. For WPS tag, please refer to the section How to write aWPS Tag

2. About writing resource bundle code, please refer to java JDK.

Here is a sample.

package com.ibm.sgl.oged.lwp.plugin.utils;

import java.util.Locale;
import java.util.*;

import java.io.*;

import org.apache.log4j.*;

public class LocaleUtil {
public static String getResource(String name) {
Locale locale = Locale.getDefault();
StringBuffer bundleBuffer = new StringBuffer()
.append(“conf").append(File.separator)//SNON-NLS-1$
.append(“resource");//SNON-NLS-1$
ResourceBundle bundle =
ResourceBundle.getBundle(bundleBuffer.toString(), locale);
return bundle.getString(name);

7.3.4 Using LP in portal project
1. Add the LP files into portal prOJect like the following

=1-{Z3 WEMPPro_]ect Ewelcome properties
ES “TI - =settings ﬂuser properties
H-L3 etp %] trackine properties
*-J etp. mlkelem ﬁstandalone.properties

] JTawaSource
+ _| com

{ confiz—file
SRR o) e naBack

|%] shippine. properties
%] report. properties
ﬁ pluzin. properties
|#] cther. properties

j :;_ﬁ: i‘ onlinetool. properties
ca fr_FR ﬁnew. properties
1 zh_CH %] mytasl. properties
e ;l wempproject i‘lwpuser. properties
—-{_] WebContent ﬁ image. properties
513 html %) codesystem. propertieas
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2. InJSPfile

Write the following code in jsp page:

<!I--Import the taglib -->

<% @taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip" %>

<!I—Or you can init another instance -->
<%@taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ipnew"%>

<!--Load the property file -->
<Ip:load file="user.properties" />
<!--You can load another properties file using the new instance -->

<Ip:load file="other.properties" />

<!I--Get the translated string from Ip -->
<Ip:value key="USER_NAME" />
<lIpnew:value key="ERR_GENERAL" />

3. In Portlet or Business Bean

We can use the utility class LPUtil.class in portlet and business bean. Please refer to LPUtil.java
for details.

I

String mailSubject = (LPULtil.getLPValue(locale,”other.properties”,”"EMAIL_TITLE”));

7.3.5 Verify multi languages in portal website

After the portal project is deployed into portal server. User can also browser the website in each
locale by changing the language in homepage as the following.

Here are two images for two languages.
English
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- ]
Administiation [T TR

Welcome E-Shipping Track Shipment Status  User Management  Online Tools

Genenal Infarmation About DGED About SGL

I General Information

Welcome to Global Express Demo (QGED), the globalization solution for the express industrd OGED leverages [BM
Workplace, WebSphere Everyplace Mobile Portal, RFID and other products to address the needs of express companies
and their business partners. The core products and technologies that OGED uses are described as follows: I Please select a language

= |BM Warkplace: IBM Workplace Collahoration Services is a single product that provides a full range of integrated ready-

to0-use communication and collaboration taols that enable peaple to do their jobs more affectivaly - amytime, anywhere Englizh (United States)
‘With the flexibility to deploy any mix of capabilities, it provides a ready-made foundation to build customized role-hased
Workplace environments that provide the tools and information peaople need to do their work mare efficiently (ch () i

frangais (France)

=YWEMP: WehSphere Everyplace Mobile Portal (WEMP) is a key component of WebSphere Evervplace Service Delivery. It

Simplified-Chinese:
il RERSEE G
*in {ZR{iEE ShilEdE APEE TR

|ﬂ$

OISR OGED » Mg mi Bk AR 7T OGED®ER T 18M Workplace s WehSphere Everyplace Maobile Portal
FF IDFIE AR G R R A S T T S MRS, OGEGETER™ SFHEA0T

EEES

= 1B Workplace: IBM \orkplace Collaboration Sericesr™ B8 T 2 EARE » BREAMERTMRITETE » 80101 I

AR R A T fE. e T AT LLR E R E S FhThakE  » IBM Workplace Collaboration Senicesal LB A FPRER

EET RSN RITEIRE , B L. T (T3 v
E.

glich (lUnited States)
=WEMP: WehSphere Everyplace Mobile Portal pWEMPRWebSphere Everyplace Senvice Delvenfzxi@r=f. EH#RT G

WiehSphere PortalfEt LR Bt TRERS IR ANRE » B S e Bilils] , Rt | A F T ¢ais (Erancel
HRGMEETE, HESNT “—ikRE, SHEEH0" . Lyrmdl fpaa)

7.3.6 TVT

In TVT phase, tester may find that some words are not right.

We need to contact the translate to correct it and update the following places:

1. The properties file in Localization Pack directory of CC

2. The properties file in portal project

3. The properties file in portal deployed directory (You may need to re-deploy the portal project
or restart the portal server to take effect.)
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7.3.7 How to Support Complex Sentence in Localization Pack File

We collect all the strings into localization pack files, which will be translated by TSC. Sometimes
we need to use a variable in the Ip strings. For example, RESULT=There are {%number} results
found.

We can write a method replaceString() to replace the variable with true value.

Here is the sample:

7.3.7.1 String in Localization Pack file

Here is the LP string in LP file.
# {%number} represents the tickets number ; {%acocount} represents the total cost of this order.
BOOKING_RESULT =You have booked {%number} tickets. Total cost is {%account}.

7.3.7.2 Code in jsp file

We call the method reaplceString() to replace the variable with true value in LP string.

<%= replaceString(replaceString(LPULtil.getLPValue(lpFile, "BOOKING_RESULT") )
"{%number}" , ticketNumber), "{%account}" total Account) %>

7.3.7.3 The method replaceString()
The method replaceString().
<%!
public String replaceString(String original, String source, String target) {
String result = original;
int pos = 0;

pos = original.indexOf(source);

if (pos !=-1) {
result = original.substring(0, pos);
result += target;
result += original.substring(pos + source.length(), original.length());

return result;

%>

©Shanghai Globalization Lab, User Page 110
Technology, CSDL, IBM China 2006

¢




Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

7.4 Select language

To support multi languages, we need to support language changing in portal website. Then user
can select the preferred language to view the portal website.

Here | attach two images of two languages.

7.4.1 English

» " T i ]
Administation [ TSR T balization P

Welcome E-Shipping Track Shipment Status  User Management  Online Tools

Genenal Infarmation  Aboul 0GED  About SGL

I General Information

Welcome {o Glohal Express Demao (OGED), the glohalization solution for the express industry! OGED leverages 1BM .
Workplace, YehSphere Everyplace hobile Portal, RFID and other products to address the needs of express companies

and their business parners. The core products and technologies that OGED uses are descrihed a5 follows: Please select a language
= |[BM Workplace: [BM Workplace Collaboration Services is a single product that provides a full range of integrated ready-
to-use communication and collaboration tools that enable people to do their johs more effectively - anytime, anywhere.
‘With the flexibility to deploy any mix of capahilities, it provides 2 ready-made foundation o build customized role-based
Workplace environments that provide the tools and information people need to do theirwaork mare efficienthy.

=WENMP: WebSphere Everyplace Mohile Porial (WEMP) is 2 key component of WehSphere Everyplace Service Deliveny. It

7.4.2 Simplified-Chinese:
Tl TR
witiasn @ HPEE #¥TH

Cﬂ.lr ﬁlub'w'lfvprr.' - Pemo *F OGED *F 56L

Iﬂg

REROGED » Mg T kAR 3T OGEDRR T IBM Workplace , ‘WebSphere Everyplace Mohile Fortal,
RF IDFIEARF= R R L S A T Sk R . OGEGET A R0 T

EEES
= 1B Workplace: 1B Workplace Collaboration SerdcesF™ RAEH T2 EARS » BREEFERAFIMRTETLER » 480101 I
AL FERT R A T . | T A LU A B -S e ThERsEM » IBM Workplace Collaboration SenicesT LR PEEWN
BETAHEMTR TR, FEam L El. EESCT-D v|
«WEMP: YWehSphere Everyplace Mohile Portal (WEMP)2WWebSphere Everyplace Service Deliven@i-siir= R, CEFT el "t [E
WebSphere Punal}ﬁ*&ﬁﬁféﬂﬁ%éﬁﬂﬁ%k&ﬁWWE o BT S AT TS SRR A LA T R francais (Francel
HFEHGMERSIE, HIERET “—RRiE, ZREE0” . Looprdt [ puo)
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7.4.3 Code Fragment

We implement this function using JavaScript and WPS command ChangeLanguage.

Here are the code fragments.

<%@ page language="java" contentType="text/html; charset=UTF-8" pageEncoding="UTF-8"
session="true"%>

<%@ taglib uri="http://java.sun.com/portlet” prefix="portlet" %>

<%@ page import="java.util.* ,javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.*" %>

<%@ page import="java.util.* javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.*,
com.ibm.sgl.oged.db.databean.G11NPreferenceBean, com.ibm.sgl.oged.constant.UserConstansts,

com.ibm.sgl.oged.util.CodeSystem, com.ibm.sgl.gbo.core.operation.FeatureManager,
com.ibm.sgl.gbo.localelist.IGLocaleList,

com.ibm.sgl.gbo.core.preference.base.* ** %>

<%@ page import="com.ibm.sgl.oged.util.*"%>
<%@ taglib uri="/WEB-INF/tld/engine.tld" prefix="wps"%>

<%@ taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip" %>
<Ip:load file="welcome.properties"/>
<portlet:defineObjects />

<%@ include file="Bidi.jsp" %>

<script language="JavaScript">
function changeLangUrl(){
var language = document.selLangForm.Language.value;
//Set the cookie locale for XUL function in Mozila
var Then = new Date();
Then.setTime(Then.getTime() + 60*1000 ); //60second
document.cookie = "locale=0ogedwemp.cn.ibm.com_"+language+";expires="+
Then.toGMTString();

var submitURL;
if(language=="en_US")

{
submitURL = "<wps:url command="ChangeLanguage"><wps:urlParam name="locale"
value="en_US"/></wps:url>";  }
else if(language=="zh_CN")
{

submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale
value="zh_CN"/></wps:url>";

}

else if(language=="ar_EG")

{

>

submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale
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value="ar_EG"/></wps:url>";
}
else if(language=="fr_FR")
{
submitURL = "<wps:url command="ChangelLanguage"><wps:urlParam name="locale"
value="fr_FR"/></wps:url>";

}

<wps:if loggedIn="yes">
submitURL=submitURL.replace("portal”,"myportal");
</wps:if>

window.location.href = submitURL;

}

</script>

<%

/ICookie cookie = new Cookie("locale", "en_US");
/[cookie.setMaxAge(100000000);

//String name = cookie.getName();

/IString value = cookie.getValue();

/Iresponse.addCookie(cookie);
/Iresponse.flushBuffer();
/lout.printIn("Finish adding cookie - "+name+" | "+ value);

String userLocale = com.ibm.sgl.oged.util.LPUtil.getFullLocale(request.getLocale().toString());

/IString curLocale = request.getLocale().toString();
[lout.printIn("*****getRemoteUser is " + request.getRemoteUser());
/lout.printIn("*****getLocale is " + userLocale);

%>

<%]
public String replaceString(String original, String source, String target) {
String result = original;
int pos = 0;

pos = original.indexOf(source);

if (pos !=-1) {
result = original.substring(0, pos);
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result += target;
result += original.substring(pos + source.length(), original.length());

return result;

%>

<form name="selLangForm">

<link href="/wps/oged/images/<%=userLocale %>/Styles.css" rel="stylesheet" type="text/css">

<table width="270" border="0" cellspacing="0" cellpadding="0">
<tr>
<td><img src="/wps/oged/images/<%=userLocale%>/homemapl.gif* width="271"
height="50" alt="<Ip:value key="TABLE_SELECTLANGUAGE"/>"></td>

</tr>
</table>
<table width="100%" border="0" cellpadding="0" cellspacing="0"
class="protalboxsmall<%=dir%>">
<tr>

<td height="29" class="protaltd2map<%=dir%>" ><div ><Ip:value
key="TABLE_SELECTLANGUAGE" /></div></td>
</tr>
<tr>
<td height="65" class="protaltd3map<%=dir%>" ><div align="center" >
<select onchange="changeLangUrl();" name="Language" >
<%
String localeList[] ={"en_US", "zh_CN", "fr_FR", "ar EG"};
String languageList[] = {"en", "zh", "fr", "ar"};
String countryList[] = {"US", "CN", "FR", "EG"};

BasePreferenceFactory bpf = BasePreferenceFactory.getFactory();
BasePreference bp = bpf.getBasePreference("languageL.ist");

FeatureManager fm = FeatureManager.getinstance();
for(int i = 0; i<4; i++) {
Locale locale = new Locale(languageList[i], countryList[i]);
/ISystem.out.printin(locale);
bp.setLanguage(locale);
/ISystem.out.printin(localeList[i] + locale);
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IGLocaleList gll = (IGLocaleL.ist) fm.getFeature(IGLocaleL.ist.class, "languageL.ist");

String langL.ist3 = gll.getLocaleName(locale);
/[System.out.printIn(langList3);
String optionValue = "";
if(CodeSystem.LOCALE_EN.equals(localeList[i])) {

optionValue = CodeSystem.LANGUAGE_EN;
}
if(CodeSystem.LOCALE_CN.equals(localeList[i])) {

optionValue = CodeSystem.LANGUAGE_CN;
}
if(CodeSystem.LOCALE_FR.equals(localeList[i])) {

optionValue = CodeSystem.LANGUAGE_FR;
}
if(CodeSystem.LOCALE_AR.equals(localeList[i])) {

optionValue = CodeSystem.LANGUAGE_AR;

dir ="rtl";

langList3 =

replaceString(replaceString(langList3,")","&#8207;)" ),"("," &#8207;(");
}
%>
<option dir="<%=dir%>" value=<%=optionValue %>
<%if(optionValue.equals(userLocale)) {out.print("selected");} %>>
<div align="center" dir=<%=dir%> >
<%-=replaceString(replaceString(langList3,")",bidiForceString+")" ),"(",bidiForceString
+1(")%>
</div ></option>

<%
} %>
[select>
</div></td>
</tr>
</table>
</form>

7.5 Globalization Preference in portal projects

User can set his (or her) globalization preference after logging in portal website. For example, the
user can browser the portal website in English, but the measurement format or calendar format can
be set to Simplified-Chinese format.

>
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7.5.1 Globalization Preference

We can provide the following g11N preferences for users.
® Popup Calendar

Pull down Calendar

Currency Format

Length Format

Weight Format

Date/Time Format

Honorific

Name format

Address format

7.5.2 Design a table base for G11n preference

We need to store the G11n preference setting in database. Any G11n feature should be related to a
field.For example, Currency, Length, Weight and etc.

Here is a sample.
511 HFEEFERENCE
o FOUSERID : USER

o F LAHGUAGE
CURRENCY
DATETIME
CALEHDAR
WETLGHT
LEHGTH
FIELT!
FIELLZ
FIELD3

[N OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0

Then you can generate the script in RSA.
-- Please run the command: db2 -tvf OGED.sql
CREATE DATABASE OGEDWEMP;
CONNECT TO OGEDWEMP;
CREATE SCHEMA DB2INSTZ;
CREATE TABLE DB2INST1.G11NPREFERENCE
(USERID VARCHAR(32) NOT NULL,
LANGUAGE VARCHAR(32) NOT NULL,
CURRENCY VARCHAR(10) NOT NULL,
DATETIME VARCHAR(10) NOT NULL,
CALENDAR VARCHAR(10) NOT NULL,
WEIGHT VARCHAR(10) NOT NULL,
LENGTH VARCHAR(10) NOT NULL,
)i
ALTER TABLE DB2INST1.G11INPREFERENCE ADD CONSTRAINT C2239253 PRIMARY
KEY (USERID);

>
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ALTER TABLE DB2INST1.G11NPREFERENCE ADD CONSTRAINT USERID FOREIGN
KEY (USERID)

REFERENCES DB2INST1.USER(USERID);
CONNECT RESET;
Here is the G11n preference in database.
Note WM1001and LM1001 are constants in Code System and represent Metric or English.
USERID LANGUAGE CURRENCY DATETIME CALENDAR WEIGHT LENGTH

lukewang en_US en_US en_US en_US
WM1001 LM1001
7.5.3 Write DAO and DataBean

Commonly DataBean is related to a table in database, you can also define a DataBean as data
transferring between classes. DataBean is a set of data, which will be used everywhere in the
portal project. Such as portlet, ActionBean, BusinessBean, JSP and etc. We need to write DAO to
handle the database related operations. For example, insert, query, update, delete and etc.

7.5.4 Write a portlet for G11n preference

A portlet can be provided for user to set the G11n preference.

7.5.5 Verify the results in portal website

Set the value in the portlet.
Assume that the current user browsers the website using English, but he (or she) wants to set the
G11n preference to Chinese format.
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I Edit Globalization Preference

Freferred Languade far

Feport |¢-x Lot vl

> Armerican format--=Sample: USD1.11
(& Chinese format--=Sample; CHY 2.23
currency Format
> French format---=Sample: ELIR 1.03
£ Eovptian format---=Sample: EGF .23
O American format---=Sample: Mow 30,2005 4:27:00 A
& Chinese farmat--=Sample: 2005-11-30 4:27:00
DatefTirme Format
2 French farmat--=Sample: 30 novermbre 05 04:27:00
O Egvptian farmat—-=Sarmple: 3001152005 4:27:00
O American format---=Sample: BiA
& Chinese format--=Sarmple; MIA
Calendar Format
> French format---=Sample: MNiA
£ Egvptian format---=Sample: HA
> British measurement---=5ample:1 23lb{pound)
Weight Format
& metric measurement---=Sample: 0 85 8kalkilograrm)
2 British measurement-—-=Sample:1.23 fiffoot)

Length Format
& Metric measurement—-=Sample:0.375m (meter)

Subrnit I FRezet I

Verify the result in portal website.

You can see that the Currency, Date/time is set to Chinese format, and Length, Weight are set to
Metric format.

Shipment Information

100
Wiidth 3

Height 200 e |

Gross Weight 1 |

[Insured Amount | CMY 827.74
Fostage
Caontent candy

Status In local warehouse
Regquired Pick-ug Time 2005-11-1 F:00:00
Actual Fick-up Time 2005-11-3 9:47:36
Feguired Arrival Time 20058-11-6 12:00:00
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7.6 Enable GBO in portal project

It's a well-known fact that an application should provide a friendly, "globalized" interface for its
customers. However, there is a category of culturally sensitive GUI (graphical user interface)
functionalities that is indispensable for the globalized appliations but not currently supported by
Java or other existing technologies and that often requires developers to write complex code from
scratch.

Global Business Object (GBO) is a technical preview that provides a set of libraries for
constructing culturally aware graphical controls. GBO encapsulates the functions into a reusable
globalization tag library in a J2EE environment. Programmers can easily create global GUI
functions in Java Server Pages (JSP) files by simply using GBO's tags.

Here 1 will list some sample code used in portal project. you can visit GBO intranet website for
details. http://9.181.106.149:9080/gbo/.

Fore more details about GBO, please visit the following link.

Build culturally aware apps with GBO:
http://www-128.ibm.com/developerworks/java/library/j-gbo/?ca=dnt-649

Global Business Object:

http://www.alphaworks.ibm.com/tech/gbo

7.6.1 Pop up Calendar

JavaScript fragments
For details, please refer to GBO team: PopupCalendar.jsp and PopupCalendar.js

Code fragments
<tr>
<td class="td3<%=dir%>"><Ip:value key="TABLE_BEGINDATE" /> </td>
<td class="td6">

<input type="text" id="datel_ Show" name="begindateshow"
readonly="readonly" value=<%=begindate%>>
<input type="hidden" id="date1" name="begindate"

<%if(0!=begindatehidden.length())%> value=<%=begindatehidden%>>

<input type="hidden" id="datel_Unformat" >

<img src="/wps/oged/images/calendar.qgif" alt="<Ip_alt:value
key="CALENDAR"/>"
onclick="window.open('<%=renderRequest.getContextPath()%>/html/popupcalendar/PopupCalen
dar.jsp?locale=<%=poplocale%>",'datel’,'height=200,width=210,scrollbars=no,resizable=yes,statu
s=no,menu=no,toolbar=no")">

</td>
<tr>
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7.6.2 Pull down Calendar

JavaScript fragments

<SCRIPT language="JavaScript">

/1f there are more than one PulldownGBO in one page.

/IYou should repacle the name of year, month, date with new one.
var monthdays = new Array(12);

monthdays[0] = 31;
monthdays[1] = 28;
monthdays[2] = 31;
monthdays[3] = 30;
monthdays[4] = 31;
monthdays[5] = 30;
monthdays[6] = 31;
monthdays[7] = 31;
monthdays[8] = 30;
monthdays[9] = 31;
monthdays[10] = 30;
monthdays[11] = 31;

var back = new Array(4);

function update_days(f)

/I alert(f.months.parent());
compute_days(f);
var lengthDeleted = 31 - monthdays[f.month1.selectedIndex];

if(back[0] == null){
for(x=0;x<back.length ;x++) {
back[x] = f.date1[30 - x];

if(null !'= back[0]){
for(x=0;x<back.length ;x++) {
f.date1[30 - x] = back[x];

-

>
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for(x=0;x<lengthDeleted ;x++) {
f.date1[30 - x] = null;

function compute_days(f){
if(!isNaN(f.yearl.value) && f.yearl.value.length > 0){
var year=parselnt(f.yearl.value);
var ret_val = 0;
if (year % 4 == 0 && year % 100 !=0)
ret_val=1;

if (year%4 == 0 && year % 400 == 0)
ret_val=1;

if(ret_val == 1){
monthdays[1] = 29;
Yelse{
monthdays[1] = 28;

¥
</SCRIPT>

Code fragments
<%@

page

import="java.util.* java.text.* java.sql. Timestamp,javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.

*,com.ibm.gcl.gbo.calendar.*,com.ibm.gcl.gbo.template.*" %>

<%

CalendarGBO calendar = CalendarGBO.getInstance(locale);

String dateorder = calendar.getDateOrder();

for(int j = 0; j < dateorder.length(); j ++){

if(dateorder.charAt(j)=="m"){

%><td class="td2<%=dir%>">

<select name="month1" size="1" onchange="update_days(this.form)">
<%

String[] monthvalue = {"1","2","3""4" 5" "6","7","8","9","10","11","12"};

String[] monthcaption = calendar.getFullMonthL.ist();
for(inti = 0; i < monthvalue.length; i ++) {

>
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if(monthvalue[i].equals(month)){
%>
<option value="<%=monthvalue[i]%>"
selected><%=monthcaption[i]%></option>
<% Yelse{ %>
<option value="<%=monthvalue[i]%>"><%=monthcaption[i]%></option>
<% }

%>
</select>
</td>
<%

}

else if(dateorder.charAt(j)=="d"){
%><td class="td2<%=dir%>">
<select name="datel1" size="1">
<%
String[] dayvalue =
£r1m,2m 3 4 e e, e, e, Lo LA 12 M3 14 B e ML 7, 18, 19" 20" 121,
22", "23" "24" 25" "26" 27" "28","29","30" ,"31"};
String[] daycaption = calendar.getFullDayL.ist();
for(int i = 0; i < dayvalue.length; i ++)
{
if(dayvalue[i].equals(date)){
%>
<option value="<%=dayvalue[i]%>" selected><%=daycaption[i]%></option>
<% Yelse{ %>
<option value="<%=dayvalue[i]%>"><%=daycaption[i]%></option>
<% }

%>
</select>
</td>
<%

}

else if(dateorder.charAt(j)=="y"){

%><td class="td2<%=dir%>">

<select name="yearl" size="1" onchange="update_days(this.form)">

<%

String yearlist[] =
{"'2000","2001","2002","2003","2004","2005","2006","2007","2008","2009","2010"};
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for(int i = 0; i < yearlist.length; i ++){
if(yearlist[i].equals(year)){
%>
<option value="<%-=yearlist[i]%>" selected><%=yearlist[i]%></option>
<% Yelse{ %>
<option value="<%=yearlist[i]%>"><%=yearlist[i]%></option>
<% }

%>
</select>
</td>
<%

}

Yo>

<td class="td2<%=dir%>">

<select name="time" size="1">

<%

String[] times =
{"00:00","01:00","02:00","03:00","04:00","05:00","06:00","07:00","08:00","09:00","10:00","11:0
0","12:00","13:00","14:00","15:00","16:00","17:00","18:00","19:00","20:00","21:00","22:00","23
:00"};

for(inti = 0; i < times.length; i ++){
if(times[i].equals(time)) {
%>
<option value="<%-=times[i]%>" selected><%=times[i]%></option>
<% }
else{
%> <option value="<%=times[i]%>" ><%=times[i]%></option>

<% }
}
%>
</select>
</td>

7.6.3 Measurement

Measurement sample

>
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/*
* Class: MeasurementUtil.java
* Description:
*Version: 1.0
* Author: swj
* Creation date: Sep 12, 2005
* Department: Shanghai Globalization Laboratory
* Copyright (c) 2004, International Business Machines Corporation,
* All rights reserved.
*/

package com.ibm.sgl.oged.util;

import com.ibm.gcl.gbo.measure.MeasureGBO;

/**
*

*

* @author swj
* @version 1.0
*/
public class MeasurementUtil {
/**
* Unit name for cm.
*/
public static final String UNIT_CM = "cm";

/**
* Unit name for inch.
*/
public static final String UNIT_INCH = "inch";

/**
* Unit name for kg.
*/
public static final String UNIT_KG = "kg";

/**
* Unit name for pound.
*/
public static final String UNIT_POUND = "pound";

/**

>
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* Format the length value to display. The formatted number will contain the
* unit information.

*

* @param initValue

* The initial value. This value is in the unit "cm".

* @param convertTo

* The target unit system. This is one of the two values:

* CodeSystem.LENGTH_ENGLISH CodeSystem.LENGTH_METRIC
* @param displayLocale

* The result locale.

* @return The formatted string.

*/

public static String formatLength (double init\Value, String convertTo,
String displayLocale) {
String initUnit = UNIT_CM;
String toUnit = UNIT_CM;
if (CodeSystem.LENGTH_ENGLISH.equals(convertTo)) {
toUnit = UNIT_INCH;

return MeasureGBO.convertByUnit(initUnit, toUnit, initValue, displayLocale);

/**

* Format the length value to display. The formatted number will contain the
* unit information.

*

* @param initValue

* The initial value. This value is in the unit "cm".

* @param convertTo

* The target unit system. This is one of the two values:

* CodeSystem.LENGTH_ENGLISH CodeSystem.LENGTH_METRIC
* @param displayLocale

* The result locale.

* @param precision

* The number of digits that will be kept.

* @return The formatted string.

*/

public static String formatLength (double initValue, String convertTo,
String displayLocale, int precision) {
String initUnit = UNIT_CM;
String toUnit = UNIT_CM;
if (CodeSystem.LENGTH_ENGLISH.equals(convertTo)) {
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toUnit = UNIT_INCH;

return  MeasureGBO.convertByUnit(initUnit, toUnit, initValue, displayLocale,
precision);

}

/**

* Format the length value. Only the number part of the value will be
* returned.

*

* @param initValue

* The value to be converted.
* @param fromLocale

* The original locale.

* @param toLocale

* The target locale.

* @param displayLocale

* The display locale.

* @return The formatted value.

*/

public static String formatLengthValue (double initValue,

String fromLocale, String toLocale, String displayLocale) {

String initUnit = UNIT_CM;

String toUnit = UNIT_CM;

if (CodeSystem.LENGTH_ENGLISH.equals(initUnit)) {
initUnit = UNIT_INCH;

}

if (CodeSystem.LENGTH_ENGLISH.equals(toUnit)) {
toUnit = UNIT_INCH;

}
return MeasureGBO.convertValueByUnit(initUnit, toUnit, initValue,displayLocale);

/**

* Convert the length value to the standard unit. This method shall be
* called before values are added to database.

*

* @param initValue

&3 The initial value.
* @param initMetric
&3 The initial unit.

* @return The converted value without unit.

>
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*/
public static double convertLength (double initValue, String initMetric) {
String initUnit = UNIT_CM;
String toUnit = UNIT_CM;
if (CodeSystem.LENGTH_ENGLISH.equals(initMetric)) {
initUnit = UNIT_INCH;
}
return MeasureGBO.convertValueByUnit(initUnit, toUnit, initValue);

/**

* Format the weight value to display. The formatted number will contain the
* unit information.

*

* @param initValue

* The initial value. This value is in the unit "kg".

* @param convertTo

* The target unit system. This is one of the two values:

* CodeSystem.WEITHT _ENGLISH CodeSystem.WEIGHT _METRIC
* @param displayLocale

* The result locale.

* @return The formatted string.

*/

public static String formatWeight (double initValue, String convertTo,
String displayLocale) {
String initUnit = UNIT_KG;
String toUnit = UNIT_KG;
if (CodeSystem.WEIGHT _ENGLISH.equals(convertTo)) {
toUnit = UNIT_POUND;

return MeasureGBO.convertByUnit(initUnit, toUnit, initValue, displayLocale);

/**

* Format the weight value to display. The formatted number will contain the
* unit information.

*

* @param initValue

* The initial value. This value is in the unit "kg".

* @param convertTo

* The target unit system. This is one of the two values:

* CodeSystem.WEITHT _ENGLISH CodeSystem.WEIGHT _METRIC
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* @param displayLocale
* The result locale.
* @param precision
* The number of digits that will be kept.
* @return The formatted string.
*/
public static String formatWeight (double initValue, String convertTo,
String displayLocale, int precision) {
String initUnit = UNIT_KG;
String toUnit = UNIT_KG;
if (CodeSystem.WEIGHT _ENGLISH.equals(convertTo)) {
toUnit = UNIT_POUND;

return  MeasureGBO.convertByUnit(initUnit, toUnit, initValue, displayLocale,
precision);

}

/**

* Format the weight value. Only the number part of the weight will be
* returned.

*

* @param initValue

* The value to be formatted.
* @param fromLocale

* The original locale.

* @param toLocale

* The target locale.

* @param displayLocale

* The display locale.

* @return The formatted value.

*/

public static String formatWeightValue (double initValue,

String fromLocale, String toLocale, String displayLocale) {

String initUnit = UNIT_KG;

String toUnit = UNIT_KG;

if (CodeSystem.WEIGHT _ENGLISH.equals(initUnit)) {
initUnit = UNIT_POUND;

}

if (CodeSystem.WEIGHT_ENGLISH.equals(toUnit)) {
toUnit = UNIT_POUND;

-
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return MeasureGBO.convertValueByUnit(initUnit, toUnit, initValue, displayLocale);

/**

* Convert the weight value to the standard unit. This method shall be
* called before values are added to database.
*
* @param initValue
&3 The initial value.
* @param initMetric
* The initial unit.
* @return The converted value without unit.
*/
public static double convertWeight (double initValue, String initMetric) {
String initUnit = UNIT_KG;
String toUnit = UNIT_KG;
if (CodeSystem.WEIGHT_ENGLISH.equals(initMetric)) {
initUnit = UNIT_POUND;
}
return MeasureGBO.convertValueByUnit(initUnit, toUnit, initValue);

public static void main (String args[]) {
double result = MeasureGBO.convertValueByUnit("inch", "cm", 12345.0);
String resultl = MeasureGBO.convertByUnit("cm", "inch", result, "en_US");
System.out.printin(result);
System.out.printIn(resultl);

System.out.printIn(31356.3 / 2.54);

¥
7.6.4 Title

Title sample
<%@ page import="com.ibm.gcl.gbo.name.NameGBO"%>

<select class="select-title" name="Title">
<%
NameGBO name = NameGBO.getInstance(curLocale);
String strArr[] = null;
String strHon = null;
String strldx = ™";
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strArr = name.getHonorificArr();
for (int i=0,j=0; i<strArr.length; i++) {
strldx =i +"";
strHon = strArr[i];
if (strHon.equals("")) {
continue;

Yelse {
j+;
}
if(==0){
%>
<option value="<%=i%>" <%-=(strldx.equals(su.getTitle())) ? "selected" :
""'%>><%=strHon%></option>
<%
Yelse {
%>
<option value="<%=i%>" <%-=(strldx.equals(su.getTitle())) ? "selected" :
""'%>><%=strHon%></option>
<% }

%>

</select>

7.6.5 Address

Address sample
<%@ page import="com.ibm.gcl.gbo.address.AddressGBO"%>

<select class="select-nationality"
onchange="window.document.theform.elements[‘counOnChange'].value="changed';checkFormatB
ean();" name="Country">
<%
AddressGBO addr = AddressGBO.getInstance(curLocale);
String strArr2[][] = null;

strArr2 = addr.getCountryL.ist();
for (int i=0; i<strArr2.length; i++) {
String locale = strArr2[i][0];
String country = strArr2[i][1];
%>
<option value="<%-=locale%>"
<%-=su.getCountry().equals(locale)?"selected":"""%>><%=country%></option>

>
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<%
¥
%>

</select>

7.6.6 Currency

Currency sample
/*
* Class: CurrencyUtil.java
* Description:
* Version: 1.0
* Author: swj
* Creation date: Sep 13, 2005
* Department: Shanghai Globalization Laboratory
* Copyright (c) 2004, International Business Machines Corporation,
* All rights reserved.
*/

package com.ibm.sgl.oged.util;

import com.ibm.gcl.gbo.currency.CurrencyGBO;

/**
*

*

* @author swj
* @version 1.0
*/
public class CurrencyUtil {
/**
* Convert the currency value to USD. This method shall be called before
* values are added to database.
*
* @param initValue
* The initial value.
* @param initLocale
* The initial locale.
* @return The converted value without unit.
*/
public static double convertCurrency (double initValue, String initLocale) {
String toLocale = CodeSystem.LANGUAGE_EN;
return CurrencyGBO
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.convertValueByLocale(initLocale, toLocale, initValue);

/**

* Format the currency value to display.

*

* @param initValue

* The currency amount in USD.
* @param toLocale

* The target locale.

* @param displayLocale

* The locale for display.

* @return The formatted currency string.

*/

public static String formatCurrency (double initValue, String toLocale,
String displayLocale) {
String initLocale = CodeSystem.LANGUAGE_EN;

return CurrencyGBO.convertByL ocale(initLocale, toLocale, initValue,
displayLocale);

/**

* Format the currency value. Only the number part of the result will be
* returned.

*

* @param initValue

* The currency ammount to be formatted.
* @param fromLocale

* The original locale.

* @param toLocale

* The target locale.

* @param displayLocale

* The display locale.

* @return The formatted currency string.

*/

public static String formatCurrencyValue (double initValue,
String fromLocale, String toLocale, String displayLocale) {
return CurrencyGBO.convertValueByLocale(fromLocale, toLocale,
initValue, displayLocale);

public static void main (String[] args) {

>
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System.out.printIn(*Test currency util...");
System.out.print(*100 FR =");
System.out.print(convertCurrency(100, "fr_FR™));
System.out.printin(" USD");

System.out.printIn();

System.out.print(*100 USD =");
System.out.print(formatCurrency(12.0811, “zh_CN", "ar_EG"));
System.out.printIn();

System.out.printIn();

System.out.print(*100 USD =");

String result = CurrencyGBO.convertValueByCurrency("USD", "CNY", 100.0,
"fr_FR");

System.out.printin(result);

System.out.printIn();

7.6.7 Locale List

Code fragments

<%@ page import="java.util.* javax.portlet.*,com.ibm.sgl.oged.wemp.portlet.*,
com.ibm.sgl.oged.db.databean.G11NPreferenceBean, com.ibm.sgl.oged.constant.UserConstansts,
com.ibm.sgl.oged.util.CodeSystem, com.ibm.sgl.gbo.core.operation.FeatureManager,
com.ibm.sgl.gbo.localelist.IGLocaleList,

com.ibm.sgl.gbo.core.preference.base.* ** %>

<form name="selLangForm">

<select onchange="changeLangUrl();" name="Language" >

<%
String localeList[] ={"en_US", "zh_CN", "fr_FR", "ar_EG"};
String languageList[] = {"en", "zh", "fr", "ar"};
String countryList[] = {"US", "CN", "FR", "EG"};

BasePreferenceFactory bpf = BasePreferenceFactory.getFactory();
BasePreference bp = bpf.getBasePreference("languageL.ist");

FeatureManager fm = FeatureManager.getinstance();

for(inti =0; i<4; i++) {
Locale locale = new Locale(languageList[i], countryL.ist[i]);
/[System.out.printin(locale);
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bp.setLanguage(locale);
/ISystem.out.printIn(localeList[i] + locale);

IGLocaleList gll = (IGLocaleL.ist) fm.getFeature(IGLocaleL.ist.class, "languageL.ist");

String langL.ist3 = gll.getLocaleName(locale);
/[System.out.printIn(langList3);
String optionValue = "";
if(CodeSystem.LOCALE_EN.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_EN;
}
if(CodeSystem.LOCALE_CN.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_CN;
}
if(CodeSystem.LOCALE_FR.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_FR;
}
if(CodeSystem.LOCALE_AR.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_AR;
dir ="rtl";
langList3
replaceString(replaceString(langList3,")","&#8207;)" ),"("," &#8207;(");
}
%>
<option dir="<%=dir%>" value=<%=optionValue %>
<%if(optionValue.equals(userLocale)) {out.print("selected");} %>>
<div align="center" dir=<%=dir%> >
<%-=replaceString(replaceString(langList3,")" bidiForceString+")" ),"(",bidiForceString+ "("")%>
</div ></option>
<%
} %>
[select>

7.6.8 Time Zone
Use JDK directly.

import java.util. TimeZone;

7.6.9 Date format
Use JDK instead

>
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import java.sgl. Timestamp;

import java.text.DateFormat;

import java.text.ParseException;
import java.text.SimpleDateFormat;
import java.util.Date;

import java.util.Locale;

import java.util.StringTokenizer;
import java.util. TimeZone;

7.6.10 Greeting

<%@ page import="com.ibm.gcl.gbo.greeting.GreetingGBO" %>
GreetingGBO greeting = GreetingGBO.getlInstance(locale);
if (title!=null&&!title.equals("*)){

int honorificld = Integer.parselnt(title);

greetStr = "<tr bgcolor="#A5DBFC' class="Weathertable’><td height="19" align="center'
nowrap class="header2’><table>" 4 greeting.getGreetingMsg(name,honorificld) +

"<[table><br></td></tr>";

}else {

greetStr = "<tr bgcolor="#A5DBFC' class="Weathertable'><td height="19" align="center'
nowrap class="header2’><table>" + greeting.getGreetingMsg(name,locale) +

"<[table><br></td></tr>";

}
7.6.11 Name

<%@ page import="com.ibm.gcl.gbo.name.*" %>
<%
int GBO_NAME_TEMPLATE = 9;

try {

NameGBO nameGBO = null;

nameGBO = NameGBO.getlInstance(locale);

NameTemplate nameTemplate
NameTemplate(NameTemplate. HTML, GBO_NAME_TEMPLATE);

nameTemplate.setHas Table(false);

out.printin(nameGBO.genModifyLayout(nameArr,
GBO_NAME_SN, nameTemplate));

>
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} catch (Exception €) {
out.printin("<TR>Error when loading NameGBO</TR>");

%>

7.7 Bidi in portal

We will introduce how to support bidi in portal project.
We will use wps tag to support bidi language (ar_EG and iw_IL) in portal project.

7.7.1 Bidi tag in portal taglib

Please import the taglib first

<%@ taglib uri="/WEB-INF/tld/engine.tld" prefix="wps"%>
The use the tag wps:bidi in the jsp file.

<wps:bidi is="rtl"> </wps:bidi>

7.7.2 Define the bidi attributes in the Bidi.jsp

We can define some bidi variables in the Bidi.jsp. Such as dir and bidiForceString.
Here are the contents of Bidi.jsp
<%--
The following bit of code is to make BIDI support a little easier.
These variables are meant to suppliment the <wps:bidi ...> tag.
There are situations where it is easier to use these variables instead of the tag itself.
--00>
<%@ taglib uri="/WEB-INF/tld/engine.tld" prefix="wps"%>
<%
String bidiAlignRight = “right;  // BIDI sensitive value for align="right" attribute
String bidiAlignLeft ="left"; // BIDI sensitive value for align="left" attribute

String bidiDirAttr =" /[ BIDI sensitive value for dir="rtl" attribute
String bidilmageRTL — =""; /I BIDI sensitive value for adding _rtl to a graphic
String dir="ltr";

String bidiForceString = "*;
boolean isRTL = false;

%>

<wps:bidi is="rtl"">
<%

bidiAlignRight = "left"; /I BIDI sensitive value for align="right" attribute

bidiAlignLeft = "right™; /I BIDI sensitive value for align="left" attribute
bidiDirAttr = "dir=\"rth\""; // BIDI sensitive value for dir="rtl" attribute
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bidilmageRTL  ="_rtl"; /I BIDI sensitive value for adding _rtl to a graphic
dir="rtl";
bidiForceString = ""&#8207;"; //Force bidi
iSRTL = true;
%>
</wps:bidi>

7.7.3 Include the Bidi.jsp in your portal jsp file.
<%@ include file="Bidi.jsp"%>

7.7.4 Now we can use the bidi attributes deifined in the Bidi.jsp.

<table width="1000" <%=DbidiDirAttr%> border="0" cellspacing="0" cellpadding="0">
<td class="td5<%=dir %>" colspan="3" ><Ip:value key="TITLE_REGISTERUSER"/></td>
<%=replaceString(replaceString(langList3,")",bidiForceString+")" ),"(",bidiForceString+ "(*")%>

7.7.5 Support bidi in XUL function

We will use the attribute dir with value normal and reverse for XUL tag.

<window id="CalculateVolumetricWeight" title="CalculateVolumetricWeight"
xmlns:html="http://www.w3.0rg/1999/xhtml"
xmlns="http://www.mozilla.org/keymaster/gatekeeper/there.is.only.xul"
style="background-color: #F9E9CC">

<hbox dir="reverse">
<html:input id="width" maxlength="6" dir="RTL"/>
<label hidden="true"/>
</hbox>

7.7.6 Bidi in portlet class

Sometime we need to use bidi in portlet class, such as composing an email in businessBean.
Firstly we need to know if the locale is bidi language, which is ar_EG or iw_IL. We have two
methods.

One is comparing the locale. For example:

boolean bidi = false;

String bidiForceString = "";

If(“ar_EG”.equals(userLocale) || “iw_IL".equals(userLocale)){
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bidi = true;
bidiForceString = " &#8207;"

Another is getting the bidi attributes from session.
String bidi = request.getPortletSession().getAttribute(“bidi”);
String bidiForceString = "
If(“yes”.equals(bidi)){
bidiForceString = "' &#8207;"

7.7.7 Bidi in stylesheet

Sometime we may need to modify the stylesheet to support bidi.

For example.
.td5{
border-left: 5px solid #B5B5B5;
color: #B97400;
padding-left: 10px;
background: White url(bg_map2.gif);

}
.td5rti{
border-right: 5px solid #B5B5B5;
color: #B97400;
padding-right: 10px;
background: White url(bg_map2.gif);
}

We will use a bidi variable defined in Bidi.jsp like the following.
<td class="td5<%=dir %>" colspan="3" ><Ip:value key="TITLE_REGISTERUSER"/></td>

7.7.8 Difference of bidi support between in IE6.0 and Mozilla Firefox V1.0.7

1.1. Source Code in jsp

String bidi = “;

String langList3 = ...... /I Get the language here

if(CodeSystem.LOCALE_AR.equals(localeList[i])) {
optionValue = CodeSystem.LANGUAGE_AR;
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langL.ist3 = replaceString(replaceString(langList3,")","&#8207;)" ),"("," &#8207;(");

}

<option dir="<%=dir%>" value=<%=optionValue %> <%if(optionValue.equals(userLocale))
{out.print("selected"); } %>> <div align="center" dir=<%-=dir%> >
<%-=replaceString(replaceString(langList3,")",bidiForceString+")" ),"(",bidiForceString+

"("%></div ></option>

8.2. The result in the browser 1E6,0
In locale zh CN(Simplified Chinese)

| EFET

T g
Eoglith TUnited Siaces!

p I

[rancais (Francal

N | | gunal

In Locale ar_EG(Egypt)

| EFET

T g

Eoglith TUnited Siaces!
p I

[rancais (Francal

IS T 1

8.3. The result in the Mozilla Firefox VV1.0.7
In locale zh_ CN(Simplified Chinese)
You can see the it’s different with 1E6.0.

IEEEE

Englizh (Tnited States)
R (PE)

In Locale ar_EG(Egypt)

il gl el

[l () il
(Inited States) Enzlish

(HE) H37

(France) frangais

(pma) Al
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7.8 Encoding of portlet

If the encoding is not right, the portal page will not be right to users. The words may be error
code.

7.8.1 JSP page encoding

To ensure the page rendering to user in right,please add the following line into your jsps.
<%@ page language="java" contentType="text/html; charset=UTF-8" pageEncoding="UTF-8"
session="true"%>

7.8.2 Localization Pack file

When doing the LP translation, please ensure you save the original string file as UTF-8 encoding.
Then you need to convert the UTF-8 format file to \u format file.

2.1. Original UTF-8 file user.properties:

PORTLET _ONLINETOOLS=7r4k T. &

2.2. Run the native2ascii command in command console: (Ensure you have JDK in your path)
C:\native2ascii —encoding UTF-8 user.properties \ASCI\user.properties

2.3. ASClII file is like the following.

PORTLET_ONLINETOOLS=\u5728\u7ebf\usde5\u5177

7.8.3 Multilingual string handling in Java code, such as sending email.

Please ensure you UTF-8 to handle all the strings.

1. You can check if the portal page is rendered using UTF-8
Right Click in the portal page -> Select Encoding — should be UTF-8

7.9 Encoding of portal database

This piece describes how to change the default encoding of WPS DB to avoid the wrong character
displaying.

By default, WebSphere Portal Server has the globalization features and supports multilingual
applications. However, there could be some wrong characters on the homepage of an application,
e.g., when access http://gwpcwps.cn.ibm.com/wps/portal, you are supposed to see some strange
characters like *?” in some cases.

The cause of the problem is the encoding setting of WPS DB. Explore the WPSDB in the DB2

9
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Control center, and open the MARKUP_DESC LOD table. Check the CHARSET of your
supported locale, if it is not UTF-8, update the filed with UTF-8.
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8. Artwork in Portal

Artwork is very important in portal project. In a globalization portal project, we may need to
modify the stylesheet to meet the requirement in each locale.

8.1 Ul design

Before we can write the codes, we need to do the Ul design. Ul design is very important to a
portal project. A good design can save you much time.

Here are some principles we can follow in Ul design.

8.1.1 Naming conversion

Please use the word associated for html file name, such as GenerateReport.html.

8.1.2 Deal with Ul pages of different roles

If there several roles in your portal website, and they have the similar Ul pages, please design only
one page for them and put necessary notes to the page. In addition, notes must be outstanding so
that the artwork team members are able to know what you mean. Some common items should be
put in an independent file, for example bidi info and stylesheet.

8.1.3 Keep the same style for all of Ul pages.

Keep the same style for all of Ul pages is important to the overall feeling of the portal website.

8.1.4 List all the error messages on the Ul pages.

The error messages will be collected into localization pack files and send to TSC for translation..

8.1.5 As for some dynamic contents, enough explanation should be shown on the page.

The explanation would be help for developers in the development.

8.1.6 As for the JSP components, please put notes indicating the type of the used component.

The explanation would be help for developers in the development.

8.1.7 Except the homepage, it is better to put a “back’ button on every page.

A “Back” button would be helpful when user wants to input the data again or want to view the
previous page.

8.1.8 For some special input, it is better to write some limitation notes besides the input.

For example, the length the password must be more than 6. This would be helpful for developer to
validate the user input in portlet.

9

©Shanghai Globalization Lab, User Page 142
Technology, CSDL, IBM China 2006



Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

8.1.9 If there are many inputs in a page, a ““reset” button is a must.

A “reset” button can allow use to reset all the input and input the data again.sa

8.1.10 Convert html files to JSP files.

Firstly, you need to rename the html files name to JSP file name and add them into portal projects.
Then you collect all the strings into localization pack files from JSP.

Now you can start coding.

8.2 Images
We can add the images into project: PortalProject\WebContent\images
Or we can separate them from project and place the images into wps.war directory like the

following.
lopt/WebSphere/AppServer/installedApps/ogedwemp/wps.ear/wps.war/oged/images

If you want to use different image for each locale, please use the subdirectory for the locale as
following.

([ wps ] A|| Hane |
MET 5—THF Cen_Us
= wps. war [)zh_CH
cla Char_EG
[ doe =) fr_FE
% ];':'SEdi tor @Adva.ncedTr ack. gzif
t .
[ html
D 1mages icon_login_l. zif
% ;;;LE—IITF icon_EditFreference 1. zif
m icon EditFrofile 1. z1f
= @ images (i3 i con_Logout_1. gif

@hnmemapl. zif
@Selectl.a.ng‘uage. zif

B 0GED. gif

Gener alInformation. g1 f
=.. .-

e P

Note: Please pay attention to bidi language; some images may need to be converted from

right to left. Here is a sample.

bl gl el |

Englizsh [United States] b I:_).._.n.o]l J._u_):J|
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8.3 Apply stylesheet

To make the portal website more beautiful, we need to apply stylesheet. The stylesheet can be the
same directory with images.
Please pay attention to the tag .td1lrtl in the following sample , which is used to support bidi
language. Here is the sample of stylesheet.
td1{
border-left: 5px solid #clclcl;
font-weight: bold;
color: #727272;
padding: 5px 10px 5px 10px;
border-bottom: 1px solid #clclcl;
border-right: solid 1px #clclcl;
background: #eeeeee;
}
tdlrtl{
border-right: 5px solid #clclcl;
font-weight: bold;
color: #727272;
padding: 5px 10px 5px 10px;
border-bottom: 1px solid #clclcl;
border-left: solid 1px #clclcl;
background: #eeeeee;

8.4 Coordination between artwork team and portal team

Good communication between artwork team and portal team can contribute more to the success of
a portal project.

Of course, to avoid frequent Ul changes, a good Ul design is very important.

If we have to change the Ul pages, please work closely with artwork team and make our
requirement clear. If the changes don’t affect our java code, it would be the best.

Notes: Please pay more attention to the theme of portal for it’s the overall impression of the portal
website.
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9. Comparison of several types of portlets

You will know the differences of several portal projects, which including IBM API portlet,
JSR168 portlet, JSF portlet, XDIME portlet and etc.

Here 1 list the sample code in our previous projects to show the difference of each type portal
project.

9.1 IBM API Portlet

9.1.1 IBM API Portlet- Portlet

import org.apache.jetspeed.portlet.*;
public class BookAir extends PortletAdapter implements PortletTitleListener,
ActionListener {

public void doView(PortletRequest request, PortletResponse response) throws
PortletException, IOException {
PortletContext context = getPortletConfig().getContext();
PortletSession session = request.getPortletSession();
String jspFileName = (String) session.getAttribute(SESSION_PAGE_TYPE);
context.include(jspFileName, request, response);
}
public void actionPerformed(ActionEvent event) throws PortletException {
PortletRequest request = event.getRequest();
PortletSession session = request.getPortletSession();
String action = event.getActionString();
if (ACTION_CANCEL_BOOKING.equals(action)){
session.setAttribute(SESSION_PAGE_TYPE,PAGE_HOTEL_HISTORY_CACLEL);

}

9.1.2 IBM API Portlet- JSP

<%@ page language="java“ contentType="text/html; charset=UTF-8"pageEncoding="UTF-8"%>
<%@ taglib uri="/WEB-INF/tld/portlet.tld" prefix="portletAPI" %>

<%@ taglib uri="/WEB-INF/tld/engine.tld" prefix="wps" %>

<%@ taglib uri="/WEB-INF/tld/Ip.tld" prefix="Ip" %>

<Ip:load file="search.properties"/>

<portletAPl:init />

<form name="<portletAPIl:encodeNamespace value='SearchReturn'/>" action=<%=
(String)request.getAttribute(FederalSearchParameters. SEARCH_RETURN_ACTION_URI)%>
method ="POST">

>
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<Ip:value key="case_search_page_title"/>

<input type="button" name="search" value="<Ip:value key="search"/>"
onclick="document.<portletAPl:encodeNamespace value="‘search’/>.submit();">

</form>

9.1.3 IBM API Portlet — portlet.xml

<portlet id="BookHistory" href="WEB-INF/web.xml#Servlet_1063354122906"
major-version="1" minor-version="0">
<portlet-name>BookHistory</portlet-name>
<supports>
<markup name="html">
</markup>
<markup name="kiosk">
<view />
</markup>
<markup name="palm">
<view />
</markup>
<markup name="pda">
<view />
</markup>
<markup name="wap">
<view />
</markup>
</supports>
</portlet>
<concrete-portlet href="#BookHistory">
<portlet-name>BookHistory</portlet-name>
<default-locale>en</default-locale>
<language locale="en">
<title>BookHistory</title>
<title-short></title-short>
<description></description>
<keywords></keywords>
</language>
</concrete-portlet>

9.1.4 IBM API Portlet— web.xml

<servlet id="Servlet 1063354122906">
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<servlet-name>BookHistory</servlet-name>

<display-name>BookHistory</display-name>

<servlet-class>com.ibm.gcl.gtod.portlet.BookHistory</servlet-class>
</servlet>

<servlet-mapping id="ServletMapping_6">
<servlet-name>BookHistory</servlet-name>
<url-pattern>/BookHistory/*</url-pattern>
</servlet-mapping>

9.2 JSR168 Portlet

9.2.1 Introducing JSR 168

The Java Standardization Request 168 (JSR 168) defines a portlet specification, including a
contract between the portlet container and the portlet. JSR 168 is defined by the Java Community
Process (JCP). The JSR 168 was co-led by IBM and Sun and had a large Expert Group that helped
to create the final version which is now available. This Expert Group consisted of Apache
Software Foundation, Art Technology Group Inc.(ATG), BEA, Boeing, Borland, Citrix Systems,
Fujitsu, Hitachi, IBM, Novell, Oracle, SAP, SAS Institute, Sun, Sybase, Tibco, Vignette. More
details about this JSR can be found at http://jcp.org/en/jsr/detail?id=168.

9.2.2 JSR168 Portlet - Portlet

public class JSR168Portlet extends GenericPortlet {
public void doView(RenderRequest request, RenderResponse response) throws PortletException,
IOException {
response.setContentType(request.getResponseContentType());

if(null == JSP_NAME) JSP_NAME = “jsppagel";

/I Invoke the JSP to render

PortletRequestDispatcher rd =
getPortletContext().getRequestDispatcher(getJspFilePath(request, JSP_ NAME));

rd.include(request,response);

¥
¥

public void processAction(ActionRequest request, ActionResponse response) throws
PortletException, java.io.lOException {
PortletSession session = request.getPortletSession();
if(request.getParameter(“initiateNext1")!=null){
/Do something

JSP_NAME = “jsppage2";

PortletPreferences prefs = request.getPreferences();

prefs.setValue(request.getParameter(""name"),request.getParameter(“value™));

prefs.store();

>
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9.2.3 JSR168 Portlet - JSP

<%@ taglib uri="http://java.sun.com/portlet" prefix="portlet"%>
<%@ page language="java" contentType="text/html; charset=UTF-8"
pageEncoding="UTF-8" session="false"%>
<portlet:defineObjects/>
<%
PortletPreferences prefs = renderRequest.getPreferences();
Enumeration e = prefs.getNames();

while (e.hasMoreElements()) {
String name = (String)e.nextElement();
String value = prefs.getValue(name, test");
}
%>
<FORM ACTION="<portlet:actionURL/>" METHOD="POST">
<input name="initiateNext1" type="submit" value="Next">
</[FORM>

9.2.4 JSR168 Portlet— portlet.xml

<portlet>

<portlet-name>Xdime</portlet-name>

<display-name>Xdime portlet</display-name>

<display-name xml:lang="zh">Xdime portlet</display-name>

<portlet-class>xdime.XdimePortlet</portlet-class>

<init-param>
<name>wps.markup</name>
<value>html,xdime</value>

</init-param>

<expiration-cache>0</expiration-cache>

<supports>
<mime-type>text/html</mime-type>
<portlet-mode>view</portlet-mode>

</supports>

<supports>
<mime-type>x-application/vnd.xdime+xml</mime-type>
<portlet-mode>view</portlet-mode>

</supports>
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<supported-locale>zh</supported-locale>
<resource-bundle>xdime.nl.XdimePortletResource</resource-bundle>
<portlet-info>
<title>Xdime portlet</title>
</portlet-info>
</portlet>

9.3 Faces Portlet

9.3.1 JavaServer Faces (JSF)

JavaServer Faces is a GUI framework for developing J2EE Web applications (JSR 127). It
includes reusable user interface components, input validation, state management, server-side event
handling, page lifecycle management,

accessibility, and internationalization. Faces-based application development can be applied to
portlets, similar to the way that Faces development is implemented in Web applications. Similar to
Struts, there are many wizards to help you with Faces development. Both WebSphere Portal
V5.0.2.2 and V5.1support JavaServer Faces.

There are certain limitations to Faces portlet development in the current release. Service Data
Objects (SDO), formerly referred to as WebSphere Data Objects (WDO), are limited to
prototyping purposes only. Applications that rely on SDOs should be limited in a production
environment. File upload and binary download are not supported for Faces components. Finally,
document root-relative URLS are not supported for images.

Refer to the Rational Application Developer Faces documentation in the InfoCenter for usage
details. Alternatively you can refer to the following web site:
http://www.jcp.org/en/jsr/detail?id=127

9.3.2 Faces Portlet - Portlet

public class SearchProduct extends PageCodeBase {
protected HtmlCommandExButton getButtonl () {
if (button1 == null) {
buttonl = (HtmlCommandExButton) findComponentinRoot("buttonl1");
}

return buttonl;

public String doSearchAction () {
javax.portlet.PortletRequest portletRequest = (javax.portlet.PortletRequest) facesContext
.getExternalContext().getRequest();
searchProductDataBean = this.getSearchProductDataBean();

getSessionScope().put(“productListContainerDataBean",productListContainerDataBean);

>
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return "success";

public SearchProductDataBean getSearchProductDataBean () {
}

9.3.3 Faces Portlet - JSP

<%@taglib uri="http://java.sun.com/jsf/core” prefix="f"%>
<% @taglib uri="http://java.sun.com/portlet” prefix="portlet"%>
<% @taglib uri="http://java.sun.com/jsf/html" prefix="h"%>
<% @taglib uri="http://www.ibm.com/jsf/html_extended" prefix="hx"%>
<% @taglib uri="/WEB-INF/tld/Ip.tld" prefix="1p"%>
<%@page language="java" contentType="text/html; charset=UTF-8"
pageEncoding="UTF-8" session="true"%>
<portlet:defineObjects />
<Ip:load file="productsearch.properties™ />
<f:view>
<%if (locale.equals(*zh_CN")) {%>
<f:loadBundle basename="LocalizationPack/zh_CN/productsearch
var="lpnew" />
<%} else if (locale.equals(*fr_FR™)) {%>
<f:loadBundle basename="LocalizationPack/fr_FR/productsearch"
var="lpnew" />

<%} %>
<hx:scriptCollector id="scriptCollectorl">
<%-- jsf:pagecode language="java"
location="/JavaSource/com/ibm/sgl/gpim/actionbeans/SearchProduct.java™ --%><%--

/jsf:pagecode --%>
<h:form styleClass="form" id="SearchProduct_form1">
<hx:commandExButton styleClass="commandExButton* id="putton1"
value="#{lpnew.COMMANDLINK_SEARCHBYPRODUCT}* action="#{pc_SearchProduct.do
SearchAction}"></hx:commandExButton>
</h:form>
</hx:scriptCollector>
<[f:view>

9.3.4 Faces Portlet — portlet.xml
<portlet>
<description>This is SearchProduct portlet base</description>
<description xml:lang="en-US">This is SearchProduct portlet en_US</description>
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<portlet-name>SearchProduct</portlet-name>
<display-name>SearchProduct portlet</display-name>
<display-name xml:lang="en-US">
SearchProduct portlet en_US
</display-name>
<portlet-class>
com.ibm.faces.webapp.FacesGenericPortlet
</portlet-class>
<init-param>
<name>com.ibm.faces.portlet.page.view</name>
<value>/html/SearchProduct.jsp</value>
</init-param>
<init-param>
<name>wps.markup</name>
<value>html</value>
</init-param>
<expiration-cache>0</expiration-cache>
<supports>
<mime-type>text/html</mime-type>
<portlet-mode>view</portlet-mode>
</supports>
<supported-locale>en_US</supported-locale>
<resource-bundle>Ip.nl.SearchProductResource</resource-bundle>
<portlet-info>
<title>SearchProduct portlet</title>
</portlet-info>

</portlet>

9.3.,5 Faces Portlet — faces-config.xml

<managed-bean>
<managed-bean-name>pc_SearchProduct</managed-bean-name>
<managed-bean-class>
com.ibm.sgl.gpim.actionbeans.SearchProduct
</managed-bean-class>
<managed-bean-scope>request</managed-bean-scope>

</managed-bean>
<managed-bean>

>

<managed-bean-name>searchProductDataBean</managed-bean-name>
<managed-bean-class>
com.ibm.sgl.gpim.databeans.SearchProductDataBean
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</managed-bean-class>
<managed-bean-scope>session</managed-bean-scope>
</managed-bean>
<navigation-rule>
<from-view-id>/html/SearchProduct.jsp</from-view-id>
<navigation-case>
<from-action>
#{pc_SearchProduct.doSearchAction}
</from-action>
<from-outcome>success</from-outcome>
<to-view-id>/html/ProductSearchProductList.jsp</to-view-id>
</navigation-case>
<navigation-case>
<from-action>
#{pc_SearchProduct.doSearchAction}
</from-action>
<from-outcome>failure</from-outcome>
<to-view-id>/html/ProductSearchResultNULL .jsp</to-view-id>
</navigation-case>
</navigation-rule>

9.4 XDIME Portlet

9.4.1 Introduction of WEMP and XDIME

WebSphere Everyplace Mobile Portal (hereafter called WEMP) is a key component of WebSphere
Everyplace Service Delivery. It extends WebSphere Portal software with technology to meet the
requirements of mobile and wireless service providers by delivering the promise of ‘write once,
render many’ to mobile devices through device-independent authoring and allows new devices to
be introduced without changes to the style guide or impact to the existing applications or products.

XML Device-Independent Markup Extensions (hereafter called XDIME) is an abstract,
device-independent markup language. XDIME can be processed and converted by the components
of WEMP, such as MCS (Multi Channel Server), into a wide variety of markup languages, such as
WML 1.1, WML 1.3, XTHML Basic, XHTML-MP, HTML 3.2, HTML 4.0, and others. So that
developers can just write one version XDIME-enabled source files for a wide variety of mobile
devices.

9.4.2 WEMP Portlet—Portlet

public class XdimePortlet extends GenericPortlet {

public void processAction(ActionRequest request, ActionResponse response) throws
PortletException, java.io.lOException {

PortletSession session = request.getPortletSession();
if(request.getParameter(“initiateNext1")!=null){
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JSP_NAME = "InitiateShipment2";
}
public void doView(RenderRequest request, RenderResponse response) throws PortletException,
IOException {
response.setContentType(request.getResponseContentType());
if(null == JSP_NAME) JSP_NAME = "InitiateShipment";
/I Invoke the JSP to render
PortletRequestDispatcher rd =
getPortletContext().getRequestDispatcher(getJspFilePath(request, JSP_ NAME));
rd.include(request,response);

¥
¥
¥

9.4.3 WEMP Portle — html JSP

<%@ taglib uri="http://java.sun.com/portlet" prefix="portlet"%>
<%@ page language="java" contentType="text/html; charset=UTF-8"

pageEncoding="UTF-8" session="false"%>
<portlet:defineObjects/>

<FORM ACTION="<portlet:actionURL/>" METHOD="POST">
<input name="initiateNext1" type="submit" value="Next">
</[FORM>

9.4.4 WEMP Portlet- XDIME JSP

<%@ page session="false" contentType="x-application/vnd.xdime+xml" %>
<%@taglib uri="http://java.sun.com/portlet" prefix="portlet" %>
<portlet:defineObjects/>
<canvas layoutName="/layout.mlyt" type="portlet" >
<pane name = "sample_pane">
<p>Initiate shipment request</p>

</pane>
<xfform name="testForm" method="POST" action="<portlet:actionURL/>" >

<xftextinput  name="shipmentContent" type="text" caption="Shipment content:"
captionPane="contentpane" entryPane="contentpane"/>

<xfaction type="submit" name="initiateNext1"

caption="Next" captionPane="buttonpane" entryPane="buttonpane" />

</xfform>
</canvas>

>
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9.5 Comparison between IBM Portlet and JSR168 Portlet

9.5.1 Deciding which API to use

As the IBM portlet API will continue to be supported in future versions of WebSphere Portal,
there is no immediate need to migrate existing portlets unless the portlet is required to interoperate
with other portals that support JSR 168. For new portlets, consider using JSR 168 when the
functionality it provides is sufficient for the portlet's needs or when the portlet is expected to be
published as Web Service for Remote Portlets (WSRP) service. As the JSR 168 and WSRP are
closely aligned, it is possible to publish a JSR 168 portlet as a WSRP service. If the portlet needs
more functionality than that provided by JSR 168, the IBM portlet API should be used.

9.5.2 Future directions for WebSphere Portal JSR 168 support

IBM plans to provide further enhancements to the JSR in follow-on versions to make the JSR 168
portlet API as useful as the current IBM counterpart.

9.5.3 The comparison of IBM API portlet and JSR168 portlet

IBM Portlet API JSR168

Request,response PortletRequest, PortletResponse, | RenderRequest, RenderResponse
ActionEvent ActionRequest, ActionResponse

Life cycle ActionPerformed() ProcessAction()

Methods to create URI to the | PortletResponse.createURI() RenderResponse.createActionURL() and

portlet RenderResponse.createRenderURL()

Including JSPs PortletContext.include() PortletRequestDispatcher.include()

JSP tag library <portletAPl:init/> - portlet:defineObjects/>
<portletAPl:createURI/> PortletResponse.createURI()
<portletAPl:createURI/> <portlet:renderURL/>

<portlet:actionURL/>
<portletAPl:encodeNamespace/> <portlet:namespace/>

Namespace encoding PortletResponse.encodeNamespace() RenderResponse.getNamespace()

For more, please refer to:
http://www-128.ibm.com/developerworks/websphere/library/techarticles/0312 hepper/hepper.htm
I
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10. Portal Resource Center

Here are some useful resourcs of portal.

10.1 WebSphere Portal for Multiplatforms

http://www.ibm.com/software/genservers/portal

10.2 WebSphere Portal Express

http://www.ibm.com/software/genservers/portalexpress/

10.3 WP510 Info Center
http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/

10.4 RAD V6 Portlet Application Development and Portal Tools
http://w3.itso.ibm.com/redpieces/abstracts/sg246681.html?Open

10.5 IBM WebSphere Portal for Multiplatforms V5 Handbook
http://www.redbooks.ibm.com/abstracts/sg246098.html

10.6 IBM WebSphere Portal V5 A Guide for Portlet Application Development
http://www.redbooks.ibm.com/abstracts/sg246076.html

10.7 WebSphere Portal library:

http://www.ibm.com/software/genservers/portal/library/

10.8 WebSphere Portal zone in DeveloperWorks

http://www.ibm.com/developerworks/websphere/zones/portal/

10.9 WebSphere Portal Forum

http://www.ibm.com/developerworks/forums/dw_forum.jsp?forum=168&cat=9

10.10 IBM user groups

http://www.ibm.com/developerworks/websphere/usergroups/index.html

10.11 JSR 168 Specification:
http://www.jcp.org/en/jsr/detail?id=168

10.12 Comparing JSR 168 to the IBM portlet API

http://pvcid.raleigh.ibm.com/wpf/ic/510/ent/en/InfoCenter/wps/jsrcpr.html
http://www-128.ibm.com/developerworks/websphere/library/techarticles/0312 hepper/hepper.htm
|

10.13 Tags used by the portal JSPs
http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/wps/dgn_ptltld.html

©Shanghai Globalization Lab, User Page 155
Technology, CSDL, IBM China 2006

9



http://www.ibm.com/software/genservers/portal
http://www.ibm.com/software/genservers/portalexpress/
http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/
http://w3.itso.ibm.com/redpieces/abstracts/sg246681.html?Open
http://www.redbooks.ibm.com/abstracts/sg246098.html
http://www.redbooks.ibm.com/abstracts/sg246076.html
http://www.ibm.com/software/genservers/portal/library/
http://www.ibm.com/developerworks/websphere/zones/portal/
http://www.ibm.com/developerworks/forums/dw_forum.jsp?forum=168&cat=9
http://www.ibm.com/developerworks/websphere/usergroups/index.html
http://www.jcp.org/en/jsr/detail?id=168
http://pvcid.raleigh.ibm.com/wpf/ic/510/ent/en/InfoCenter/wps/jsrcpr.html
http://www-128.ibm.com/developerworks/websphere/library/techarticles/0312_hepper/hepper.html
http://www-128.ibm.com/developerworks/websphere/library/techarticles/0312_hepper/hepper.html
http://publib.boulder.ibm.com/pvc/wp/510/ent/en/InfoCenter/wps/dgn_ptltld.html

Best Practice of Portal Development written by Luke Wang (wanghuah@cn.ibm.com)

11. Appendix 1: Abbreviations and acronyms

RAD - Rational Application Developer

WPS — WebSphere Portal Server

RSA — Rational Software Architecture

G11n - Globalization

WEMP — WebSphere Everyplace Mobile Portal
XDIME -XML Device Independent Markup Extension
LP — Localization Pack

JSR —Java Specification Request

JSF — JavaServer Faces

JCP - Java Community Process
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I want to say thanks to my colleagues, Elton, Terry, Martin, Benny, and Catherine. With your
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Also I’ll say thanks to you, my dear reader. Thank you for your time in this document, hope it can
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